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I n t r o d u c t i o n
Introduction

As an accountant, you probably have many clients who either use QuickBooks or 
could benefit from using QuickBooks. Many accountants have found that clients who 
use QuickBooks are a boon to the firm: besides allowing you to work from more 
organized financial information, a client’s use of QuickBooks can represent a source 
of additional revenue. For example, if your clients use QuickBooks, you can offer these 
additional services:

� Setting up QuickBooks companies for clients who own small businesses.

� Reviewing clients’ QuickBooks chart of accounts and recommending corrections 
if necessary.

� Training clients on how to use QuickBooks for day-to-day financial transactions.

� Providing business and financial management advice. See Chapter 8, “Evaluating 
client data.”

� Providing secure, off-site data storage for clients’ QuickBooks data disks. (They can 
deliver data disks to your office on a periodic—weekly or monthly—basis.)

QuickBooks can give you the opportunity to provide full-service financial analysis and 
business consulting services to clients who desire such assistance.

Using this guide

Because this guide is written for QuickBooks, QuickBooks Pro and QuickBooks 
Accountant, all references to “QuickBooks” will mean all programs. When a feature or 
example applies to specific versions only, it will be noted in the text.

The graphics and examples in this guide were created using QuickBooks Accountant. 
If you are working with other versions of QuickBooks, or if you are using Microsoft 
Windows XP, some of your screens may look different from the examples given.

When other sources of documentation provide additional information on a subject, 
they are referenced in the text.

Finding the information you need

To help you find the information you need to work with your clients, we’ve divided 
this guide into two sections.

Section 1 provides technical details about QuickBooks. It includes detailed 
descriptions of report customisation options, information on how to import and 
export QuickBooks data, and answers to frequently asked questions about QuickBooks 
features.
2



Section 2 contains information to help you work with your clients who use 
QuickBooks. You’ll find information on how to help clients set up their QuickBooks 
company files—including suggestions for setting up QuickBooks for different 
industries. This section also contains information about specific QuickBooks reports 
you might want to create to help you prepare financial statements and evaluate client 
data. Finally, you’ll find information to help you diagnose and fix common client 
errors.

Using other QuickBooks resources

In addition to this reference guide, there are a number of other resources you can use 
to help you work with QuickBooks and your clients who use QuickBooks.

QuickBooks Training Guide

The QuickBooks Training Guide is included in your membership materials, and is 
available to download. The training guide contains a set of lessons that cover key 
QuickBooks features. 

Use this guide to introduce your clients to QuickBooks features. The training guide is 
modular so you can skip lessons that don’t apply to a client’s business.

QuickBooks printed and onscreen documentation

For an overview of QuickBooks features, refer to the QuickBooks User Guide. This book 
contains direct references to onscreen help topics to help your clients easily find the 
step-by-step information they need to use QuickBooks on a day-to-day basis. 
QuickBooks even allows the user to launch specific QuickBooks features directly from 
the onscreen help.

Most QuickBooks windows also include a natural language query box in the title bar, 
giving easy access to help, tips and troubleshooting.

The User Guide also provides step-by-step instructions on how to install QuickBooks 
and convert existing QuickBooks or Quicken files to QuickBooks.

Follow-Me Help and Support

The Find and Follow-Me Help panels consolidate the many ways of getting 
QuickBooks help and support information into a single convenient location. The 
information available draws upon advice, help, and tips provided within QuickBooks, 
as well as from various sources on the World Wide Web.

The Follow-Me Help panel automatically shows help related to what you are doing in 
QuickBooks. 
3



I n t r o d u c t i o n
Alternatively you can use the Search to look for topics in the help, or look online, or 
contact Intuit for further advice. You can also use the Index to locate information. The 
results are shown in the Follow-Me Help panel. 

To display the Help if it is not already shown, choose Help & Support from the Help 
menu.
4
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Section 1 Working with 
QuickBooks
S e c t i o n  1

The first section of this book contains five chapters designed to help you work with 
QuickBooks. Unlike Section 2 of this guide—which details ways you might want to 
work with your clients who use QuickBooks—this first section provides technical 
information about working with QuickBooks data files.

To introduce you to QuickBooks Regular, QuickBooks Pro and QuickBooks 
Accountant, the book starts with a list of the new features and services with this 
version that may interest your clients. Chapter 1 briefly describes each new feature 
and service and tells you where to find more information.

As an accountant, you may have clients who might benefit from using QuickBooks. 
Chapter 2 contains information about some of the technical and practical limitations 
of QuickBooks data files and how forms can be customised, which can help you 
determine whether a small business is right for QuickBooks.

If you have clients with questions about getting information into and out of 
QuickBooks, Chapter 3 gives instructions for importing and exporting QuickBooks 
data—including instructions for exporting QuickBooks reports to Microsoft Excel. In 
this chapter, you’ll also find instructions for using the Accountant’s Review feature to 
work with your clients’ data files.

If you run reports for clients, you may find the extensive information about 
QuickBooks reports in Chapter 4 especially useful. You’ll learn how to find the report 
you’re looking for; how to customise and filter data to get the information you want; 
and how to save the settings so you can create customised reports that clients can 
generate later.

Finally, in Chapter 5 you’ll find answers to some frequently asked questions about 
QuickBooks features that you might hear from clients.
 5
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T e c h n i c a l  d e t a i l s  a b o u t  Q u i c k B o o k s  d a t a  f i l e s
Maximum number of list items and 
transactions

Technical limitations
� The maximum number of transactions QuickBooks can handle is two billion. (In 

other words, maximum transactions are limited more by your system’s disk space 
and memory than by QuickBooks.)

� Each list in QuickBooks can hold a certain number of items. Once that number is 
reached, no new items can be created. The maximum number of items that can be 
created in each list is shown in the following tables.

List names Maximum

Chart of accounts 10,000

Items—including inventory items 14,500

Price Level 
(Fixed % and/or Per Item, up to a total of 100 combined)

100

Payroll Items 10,000

Class 10,000

Total Customer:Job, Supplier, Employee, and Other Names lists 
added together (Any one of these lists can contain up to 10,000 
names, but they cannot exceed 14,500 combined).

14,500

Sales Rep 14,500

Customer Type 10,000

Supplier Type 10,000

Job Type (QuickBooks Pro/Accountant only) 10,000

A/R Terms and A/P Terms added together 10,000

Customer Messages 10,000

Payment Method 10,000

Ship Via 10,000

Templates 14,500

Memorised Transaction 14,500

To Do 10,000

Memorised Reports 14,500
8



C H A P T E R  1
Practical limitations

The typical QuickBooks customer is a small business with 20 or fewer employees and 
annual revenue of less than a million pounds. The ideal use of QuickBooks is to keep 
at least two years of detailed transactions in a data file so you can run comparative 
reports and have prior-year project information.

The rate of growth of a QuickBooks data file varies dramatically from company to 
company. There is no “average” or “typical” size data file, since each business will 
track different information for each type of transaction entered into QuickBooks. But 
it is not uncommon for a QuickBooks data file to grow as large as 30 Mb. How quickly 
a data file grows depends on the number of transactions, the amount of information 
entered per transaction, and the number of “links” per transaction. For example, 
someone who enters 500 one-line invoices per month might find that their data file 
is smaller than another person who enters 100 five-line invoices per month. Or 
someone who usually receives five separate payments per invoice would have a larger 
file than someone who typically receives only one payment per invoice.

To determine whether a small business is right for QuickBooks, you can do a quick 
check by taking the average number of monthly transactions—remember, an invoice, 
payment, and deposit would be three separate transactions, and a bill and bill 
payment would count as two—and multiplying that number by 2000. This gives you 
an estimate of how much the data file will grow each month.

For example, if a company enters 300 transactions per month, on average, the data file 
would grow by around 600 Kb per month (300 x 2000 = 600 Kb), or 7 Mb per year 
(600 Kb x 12 = 7 Mb). If the annual data file size is less than 15 Mb, then QuickBooks 
should be more than suitable for their company.

Important: The 2000 multiplier does not include list information, which will also
grow as new names are added to the data file, and is only an approxi-
mation that may not be a good estimate for all QuickBooks data files.

Important: The upper limit on how large a QuickBooks data file can grow without
causing noticeable performance degradation varies greatly. As a general
guideline, using an IBM-compatible Pentium computer, 166 MHz or
faster, with 32 Mb of RAM, should allow the typical small business to
keep two or three years of data with little performance degradation.

If performance becomes an issue or you decide you do not want to keep detailed 
transactions for prior years, you can condense a QuickBooks data file. Before you 
condense a data file, please read “Condensing data to reduce file size” on page 193 
which explains how condensing data will affect the data file and what should be done 
before a data file is condensed.
9



T e c h n i c a l  d e t a i l s  a b o u t  Q u i c k B o o k s  d a t a  f i l e s
If you find that QuickBooks is getting slow when entering or recording transactions, 
you might want to check the following preference:

Note: Only the QuickBooks Administrator can change Company preferences.

� Is auto-recall for last name on?

From the Edit menu, choose Preferences. Click General on the scrolling iconbar in 
the Preferences window; click the My Preferences tab. If the “Automatically recall 
last transaction for this name” option is selected, you can increase performance by 
clearing it. This option requires QuickBooks to search backward for the last 
transaction using the payee name. If the register contains a large number of 
transactions, this can slow down data entry.

Customising QuickBooks forms

QuickBooks allows customisation of all forms—invoice, delivery note, sales receipt, 
credit memo, statement, estimate, sales order and purchase order. You can modify the 
name (label) of each field, select which fields display and/or print, and choose the 
order and width of all columns. Using the Layout Designer, you can decide exactly 
where columns and fields appear on the printed form. QuickBooks lets you save your 
custom forms as templates, so you can easily recall your custom layouts. 

To set QuickBooks to display years as two digits (DD/MM/YY):
1 From the Edit menu, choose Preferences.

2 Select General in the scroll box, and click the Company Preferences tab.

3 Click to clear the “Always show years as 4 digits” tick box.

Note: Only the QuickBooks Administrator can change Company preferences.

4 Click OK.

QuickBooks also gives you the ability to create custom fields in the Customer, 
Supplier, Employee, and Item lists, and to add these fields to sales and purchase forms. 
You can have up to seven custom fields each for customers, suppliers, and employees 
(up to a total of 15 custom fields), and up to five custom fields for items.

The number of fields and/or columns QuickBooks can print depends on the size of 
each field/column and the number of fields/columns you choose to print. To see how 
the custom form will print, click the Print Preview button before printing the form. In 
addition to the layout options possible with the layout designer, you can choose to 
print using one of the built-in standard templates on blank paper or letterhead paper 
and decide whether to let QuickBooks draw lines around each field.

Forms have a number of fields available to include on the onscreen version, the 
printed version, or both. For example, a printed invoice would include the VAT 
registration number which is not shown on the onscreen form; on an estimate the 
onscreen version could include markup information which would not be included in 
the printed version that is sent out to customers.
10



C H A P T E R  1
To customise a form:
1 Open a form, such as an invoice.

2 Click Customise.

3 Select an existing form and click New.

4 Select each tab in turn and select the tick boxes for the items you want to include, 
or clear them for items you do not want to include.

5 To customise the print layout (all versions), or to add graphics, text boxes and 
borders (Pro/Accountant), click Layout Designer, make the required changes and 
click OK.

For guidance on the options available, see the next section.

Guidance on customising forms

Using the Customise window

Each form is divided into areas, each of which are represented by tabs in the Customise 
Form window.

In the following illustrations, Customise Invoice is shown, but the exact fields 
available depend on the type of form, which features you have turned on, and 
whether you have added any custom fields.

� Header: This information typically includes the form title and number, and 
details of the customer or supplier to whom the form is addressed.
11



T e c h n i c a l  d e t a i l s  a b o u t  Q u i c k B o o k s  d a t a  f i l e s
� Fields: This includes details specific to the transaction, such as the terms, due date, 
ship date and sales representative.

� Columns: This provides the area to enter item lines, and typically includes the 
item name or code, description, quantity, rate or cost, VAT and total amount for 
the line.
12



C H A P T E R  1
� Prog Cols: (QuickBooks Pro/Accountant) This section on invoice forms includes 
additional columns related to progress invoicing, including estimate quantity and 
rate, prior quantity and rate, and percentages.

� Footer: This provides the subtotals and totals, together with any other summary 
information and messages.
13



T e c h n i c a l  d e t a i l s  a b o u t  Q u i c k B o o k s  d a t a  f i l e s
� Company: This enables you to specify whether to print the company logo, name 
and address details if you are not using pre-printed company paper.

� Format: This controls the font and size of different types of text, and whether to 
use status stamps.
14



C H A P T E R  1
� Printer: Choose whether to use printer settings, or set print options specifically for 
this type of form.
15



T e c h n i c a l  d e t a i l s  a b o u t  Q u i c k B o o k s  d a t a  f i l e s
Using the Layout Designer

In the Layout Designer, you can immediately see the effects of your changes, and drag 
the fields to the required positions. 

You can:

� Change the properties of a field, such as its label

� Add graphics or text boxes, with or without borders – which can have rounded 
corners (Pro/Accountant)

� Copy fields, which you can move to any position on the page – for example-
header-type fields can be moved to the bottom of the form (Pro/Accountant) 

� Delete unwanted fields.

Note: The changes you make in the Layout Designer affect the printed version of the 
form only.

For step-by-step instructions on customising forms, search the onscreen Help for 
customising forms.
16
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C H A P T E R  2
Overview

Your clients who ask about importing and exporting QuickBooks data may be 
interested in a variety of topics. Among these may be importing from and exporting 
to word processors, spreadsheets, other bookkeeping software, contact management 
software, other QuickBooks company files, or files for review by an accountant. 
QuickBooks has features that accomplish each of these tasks. Some perform 
automatically, but others require a little skill and work to accomplish. This chapter 
covers the import/export questions your clients are most likely to ask.

Understanding import and export formats

QuickBooks can export and import data in a format called IIF (Intuit Interchange 
Format), which is different from QIF (used by Quicken). QuickBooks imports only IIF 
data.

When you export information from QuickBooks, the program formats the data into 
IIF. You can then import the IIF file into spreadsheets, word processors, and database 
programs.

If you want to import data from other software applications, you need to create an IIF 
file from scratch or reformat data you already use to conform to IIF standards. (See 
“What is an IIF file?” on page 28.)

Creating an IIF file from scratch or changing data from another accounting program 
into an IIF file is technically complex. It is not recommended for those who do not 
have programming experience.

You do not need to learn about the IIF format to export lists and import them back 
into QuickBooks. Furthermore, you will not need to learn about the IIF format when 
exporting report data to Microsoft Excel, using the Write Letters feature with 
Microsoft Word, or when synchronising your QuickBooks list information with 
contact management software.

Capabilities and limitations of import and export

Description Import/Export?

Lists (customers, suppliers, items, etc.) Yes (most)

Transactions (invoices, payments, etc.) Import ONLY; must use IIF format

Estimates No

Timesheets No
19



I m p o r t i n g  a n d  e x p o r t i n g  d a t a
Importing and exporting between QuickBooks 
files

Using the Accountant’s Review to create an Accountant’s 
Copy file

The Accountant’s Review makes it easy for you to review and correct your client’s 
QuickBooks data. You make correcting entries in an “Accountant’s Copy” of the 
QuickBooks company file, while your client continues to make entries as usual in the 
original QuickBooks file. When you are finished, your client imports your changes. 
The table that follows gives you a quick reference for the capabilities of the 
Accountant’s Review feature. For full details on using the Accountant’s Review feature, 
refer to the onscreen Help.

For information on more ways to exchange QuickBooks data with your clients, see 
“Accessing client data” on page 161.

What an accountant can do with an Accountant’s 
Review copy

Accountant can Accountant cannot Client cannot

View all existing transactions 
and lists.

Enter transactions other than 
general journal transactions.

Delete any items 
from lists.

Add new items to the chart of 
accounts, Item list, Payroll Item list, 
To Do Notes list, Memorised 
Transaction list (general journal 
transactions only).

Memorise transactions other 
than general journal 
transactions.

Reorganise lists 
(move items, 
make one item a 
subitem of 
another).

Edit existing account name and 
numbers.

Edit or delete existing 
transactions, including 
pay cheques.

N/A

Edit existing payroll items. Reorganise lists (move items, 
make an item a subitem).

N/A

Edit account and tax information 
for existing items on Item list.

Make items inactive. N/A

Enter general journal transactions. Edit names of existing items 
on Item list.

N/A

Reconcile new transactions. Adjust payroll liabilities. N/A

Adjust stock values or 
quantities.

Enter or edit employee YTD 
payroll setup transactions.

N/A

Create reports. Memorise reports. N/A

Change preferences temporarily. Export changes to preferences. N/A
20



C H A P T E R  2
Transferring QuickBooks transactions between company files

There is no way to automatically transfer transactions from one QuickBooks file to 
another.

Transferring QuickBooks lists between company files

QuickBooks allows you to export most lists and their related information (addresses, 
phone numbers, and so on). You simply mark the lists that you would like to export, 
and QuickBooks creates a file that you can import into another QuickBooks company. 
This may be useful for a person who owns more than one company and uses the same 
customers and suppliers in each. Or, as a professional advisor, you may have a preset 
chart of accounts that you like to use when you set up a new client’s QuickBooks data 
file.

You should be cautious when importing lists into an existing QuickBooks company 
that already contains list data. QuickBooks assumes you are importing information 
that is more current than that contained in the existing file, so when it encounters 
duplicate entries, it replaces the entry in the existing company file with the one from 
the import file.

For example, suppose that both Supplier lists (in the existing file and the import file) 
have entries for Sergeant Insurance. The existing company file shows the address for 
Sergeant Insurance as 3 Dean Street, while the import file has Sergeant Insurance’s 
address as 26 Mellor Road. When you import the new Supplier list, QuickBooks 
replaces the Dean Street address with the Mellor Road address. Of course, this is only 
a problem if the import file contains incorrect or outdated information. We 
recommend that you always make a backup copy of an existing QuickBooks company 
file before you import new list data.

You can export these QuickBooks lists and information from one QuickBooks 
company to another.

* QuickBooks templates are imported and exported only from the Templates list.

Budgets Item list Ship Via list

Chart of Accounts Job Type list Templates list*

Class list Other Names list Terms list

Currency list Payment Method list To Do list

Customer:Job list Payment Terms list Supplier list

Customer Message list Payroll Item list Supplier Type list

Customer Type list Price Level list VAT Code list

Employee list Sales Rep list
21



I m p o r t i n g  a n d  e x p o r t i n g  d a t a
To export lists from one company and import them into another:
1 Open the company that contains the lists you want to transfer.

Exporting lists does not remove or modify the lists in the original file.

2 From the File menu, choose Utilities, and then choose Export.

3 In the Export window, select the lists you want included in the export file.

4 Click OK.

5 Enter a filename for the export file. 

The filename must have the IIF extension (for example, customer.iif).

6 Click Save.

7 From the File menu, choose Open Company. Select the filename of the company 
that you want to import into, and click Open.

8 From the File menu, choose Utilities, and then choose Import.

9 Select the export file you just created (for example, customer.iif).

10 Click Open.

To export templates from one company and import them into 
another:
1 Open the company file that contains the templates you want to transfer.

2 From the Lists menu, choose Templates.

3 Select the template you want to transfer.

4 From the Templates menu button, choose Export.

5 Enter a filename for the template. 

The filename must have the DES extension (for example, invoice.des).

6 Click Save.

7 From the File menu, choose Open Company. Select the filename of the company 
into which you want to import the templates, and click OK.

8 From the Lists menu, choose Templates.

9 From the Templates menu button, choose Import.

10 Select the export file you just created (for example, invoice.des).
22



C H A P T E R  2
11 Click Open.

12 Enter a filename for the template and click OK.

Exporting from QuickBooks to other software

When you export information from QuickBooks, the program formats the data into 
IIF. You can then import the IIF file into spreadsheets, word processors or database 
programs. 

You do not need to use IIF files when exporting report data to Microsoft Excel or CSV 
files, saving reports in PDF format, using the Write Letters feature with Microsoft 
Word, or when synchronising QuickBooks list information with contact management 
software.

Exporting QuickBooks lists

If you want to import information from a QuickBooks list into another program, you 
first need to determine if the other program has an import feature and which formats 
it supports. If the other program lets you import from a spreadsheet program, you may 
be able to modify the QuickBooks export file from within a spreadsheet, to match the 
format used by the other software program. You must have detailed information on 
the other program’s import specifications and be very knowledgeable about 
manipulating data in your spreadsheet program.

To export lists to a tab-delimited file:
1 Open the company file that contains the lists you want to transfer.

Exporting lists does not remove or modify the lists in the original file.

2 From the File menu, choose Export, then Lists to IIF files.

3 In the Export window, select the lists you want to include in the export file.

4 Click OK.

5 Enter a filename for the export file. The filename must have the IIF extension (for 
example, customer.iif).

6 Select the drive and folder where you want the export file to be created.

7 Click Save.

Exporting QuickBooks list data to Microsoft Word

Exporting QuickBooks list information to Microsoft Word requires QuickBooks Pro or 
Accountant and Microsoft Word 97, 2000 or 2002.

You can export most information included in QuickBooks lists to Microsoft Word 
using QuickBooks Letters. QuickBooks Letters are prewritten, preformatted business 
letters which include collection letters for customers, credit requests for suppliers, 
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memos for employees, and more. You can use the preset letters as is, or you can modify 
them by adding or removing QuickBooks fields or by changing the wording.

You create and modify letters using the QuickBooks Write Letters wizard which walks 
you through each step. When you’ve made all of your selections, you’ll leave the 
wizard and start creating letters in Microsoft Word.

When you modify existing letters, or create new ones, you use QuickBooks toolbars in 
Microsoft Word to add fields for QuickBooks information. Then, when you create 
letters to send, QuickBooks fills in the information from the fields you included in the 
QuickBooks Letter.

This is an example of one of the preset QuickBooks collection letters. The << >> 
symbols represent QuickBooks fields. The information in the fields is replaced with 
data from QuickBooks when you generate letters to send to customers.

To start writing letters:
� From the Company menu, choose Write Letters.

For more information, search the onscreen Help index for write letters.
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Exporting QuickBooks reports

You can export QuickBooks report data to other programs using Microsoft Excel, a 
CSV file or an ASCII file. You can also save QuickBooks reports as PDF files 
(QuickBooks Pro or Accountant only).

Exporting a report to Microsoft Excel

For greater flexibility in report formatting, data manipulation, and customisation, you 
can export QuickBooks report data to a Microsoft Excel spreadsheet. Because the 
changes you make in Excel do not affect the QuickBooks data, you are free to 
customise reports as needed and even change data to run “what-if” scenarios.

Note: To use this feature, you must be using QuickBooks Pro/Accountant and 
Microsoft Excel 97, 2000, 2002 or 2003.

When exporting a report to Microsoft Excel, you indicate whether or not you want to 
preserve the formatting of the QuickBooks report. You also have the option to turn on 
or off several Excel features from within QuickBooks.

By default, QuickBooks preserves the look of your report when exporting to Excel, and 
turns on the following features:

� AutoFit sets column widths in Excel wide enough to display data without cutting 
off words or numbers.

� Freeze panes allows you to scroll though data while keeping the row and column 
headers in view.

� Show Gridlines turns on gridlines in Excel.

To export a report to Microsoft Excel:
1 Generate the report you want to export.

2 On the report buttonbar, click Excel.

3 Choose whether you want to send the report to a new or existing spreadsheet file.

If you want to import data into another spreadsheet or database program, you can 
export QuickBooks report data to a CSV file.

4 (Optional) Click Advanced to select formatting options, turn on or off the Excel 
features listed, or to set printing options.

5 Click Export.

QuickBooks exports the report data (and formulas) to an Excel spreadsheet.

To show clients how to export reports to Microsoft Excel, refer to Lesson 9, “Analysing 
financial data,” in the QuickBooks Training Guide.
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Printing a report to a file

If you are not using QuickBooks Pro, or do not have Microsoft Excel 97 or higher, you 
can use the process described here to export a list or report from QuickBooks to 
another software program.

Almost any list or report can be printed to an ASCII or tab-delimited file. This makes 
it easy to transfer your transactions to a spreadsheet (tab-delimited) or word 
processing (ASCII) program. You simply customise and filter a QuickBooks report until 
it shows the transactions you need to export, and then print the report to a file.

To print a report to a file:
1 Display the report that contains the data you want to use in another program 

(word processor or spreadsheet).

2 Click Print on the report buttonbar, and select File in the “Print to” field.

3 From the drop-down menu, choose “ASCII text file” (word processor), “Tab 
delimited file” (spreadsheet), or “Comma delimited file” (spreadsheet).

4 Click Print.

5 In the Create Disk File window, enter a name for the file and select the drive and 
folder where you want the file to be saved.

6 Click Save.

7 Open the file with your word processor or spreadsheet program to format or edit it.

Saving a report in PDF format

With QuickBooks Pro or Accountant, you also have the option to save reports in PDF 
format.

To save a report in PDF format:
1 Generate the report.

2 (Optional) Modify the report if you want to change the fonts.

3 From the File menu, choose Save as PDF.

4 In the Save Report as PDF window, enter a name for the PDF file and select the 
drive and folder where you want to save the file.

5 Click Save.
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Importing information from other programs to 
QuickBooks

This section describes the two methods you can use to import information from other 
programs into QuickBooks:

� Intuit Interchange Format (IIF)

� Cmma Separated Value (CSV)

Importing information using IIF

This section gives an overview of the Intuit Interchange Format, and provides 
examples to guide you in constructing your own IIF files. The online help provides 
specific information about what is required for each type of file (search the index for 
Importing data then choose Reference guide to importing files).

A QuickBooks import file must be a text-only (ASCII) file that adheres to the Intuit 
Interchange Format (IIF). IIF files may contain transaction data (cheques, invoices, 
and so on) or list data (customers, suppliers, or items for sale). In fact, most 
QuickBooks information can be imported using an IIF file. If you would like to use this 
feature, you need to create an IIF file from scratch, reformat data you already use to 
conform to IIF standards, or write a computer program to reformat the data for you.

If you decide to create an IIF file from scratch or reformat the data “by hand,” we 
suggest that you use a spreadsheet program. We cannot offer specific suggestions 
about writing a computer program to create or reformat the data for you. You must 
already be proficient in a computer language to try this option.

Before you attempt to create an IIF file using any of these methods, we offer you these 
cautions:

� Creating an IIF file from scratch or changing data from another accounting 
program into an IIF file is technically complex, and is not recommended for those 
without programming experience.

� Unless you have a very large customer data base or more than 200 transactions, it 
may be easier and less time-consuming to enter the data directly into QuickBooks.

This section gives an overview of the Intuit Interchange Format and gives examples to 
guide you as you construct your own IIF files. For more information on creating IIF 
files, please search the onscreen Help index for importing data or IIF file format.

Important: As you read this section and create your own IIF file, you must take care
to position the columns and rows correctly, and type the IIF headers exactly as they
appear. A misspelt header or omitted punctuation mark will cause your import to fail.
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What is an IIF file?

An IIF (Intuit Interchange Format) file is a tab-delimited or comma-delimited text file.

In a tab-delimited text file, the data fields are separated by tabs. This format is typical 
of files created in spreadsheet programs. Here is an example of a chart of accounts 
import file using tab-delimited format:

In a comma-delimited text file, the data fields are separated by commas. This format 
is typical for files created in word processing programs. Here is an example of a chart 
of accounts import file using comma-delimited format:

!ACCNT,NAME,ACCNTTYPE,DESC

ACCNT,Current,BANK,Lloyds TSB

ACCNT,Sales,INC,Sales Income

Although you can create such text files using either a word processor or a spreadsheet 
program, we recommend that you use a spreadsheet, since the column and row layout 
found in spreadsheet programs makes editing data easier.

What are IIF file headers?

File headers are markers used to tell QuickBooks the type of data that follows. Without 
them, QuickBooks would not know how to interpret the data in your import file. 

IIF file headers always begin with an exclamation point. In the example below, the file 
header “!CUST” tells QuickBooks that the information that follows should be 
imported as a customer list. The file headers for lists (groups of customers, suppliers, 
employees, and so on) should always be placed in the first row of the data.

!ACCNT NAME ACCNTTYPE DESC

ACCNT Current BANK Lloyds TSB

ACCNT Sales INC Sales Income

!CUST NAME BADDR1 BADDR2 →

CUST Abercrombie, 
Kristy

Kristy 
Abercrombie

47 Elm Road →

CUST Cook, Brian Brian Cook 5 Cherry Lane →
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The headers used to import transactions (cheques, invoices, and so on) usually use 
both the first and second rows. In the following example, “!TRNS” tells QuickBooks 
that the information that follows is for a transaction. “!SPL” indicates the transaction 
is split among several accounts.

When you export a list from a QuickBooks company file, the program automatically 
creates an export file header similar to the one that follows. This header provides 
identifying information about the version of QuickBooks that created the file. It is not 
necessary to include this header when you create your own import files.

Each list that can be imported into QuickBooks requires its own unique file header. 
(For more information, search the onscreen Help index for importing data, Reference 
guide to import files.)

Importing lists with QuickBooks

This table is an example of a chart of accounts import file.

Importing transactions into QuickBooks

Creating a transaction import file is more complex than importing lists. Thus, it is 
essential that you read the “Reference guide to import files” topic in the onscreen 
Help. To view the topic, search on importing data. Then select the topic Reference guide 
to import files.

!TRNS TRNSTYPE DATE ACCNT  NAME CLASS AMOUNT →

!SPL TRNSTYPE DATE ACCNT  NAME CLASS AMOUNT →

TRNS CHEQUE 3/3/07 Main 
Current

Mobil Oil 
Company

-70 →

SPL CHEQUE 3/3/07 Fuel Cook, Brian 10 →

SPL CHEQUE 3/3/07 Car 
Repair

60 →

ENDTRNS

!HDR PROD VER REL IIFVER DATE TIME

HDR QuickBooks Version 
14.0

Release 
R9P

1 03/03/2007 794236875
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The tables below show all the file headers that can be used in an IIF file to import 
transactions into QuickBooks. Because there are too many columns to show, we have 
split the information into four tables. Also, we added the row labels (1 to 2) and 
column labels (A to AH) found in spreadsheet programs to make the information 
easier to understand. For example, the “CLEAR” header in box K1 of Table 2 would 
follow to the right of “MEMO” in box J1. 

Table 1 of 4

Table 2 of 4

Table 3 of 4

Table 4 of 4

It is not necessary to include every column shown here. Use only the columns that are 
related to the transaction you are importing. For example, if you only import cheques 
and deposits, there is no need to include columns like DUEDATE or INVITEM (stock 
item), since they do not contain information relevant to a cheque or a deposit. On the 
other hand, INVITEM is required if you are importing invoices. To find whether a 
column is required for a particular transaction, search the onscreen Help index for 
importing data, Reference guide to import files.

For examples of import transactions for various QuickBooks forms, visit 
www.QuickBooks.co.uk and search for IIF. Internet access is required.
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Importing information in Excel or CSV format

You can import an existing Excel (97, 2000 or 2002) file or CSV (comma-separated 
value) file into QuickBooks. You can import information for:

� Customers

� Suppliers

� Accounts

� Items

To avoid errors in data transfer, we recommend that you do the following before you 
import data:

1 Prepare the file for import into QuickBooks.

2 Map the data from the source file to QuickBooks.

3 Preview the data before you bring it into QuickBooks.

These stages are covered in more detail below.

Preparing a file for import

It is important that you format your Excel or CSV file data properly before you import 
it into QuickBooks. This reduces the likelihood of errors and makes the import process 
cleaner and faster.

Tip: The easiest way to see and understand the format that QuickBooks needs to 
import data is to export some QuickBooks lists and view the resulting file 
in a spreadsheet. If you don’t already have a QuickBooks company file, you 
can open a sample file and export lists from its data.

To prepare a data file for import into QuickBooks:
1 Open the spreadsheet that contains the data.

2 Move the contents of all the cells down by one row, so that the first row is blank.

3 In the blank row, create a header that follows the field recommendations for the 
type of data.

4 Check the structure of the spreadsheet. Each type of list (account, customer, item 
and supplier) should be in a separate spreadsheet or in a separate worksheet inside 
a master spreadsheet.

Mapping data to QuickBooks

Mappings tell QuickBooks how to import the Excel or CSV data into the companay 
data file. You can create and save mappings. You only need to map required fields i 
order to save a mapping; mapping other fields is optional.
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To map data to QuickBooks:
1 From the File menu, choose Import, then choose Excel Files.

2 Select the Excel or CSV file you want to import.

3 Select a sheet. If your worksheet contains only one page, select Sheet 1.

4 From the Choose a mapping drop-down list, select Add New.

5 Type in a name for your mapping.

6 Select an Import type (Account, Customer, Supplier or Item).

7 In the QuickBooks column, select the row of information you want to map.

8 In the Import data column, use the drop-down button to select which column in 
the import file should be mapped to the QuickBooks column.

9 Repeat this process for each row of information you want to import.

10 Click Save.
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11 To preview the data (and correct any errors) before importing into QuickBooks, 
click Preview.

Importing the file

To import an Excel or CSV file:
1 From the File menu, choose Import, then choose Excel Files.

2 At the Set up Import tab, choose the file you want to import.

3 Select the sheet. If there is only one sheet, select Sheet 1.

4 Specify whether the file you’re importing has header rows.

5 From the drop-down list, choose the mapping.

6 At the Preferences tab, set your preferences about how you want to handle 
duplicate data and errors.

7 (Optional) Click Preview to see how the data will be imported into QuickBooks.

8 Click Import.
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Integrating QuickBooks Pro/Accountant with 
other applications

Integrating QuickBooks with other software is much more secure than manually 
importing and exporting your data, and QuickBooks validates integrated data as it 
goes. Some applications may be able to run automatically even when no one is 
working in QuickBooks. 

We recommend that you back up your QuickBooks data prior to installing any third-
party application. Control of the third-party application will remain in your hands. 
You must give the application permission before it can access your QuickBooks files. 
You can also set permissions on a third-party application by using the existing user 
permissions feature. 

The first time the application tries to access a company file, an authorisation window 
appears. You can then choose whether to allow the application to:

� Access the file once 

� Access the file in the future without asking 

� Deny the application permission to access the file 

In some cases, the application developer may digitally “sign” the application. 
Associated with the signature is a certificate containing the name and other 
information of the developer of the software. If the certificate is valid and the 
application has not been modified since it was signed, the certificate shows the 
application’s name, the developer’s name, and the name of the certificate authority—
the agency that issued the certificate. For questions and details regarding the 
trustworthiness of a particular certificate authority or digital certificate, consult the 
certificate authority’s Web site. 

You may be able to get additional information about the application and its developer 
by going to the QuickBooks Solutions Marketplace. 

There may be instances in which you want an integrated application—one designed 
to share data with QuickBooks—to access QuickBooks files automatically, without 
user intervention. This might permit, for example, a particular application to run 
during the night when there is no other activity on the company file. 

If you want to allow applications to access QuickBooks files automatically, you may 
also want to restrict what those applications can do. You can do this by creating a user 
specifically for the application to use to log into QuickBooks, then restricting the 
access permissions that user has. 

You can also restrict an application’s ability to access QuickBooks files by using the 
preferences to set or modify permissions or restrictions on an integrated application. 
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Allowing an integrated application to access QuickBooks 

Note: The QuickBooks Administrator is the only user who can do this. 

You enable permission in the authorisation window when the application first tries to 
access QuickBooks, which adds it to the Authorised Applications List. You then set 
Preferences to specify the user and permissions for the application.

To allow the application to access QuickBooks:

In the authorisation window, choose whether to allow the application to:

� Access the file once – click “Yes, This Time”.

� Access the file in the future without asking – click “Yes, Always”

� Deny the application permission to access the file – click “No”

To specify permissions through Preferences
1 In QuickBooks, from the Edit menu, choose Preferences.

2 Select Integrated Applications, and Company Preferences.

3 Make sure that the “Don’t allow any applications to access this company file”box 
is clear, not ticked. 

4 To restrict an application from accessing QuickBooks automatically if its certificate 
expires, select “Notify the user before running any applications whose certificate 
has expired”.

5 For each application you want to access QuickBooks, tick the Allow Access 
column.

6 Select the application, and click Properties.

7 To enable integration, tick “Allow this application to access this company file”.

8 To enable automatic integration, clear “Prompt before Allowing Access” and tick 
“Allow this application to log in automatically”. 

9 If your company has multiple users, select a user for the application to log in as.
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10 Click OK.

11 In the third-party application, set it to log in to QuickBooks and run at the desired 
time. 

Note: This requires leaving your computer on. If you leave the computer 
unattended, it should be in a locked room or otherwise physically secured.

Sharing QuickBooks Pro/Accountant data with 
contact management software

You can configure QuickBooks Pro/Accountant to synchronise information from the 
Customer:Job, Supplier, and Other Names lists with Symantec ACT! or Microsoft 
Outlook contact management software. Being able to synchronise the information 
between QuickBooks and a contact management program means not having to enter 
contact information in two applications.

Synchronising with contact management software requires QuickBooks Pro/
Accountant and one of the contact management software programs listed in the 
following table.

Only a subset of the information contained in the contact manager can be 
synchronised with QuickBooks because contact managers store so much more 
information than QuickBooks needs for lists. However, you can synchronise the most 
vital contact information (including name, address, and fax number).

When synchronising information between QuickBooks Pro/Accountant and 
Symantec ACT! or Microsoft Outlook, you have three options for transferring data:

� QuickBooks to contact manager

� Contact manager to QuickBooks

� QuickBooks to contact manager and contact manager to QuickBooks

Information is not deleted with any of the transfer options.

Note: QuickBooks currently can’t accommodate the direct transfer of contact 
information from a personal digital assistant (PDA).

After completing a brief setup process, you can synchronise information between 
QuickBooks and the contact management software. During synchronisation, the 
contact management wizard will point out records in which the information in 
QuickBooks and the contact manager do not match and will offer a number of options 
for resolving the conflicts or discrepancies between the software programs.

Product Versions supported

Symantec ACT! 3.0.8, 4.0.2, 2000

Microsoft Outlook 97, 98, 2000, 2002
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To set up for sharing information with a contact manager:
1 As a precaution, back up the company data file.

2 From the Company menu, choose Synchronise Contacts.

3 Follow the onscreen instructions.

For more information, see the chapter “Staying in touch with important contacts” in 
the QuickBooks User Guide, or search the Help index for contact management.

Using QuickBooks Remote Access

With QuickBooks Accountant, you can use the QuickBooks remote access service to 
access a QuickBooks company file on another computer. 

There are two ways you can do this:

� You can check something in a client’s file, enter changes, or even set up a new 
company file without being at your client’s place of business. 

To do this, both you and your client must have an Internet connection. Remote 
access lets you work with your client’s QuickBooks software and other programs 
that integrate with QuickBooks, but not programs unrelated to QuickBooks.

� You can access your own company file from a remote location.

To do this, your company computer must be running QuickBooks with the 
company file open, and it must have an active Internet connection.

The computer you are using does not have to be running QuickBooks, so you can 
always access your file when you are away from the office.

Note: To use remote access, Internet access is required. One 12-month basic 
subscription valid for customers who purchase and install QuickBooks 
Accountant Edition software before the end of December. After 12 
months, users can subscribe to the service for a fee. Fees apply for 
additional subscriptions. Service subject to change.

To sign up for remote access: 
1 Connect to the Internet as you usually would.

2 From the Accountant menu, choose Remote Access. 

3 Click the link to Sign Up Now. 

To access a client’s QuickBooks file: 
1 Connect to the Internet as you usually would.

2 From the Accountant menu, choose Remote Access. 

3 Log in with your user name and password. 

4 Call or email your client with his or her unique session number and the web page 
he or she should visit. 

5 Request control of your client's QuickBooks file. 
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6 When the client approves your request, work with their QuickBooks data as you 
normally would. 

Note: Internet access is required. Service subject to change.

To access your own QuickBooks file: 
1 Connect to the Internet as you usually would.

2 Log in to the Remote Access web page with your user name and password. 

3 Select your work computer. 

4 Enter your access code.

5 Work with your QuickBooks data as you normally would. 

6 Once you have finished, make sure you choose End Session, and close the browser 
on the remote computer, especially if you are working on one that other people 
can access.

Note: Internet access is required. Service subject to change.

Setting up QuickBooks for income tax self-
assessment

Sole traders can use QuickBooks income tax reports to prepare UK Self-Assessment Tax 
Returns. Follow the steps below to get accurate tax information for these reports. 

Setting up QuickBooks income tax information

Follow these steps to set up QuickBooks to track self-assessment tax information:

1 From the Company menu, choose Company Information.

2 In the Legal Name field, enter the company name as you want it to appear on tax 
forms.

3 In the Legal Address area, enter the complete business address as you want it to 
print on legal forms.

4 Choose the first month of your income tax year from the drop-down list.

5 Choose Self-Assessment Tax Return from the drop-down list in the Income Tax 
Form Used field.

6 Click OK.

Associating tax-related accounts with income tax lines

For each tax-related (i.e., expense or income) account on the chart of accounts, follow 
these steps to associate the account with an income tax line:

1 From the Lists menu, choose Chart of Accounts.

2 Highlight a tax-related account on the list.
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3 Click on the Account button and choose Edit.

4 From the Tax Line drop-down list, select the tax line you want to associate with 
the account.

5 Click OK.

6 Repeat the previous steps for each tax-related account.

QuickBooks is now set up to associate tax-related accounts with the assigned tax line 
when transactions are entered.
39



I m p o r t i n g  a n d  e x p o r t i n g  d a t a
Converting from Quicken or earlier versions of 
QuickBooks

For complete information on how to install QuickBooks and how to convert data from 
Quicken or earlier versions of QuickBooks, please refer to the User Guide.

For information about setting up company files for clients who are converting from 
Quicken, see “Converting from Quicken to QuickBooks” on page 151 of this guide.
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Overview

This chapter describes how to find and generate the preset reports in QuickBooks. If 
you find that a particular preset report doesn’t meet your needs, take advantage of the 
extensive customisation and filtering options described in this chapter to create the 
reports you want for you and your clients.

Once you’ve customised and filtered report data, see “Saving report settings” on 
page 89 for instructions on how to save (memorise) the settings so you don’t have to 
recreate the report from scratch each time. 

Once they are memorised, you and your clients can easily recall these reports. You can 
use report templates to export the layout and filters of memorised reports so your 
clients can import them (provided they are using the same release version of 
QuickBooks).

See “Evaluating client data” on page 167 for more information about specific reports 
that you might use to evaluate client data.

When reviewing the reports you or your clients have created, you can use 
QuickZoom to see the transactions affecting the income and expense accounts. For 
example, when you review QuickBooks reports, you may see errors or discrepancies in 
particular areas. When you question an amount on a report, you can QuickZoom 
(double-click) the amount to see a detailed transaction report of the figures that make 
up that amount. This lets you return to the source of the transaction and make 
corrections. For example, you might find that your client has inadvertently created 
two expense accounts for car expenses—one named “Auto expense” and one named 
“Car expense”—that you need to merge together.

If there are entries that would affect the balance sheet accounts, you can make changes 
in the form of a journal entry, and provide the client with the journal entry. (To make 
journal entries in QuickBooks, choose Make Journal Entry from the Company menu.)

Generating QuickBooks reports

This section describes how to find and generate the QuickBooks reports you need. If 
the preset report does not meet your needs exactly, use the information in the 
following sections to customise the data to get the report you want.

For information on how to restrict access to reports when using multi-user 
QuickBooks, see “Setting up clients” on page 143.

Using the Report Finder

With the Report Finder, you can quickly review and choose among the many preset 
reports that QuickBooks provides. To help you choose an appropriate report, the 
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Report Finder displays a sample of each report, as well as a summary of what the report 
conveys.

To use the Report Finder:
1 From the Reports menu, choose Report Finder to display the Report Finder 

window:.

2 Choose the category of report that you want to view from the Select a type of 
report drop-down list, and then select the name of the report you want to view.

QuickBooks displays an example of the report, using sample data from a fictitious 
company.

3 Click Display to generate the report you’ve selected in the list using data from the 
company file in which you are working.

Using the Reports menu

Once you are familiar with the available preset reports, if you know which report you 
want, you may prefer to select it directly from the Reports menu.

To generate a preset report:
� From the Reports menu, choose the category of report you want to generate, then 

choose the report you want from the submenu.

To generate a list report:
� From the Reports menu, choose List. Then choose the report you want to create.
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QuickBooks report types

QuickBooks provides a wide variety of preset reports designed to give you and your 
clients easy access to company information.

QuickBooks reports can be classified as one of these three types:

� Summary reports

� Transaction reports

� List reports

Summary reports

A summary report summarises and subtotals the data. For example, a standard profit 
and loss report summarises the amounts for each income or expense account:

Tip: You can double-click (QuickZoom) any number in a summary report to get 
a transaction report, so you can easily see the detailed transactions behind 
the numbers.
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Transaction reports

A transaction report shows each transaction that makes up the subtotals.

The profit and loss detail report shows year-to-date transactions (instead of totals only) 
for each income and expense account. It is considered a transaction report:

Tip: You can double-click (QuickZoom) any line in a transaction report to open 
the original transaction (for example invoice or bill).
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List reports

List reports do not display transaction information like summary or transaction 
reports; instead, they allow you to report on information stored in your Customer, 
Supplier, or Employee lists.

QuickReports

QuickReports display all the transactions recorded in QuickBooks for a specific list 
entry. For example, you can generate a QuickReport for an account on the chart of 
accounts list—like a bank account—or generate one for a customer, supplier or item.
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Understanding basic customisation options

The choices you have for customising a report depend on the type of report you want 
to create. Certain options apply globally to all preset reports, certain similar options 
apply to all types of summary reports, and other options to all types of transaction 
reports are similar, and finally there are options that are similar for all types of report.

Global options

Certain settings control all reports generated in QuickBooks.

Hiding account numbers on financial statements

If the option to use account numbers is turned on, QuickBooks displays and prints the 
account numbers on all financial reports. If you want to print financial statements 
without the account numbers, you must temporarily turn off the “Use account 
number” preference while printing the reports, and then turn it back on when you 
have finished printing them.

To turn on/off account numbers:
1 From the Edit menu, choose Preferences.

2 Click Accounting in the scroll box.

3 Click the Company Preferences tab.

4 Click “Use account numbers” to turn the preference on or off.

Setting report preferences

There are a number of other global preferences you can set, which will affect the 
default settings used as the basis for most reports. You can also set the default report 
format, which you can reset on individual reports as required.

To change report preferences:
1 From the Edit menu, choose Preferences.

2 Select Reports & Graphs.

3 Click the Company Preferences tab.
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Note: Only the QuickBooks Administrator can change Company Preferences.

4 Change the settings as required by clicking the appropriate button:

� the report basis for summary reports as accrual or cash (note that you can reset 
this default on most individual summary reports)

� whether ageing reports are based on the due date or the transaction date

� show accounts by name, description or both

� whether to show balance sheets in UK format or QuickBooks format

5 Click Format.

QuickBooks displays the Report Format Preferences window, with the 
Header/Footer view.

6 To change which items are included in the header or footer, tick or clear the boxes.
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7 To change the date format in the header, select the required format from the drop-
down list.

8 Click the Fonts & Numbers tab.

9 To change the font, select the text type (e.g. Report Title) and click Change Font.

QuickBooks displays the font dialog box for the selected type of text.

10 Change the font, style, size and colour, and click OK. 

When QuickBooks asks if you want to change all related fonts, click Yes to change 
the font for all types of text, or click No to change only the selected type of text.

11 To switch to a different format for negative amounts, select the option you want 
(for example, show negative numbers in bright red).

12 To reduce numbers to multiples of 1000, select “Divided By 1000.”

For example, the amount 15,523 displays as 15.5.

13 To show pound amounts without pence, select “Without Pence.”

This rounds each amount up to the nearest pound.

14 Click OK.
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Customising summary reports

In QuickBooks, report customisation is simple because most customisation features 
are grouped together. In a single window, you change the date range for reports, add 
or delete columns, change the reporting basis, select filters for the report, modify 
header and footer information, and adjust the page layout. In the same location, you 
can also select the fonts you want to use for a given report, and tell QuickBooks how 
you want to numbers to display.

To customise QuickBooks preset reports, click Modify Report on the report buttonbar. 
This displays the Modify Report window, with different report settings on the four 
tabs according to the type of report. For example, if you create a summary report, the 
window looks something like this:

For a description of each option in the Modify Report window, see the tables below.

Important: Not all options are available for all summary reports. See “Customising
QuickBooks preset reports” on page 60 for a list of the options available.

If you want a summary-style report, and none of the preset reports meet your needs, 
try a custom summary report. For a custom report, QuickBooks lets you specify the 
columns you want across the top (how you want to subtotal the data) and the type of 
information you want on the rows (such as income or expense accounts or customers).

Changing summary report default information

By default, most summary reports in QuickBooks display only “Active” information 
for rows and columns in financial statements. (Active includes only those rows and 
columns that show activity during the period of the report.) You can change this 
default to “All” or “Non-zero”.

� “All” displays accounts and names even if there was no activity during the 
specified report period.
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� “Non-zero” hides all accounts and names that have a zero balance during the 
report period.

The preset time period for most summary reports is the current financial year, so for 
example year-to-date reports always start with the first month of your client’s 
financial year. You can change the date range of the report to “Calendar year” or 
“Payroll year,” if different.

To change summary report default information:
1 Create a summary-style report (for example, a profit and loss standard report).

2 Click Modify Report.

3 Click Advanced to display this dialog box:

4 Select desired options for Display Rows, Display Columns, Reporting Calendar.

5 Click OK to close the Advanced Options dialog box.

6 Click OK to close the Modify Report window.

Selecting cash or accrual-based summary reporting

You can view most summary reports on a cash or accrual basis by customising the 
report when you create it (transaction reports are always on a cash basis).

To change the basis of the current report:
1 In the Report window, click Modify Report.

2 On the Display tab, select either Cash or Accrual as the report basis.

3 Click OK.

If you wish to change the reporting basis for summary reports, follow the procedure 
below. Changing this preference affects most summary reports.

To change the basis for all summary reports:
1 From the Edit menu, choose Preferences.

2 Select Reports & Graphs.

3 Click the Company Preferences tab.

Note: Only the QuickBooks Administrator can change Company Preferences.

4 Under “Summary reports basis,” select either Cash or Accrual.

5 Click OK.
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Basic customisation options for summary reports

Additional options for customising budget reports

Additional options for customising ageing reports

Summary 
report option

Use to:

Report Dates Set the date range for the report. You can choose a time period 
from the drop-down list, or enter a custom date range in the 
From and To fields.

Report Basis Choose whether the report is done on an accrual or cash basis.

Columns Subtotal amounts in columns for time periods or other factors. 
For example, if you choose Month, QuickBooks displays your 
report with separate columns for each month, within the date 
range of the report.

Add Subcolumns Select the additional columns you want included in the report 
(such as Previous Period, Previous Year, Year-to-date, % of YTD, 
% of Income, % of Expenses, % of Row, % of Column). Column 
headings with a tick are included.

Sort By Choose whether to sort by transaction order (Default) or amount 
order (Total); also by ascending or descending order for either.

Units of Measure 
(Pro/Accountant)

Choose whether to express quantities and units in stocking, 
selling or purchasing units.

Budget 
report 
customise 
option

Use to:

Show Actuals Choose whether the report should show actual amounts in 
addition to budgeted amounts. 
If you select “Show actuals,” you can also select either or both of 
the next two options: “£ Difference” and “% of Budget.”

Ageing 
report 
customise 
option

Use to:

Days per ageing 
period?

Restrict transactions included in the report according to their age-
ing period. In this field, enter the period of time you want each 
column to represent. For example, if you type 30, the column 
headings would be “Current,” “1-30,” “31-60,” and so on.

Age through how 
many days?

Specify the maximum number of days for which you want a 
breakdown of ageing intervals. For example, if you don’t want 
the report to go past 90 days, type 90 in this field.
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Additional options for customising time reports 
(QuickBooks Pro/Accountant only)

Additional options for customising cash flow forecast 
reports

Additional options for customising custom summary 
reports

Time report 
customise 
option

Use to:

Formats Determine how the report breaks down the amounts for time 
worked. For example, if the format is “Time by Job by Item,” the 
report shows how much time went into each type of work your 
company did for each job. If, instead, you wanted the report to 
show how much time each employee worked on each job, you 
would choose “Time by Job by Name.”

Cash Flow 
Forecast 
report 
customise 
option

Use to:

Reporting Periods Choose a time period that you want QuickBooks to use for the 
report. For example, if you have the reporting period set to one 
week, the report shows your cash flow at 7-day intervals for the 
date range you specify.

Delay receipts 
how many days?

Slow down receipts to produce a more conservative and realistic 
cash flow. If you leave this field set to 0, QuickBooks includes all 
receipts where the due date falls within the date range of the 
report. If you type a number greater than zero, QuickBooks 
doesn’t include a receipt until it is that number of days past its 
due date.

Custom 
report 
customise 
option

Use to:

Display rows by Customise the row headings you want for your report by 
choosing them from a drop-down list.

Display columns 
for

Specify whether the report should include columns for Amount, 
Quantity, or Both.
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Customising transaction reports

When you create a transaction report and click the Modify Report button from the 
report window, QuickBooks displays a Modify Report window similar to this one:

When you click the Advanced button, QuickBooks displays a window similar to this:

The table below describes each option available for customising transaction reports.

Important: Not all options are available for all transaction reports. See “Customising
QuickBooks preset reports” on page 60 for a list of the options available and the
default settings for each option.

Customise 
option

Use to:

Report Dates Set the date range for the report. You can choose a time period 
from the drop-down list, or type a custom date range in the From 
and To fields.

Report Basis Choose accrual or cash basis.

Columns Select the columns you want included in the report. Column 
headings with a tick are included.

Total By Change how QuickBooks groups and subtotals the individual 
transactions on the report.
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If you want a transaction-style report, the most flexible is the custom 
transaction detail report. This report lets you specify how QuickBooks groups and 
subtotals the individual transactions on the report (in the Total By field), as well as the 
order in which transactions appear within a group (for example, in date order).

Displaying Debit and Credit columns on transaction 
reports

By default, QuickBooks displays transaction-style reports to show amounts as positive 
and negative, rather than as debits and credits. You can modify a QuickBooks report 
to display and print Debit and Credit columns, instead of the preset Amount column.

To display Debit and Credit columns on transaction reports:
1 Create any transaction-style report (for example, a transaction by date report).

2 In the report window, click Modify Report.

3 In the Columns section on the first tab, select Debit and Credit, and clear the 
Amount column. (A tick shows that a column is selected.)

4 Click OK.

QuickBooks replaces the Amount column with Debit and Credit columns.

Important: The trial balance report (summary) and the journal report (transaction)
are always preset to show the Debit and Credit columns. Both reports are on the
Accountant & Taxes submenu.

Sort By Change how QuickBooks sorts the transactions on a report. 
Transactions normally appear in date order (earliest first) on a 
report; you can also sort by amount or document order.

Units of Measure 
(Pro/Accountant)

Choose whether to express quantities and units in stocking, 
selling or purchasing units.

Show Detail 
(Journal report)

Choose whether the report shows each individual transaction or 
summarises totals.

Date Entered/Last 
Modified (Audit 
trail report)

Set the date range for the transactions included in the report. 
QuickBooks includes a transaction if it was either entered or 
modified within the date range you specified.

Include Specify whether you want to include all transactions, or only 
those that show activity during the period covered by the report.

Open Balance/
Ageing

Determine how QuickBooks calculates a customer’s open balance 
on an ageing report. Choose “Current” to show the customer’s 
open balance as of today. Choose “As of Report Date” to show 
the customer’s open balance as of the ending date of the report.

VAT Basis Choose Net or Gross.

Customise 
option

Use to:
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Changing columns on transaction reports

If a report has too many columns to display all information on your screen, as is true 
of most transaction reports, you can choose to hide columns that you don’t need.

To hide columns on a transaction report:
1 Create a transaction-style report (for example, a general ledger report).

2 Click Modify Report.

3 For Columns, clear (click) columns you do not need to view onscreen.

For example; Left Margin, Memo, and Split can usually be removed from the 
general ledger report.

4 Click OK.

You can also follow these steps to add columns to the report. For example, to add the 
transaction number (trans no), date last modified, or custom field information to the 
general ledger report, just tick the columns you want to display. 

You can use this feature to combine transaction information with contact details. For 
example, adding columns for customer contact name and phone number to an A/R 
Ageing Summary gives you a list of overdue receivables with details of who you need 
to chase for payment.

Customising list reports

When you customise list reports, QuickBooks displays the fields available in the 
particular list you are reporting on. Because each list contains different fields, the 
Modify Report window for each list report is unique. For example, the Modify Report 
window for the customer phone list looks like this:

In addition to the customisation options described earlier in this chapter, you can sort 
report data by column and rearrange columns in reports.
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Sorting report data

If you wish, you can change the columns on which certain QuickBooks reports are 
sorted. You can also change the report settings to sort report data in ascending or 
descending order.

Sorting behavior varies by type of report and is not available for all reports. This table 
provides examples of the types of reports that can and can’t be sorted in QuickBooks.

Because you can only sort on columns displayed in a report, you may need to add 
columns to standard QuickBooks reports to be able to sort the data the way you want. 

Adding and deleting report columns

QuickBooks makes it easy to create the reports you want by allowing you to add, 
delete, and rearrange report columns. The ability to add or delete columns is not 
available on all reports.

To add or remove columns from a report:
1 Generate the report you want to modify.

2 Click Modify Report on the report buttonbar.

3 In the columns section of the Display tab, click the columns you want to add or 
delete from the report (a checkmark indicates that a column is included in the 
report).

4 Click OK.

Report type Examples Able to sort

Regular Detail Customer Balance Detail, 
Transaction Detail by Account

Yes

Specialised Detail Profit & Loss Detail, Sales by 
Item Detail

Yes

Transaction Journal, Deposit Detail Yes

List Supplier Contact list, Item 
Price list

Yes

Specialised Summary Profit & Loss Standard, 
Balance Sheet Summary

Yes

Regular Summary A/R Aging Summary, 
Purchases by Supplier 
Summary

Yes

Time Summary 
(Pro/Accountant)

Time by Job Summary, Time 
by Name

Yes

Time Detail 
(Pro/Accountant)

Time by Job Detail No
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When you add a column to a report, QuickBooks adds that column to the “Sort by” 
drop-down list (for reports that allow sorting).

If you are adding columns to a report which currently has the original column order, 
QuickBooks inserts the new columns in the order in which they appear in the column 
list for that report. If you have altered the display order of columns, QuickBooks 
inserts each new column to the left of the column in front of which it would normally 
appear.

Moving report columns

You move columns in transaction and list reports by dragging and dropping them (not 
available for summary reports).

To move a report column:
1 Generate the report in which you want to change column order.

2 Place the mouse pointer over the header for the column you want to move.

Note: You can move only one column at a time.

3 Hold down the mouse button and drag the column to the new position, and then 
release the mouse button.

You can only move columns to areas you can see onscreen. If you have a very wide 
report and you want to move a column to a part of the report that you can’t see, move 
the column in the desired direction until you reach to the edge of the report window. 
Then, scroll through the report and move the column again. Continue this process 
until you have moved the column to the desired location.

Turning off the date, time, and report basis stamps

QuickBooks reports are set to display the date, time, and report basis in the header 
area. However, you can turn the stamps off on a report-by-report basis.

To turn off the date, time, and basis stamps on reports:
1 Generate the report in which you want turn off the stamps.

2 Click Modify Report, and then click the Header/Footer tab.

3 Click to clear the checkmarks for those items you do not wish to display.

4 Click OK.

5 (Optional) Click Memorise to save the report settings for future use.
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Changing fonts and colours in a report

To change fonts and colours in a report:
1 In the report window, click Modify Report.

2 Click the Fonts & Numbers tab.

3 To change the font for a particular type of text, select the text type (for example 
Report Title) and click Change Font.

QuickBooks displays the font dialog box for the selected type of text.

4 Change the font, style, size and colour, and click OK.

5 Click OK again.

Note: To change for all reports, see global settings on page 48.

Changing how numbers display in a report

To change how numbers display in a report:
1 In the report window, click Modify Report.

2 Click the Fonts & Numbers tab.

3 To switch to a different format for negative amounts, select the option you want.

4 To reduce numbers to multiples of 1000, select “Divided By 1000.”

For example, the amount 15,523 displays as 15.5.

5 To show pound amounts without pence, select “Without Pence.”

This rounds each amount up to the nearest pound.

6 Click OK.

Note: To change for all reports, see global settings on page 48.

Customising QuickBooks preset reports

The following tables show which options you can set in the Modify Report window 
for each type of QuickBooks report. The type is shown after the report name and tells 
you whether the report type is a summary (S), transaction (T) or list (L) report. If a 
customise option has a preset value, it is listed in parentheses after the option name. 
Advanced options are shown in italics.

Note: If a feature isn’t turned on, reports relating to that feature will not appear 
on the menus (for example if you don’t have Time Tracking turned on, the 
time-related reports do not appear on the Jobs, Time & Mileage report 
menu).

Tip: If you have a question about one of the options shown in the “Customise 
options” column, refer to “Customising summary reports” above.
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Profit and loss reports

To generate these reports from the Reports menu, choose Company & Financial, and 
then choose the report you want to create.

P&L report 
(type) Description Modify Report options

Profit & Loss 
Standard
(S)

Summarises income and 
expenses, totalled by 
income or expense 
account.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Profit & Loss 
Detail
(T)

Lists each income and 
expense transaction for the 
financial year to date, 
grouped and 
subtotalled by income and 
expense account.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Profit & Loss YTD 
Comparison
(S)

Like the standard profit and 
loss statement, but with 
one column for this month 
to date and a second col-
umn for this year to date.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns (Year-to-date)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Profit & Loss 
Prev Year 
Comparison
(S)

Like the standard profit and 
loss statement, but with 
columns for this year to 
date, previous year to date, 
amount and % change.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns
� Subcolumns (Previous Year, 

£ Change, % Change)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Profit & Loss by 
Job
(S)

Like the standard profit and 
loss statement, but with 
columns for each customer 
and job. Amounts are for 
the financial year to date.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Customer:Job)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
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Profit & Loss by 
Class
(S)

Like the standard profit and 
loss statement, but with 
columns for each class and 
subclass. Amounts are for 
the financial year to date.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Class)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Profit & Loss 
Unclassified
(S)

Like the standard profit and 
loss statement, but 
showing only unclassified 
totals. Amounts are for the 
month to date.

� Report Dates (Month-to-date)
� Report Basis (Total only)
� Columns (Class)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Income by 
Customer 
Summary
(S)

Summarises net sales 
income by customer and 
job for financial year to 
date.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� VAT Basis (Net)

Income by 
Customer Detail
(T)

Lists sales, returns, and 
reimbursed expenses for 
the financial year to date, 
grouped and subtotalled by 
customer and job.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Expenses by 
Supplier 
Summary
(S)

Summarises net expenses 
by supplier for the 
financial year to date.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� VAT (Net)

Expenses by 
Supplier Detail
(T)

Lists each expense and 
credit transaction for the 
financial year to date, 
grouped and 
subtotalled by supplier.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT (Net)

P&L report 
(type)

Description Modify Report options
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Balance sheet reports

To generate these reports from the Reports menu, choose Company & Financial, and 
then choose the report you want to create.

Balance 
sheet report 
(type)

Description Modify Report options

Balance Sheet 
Standard
(S)

Shows the balance in each 
balance sheet account, with 
subtotals for assets, liabili-
ties, and equity.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Balance Sheet 
Detail
(T)

Shows the starting balance 
at the beginning of last 
month, transactions 
entered in the account for 
this month to date, and the 
ending balance as of today.

� Report Dates (This Month-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Include (All)
� Open Balance/Ageing (Current)

Balance Sheet 
Summary
(S)

Shows amounts for each 
account type but not for 
individual accounts.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Balance Sheet 
Prev Year 
Comparison
(S)

Has columns for today, a 
year ago, amount and 
% change.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns (Previous Year, 

£ Change, % Change)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
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Cash flow reports

To generate these reports, from the Reports menu, choose Company & Financial, and 
then choose the report.

For instructions on how to classify cash, use the Search facility in the onscreen Help 
for statement of cash flows report or cash flows forecast report.

Customers and receivables reports

To generate these reports from the Reports menu, choose Customers & Receivables, 
and then choose the report you want to create.

Cash flow 
reports (type)

Description Modify Report options

Statement of 
Cash Flows
(S)

Shows net change in cash 
during a period.

� Report Dates (Financial Year-to-Date)
� Display Rows (Non-zero)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Cash Flow 
Forecast
(S)

Shows expected cash 
inflows, expected cash 
disbursements, and 
expected bank account 
balances, so you can 
forecast how much cash 
you'll have.

� Report Dates (Next 4 Weeks)
� Reporting Periods (Week)
� Delay receipts how many days (0)

A/R report Description Modify Report options

A/R Ageing 
Summary
(S)

Shows when invoice pay-
ments are or were due, 
subtotalled by customer.

� Report Dates (Today)
� Days per ageing period (30)
� Age through how many days (90)
� Open Balance/Ageing (Report date)

A/R Ageing 
Detail
(T)

Lists each unpaid invoice 
and open credit memo, 
grouped and subtotalled by 
days overdue. Tells how 
many days an invoice is 
overdue.

� Report Dates (Today)
� Report Basis (Accrual)
� Columns
� Units of Measure (Purchasing Unit)
� Open Balance/Ageing (Report date)

Customer 
Balance 
Summary
(S)

Shows balances for cus-
tomers with unpaid bal-
ances, as of the ending 
date.

� Report Dates (All)
� Columns (Total only)
� Subcolumns
� Display Rows (Non-zero)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� VAT Basis (Net)
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Customer 
Balance Detail
(T)

Lists each invoice, credit 
memo, payment, cash sale, 
and general journal entry, 
subtotalled by customer. 
Total for customer equals 
customer’s unpaid balance.

� Report Dates (All)
� Report Basis (Accrual)
� Columns
� Total by (Customer)
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Open Invoices
(T)

Lists each unpaid invoice, 
grouped and subtotalled by 
customer.

� Report Dates (Today)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Collections 
Report
(T)

Displays which invoices are 
overdue by a specified 
number of days, along with 
customer names and 
phone numbers.

� Report Dates (Today)
� Columns
� Units of Measure (Stocking Unit)
� Include (Active)
� Open Balance/Ageing (Report date)
� Days Past Due (1) (on report header)

Unbilled Costs 
by Job
(T)

Shows any outstanding 
reimbursed expenses that 
have not yet been charged 
back to a customer.

� Report Dates (All)
� Report Basis (Accrual)
� Columns
� Total by (Customer)
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Transaction List 
by Customer 
(T)

Lists all transactions, 
grouped by customer.

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

A/R report Description Modify Report options
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Sales reports

To generate these reports from the Reports menu, choose Sales, and then choose the 
report you want to create.

Sales report Description Modify Report options

Sales by 
Customer 
Summary
(S)

Summarises sales income 
(for parts, services, 
discounts, or other 
charges) by customer for 
this month.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� VAT Basis (Net)

Sales by 
Customer Detail
(T)

Like the customer sum-
mary report, but with sales 
transactions listed for each 
customer.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Total By (Customer)
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT (Net)

Sales by Item 
Summary
(S)

Summarises month-to-date 
unit and pound sales, sub-
totalled by invoice item 
(parts, services, discounts, 
other charges).

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Units of Measure (Selling Unit)
� Columns (Total only)
� Subcolumns (COGS, Avg. COGS, 

Gorss margin, Gross Margin %)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Sales by Item 
Detail
(T)

Like the item summary 
report, but with sales 
transactions listed for each 
line item for this month.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Sales by Rep 
Summary
(S)

Summarises sales income 
(for parts, services, 
discounts, or other 
charges) by employee for 
this month.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns 
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� VAT Basis (Net)
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Job, time and mileage reports (QuickBooks Pro/Accountant 
only)

To generate these reports from the Reports menu, choose Jobs, Time & Mileage, and 
then choose the report you want to create.
 

Sales by Rep 
Detail
(T)

Like the employee sum-
mary report, but with sales 
transactions listed for each 
employee.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Total By (Rep)
� Units of Measure (Selling)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Pending Sales
(T)

Lists all invoices, cash 
sales, and credit memos 
that are marked as pend-
ing. Shows the account that 
is affected when the sale is 
marked as final.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Total By (Total only)
� Units of Measure (Selling)
� Include (In Use)
� Open Balance/Ageing (Current)

Open Sales 
Orders by 
Customer
(T)

Lists all open sales orders, 
grouped and subtotalled by 
customer.

� Report Dates (All)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Open Sale 
Orders by Item
(T)

Lists all open sales orders, 
grouped and subtotalled by 
item.

� Report Dates (All)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Sales report Description Modify Report options

Job/mileage/
time report 
(type)

Description Modify Report options

Job Profitability 
Summary
(S)

Compares actual cost to 
actual revenue for all 
customers and jobs. 
Subtotals data first by 
customer and then by job.

� Report Dates (All)
� Columns (Total only)
� Subcolumns (Act. Cost, 

Act. Revenue, £ Difference)
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Job Profitability 
Detail (for one 
customer:job)
(S)

For a customer or job, 
compares actual costs to 
actual revenues and shows 
the difference between the 
two amounts. Subtotals the 
data first by item type and 
then by item.

� Report Dates (All)
� Columns (Total only)
� Subcolumns (Act. Cost, 

Act. Revenue, £ Difference)

Job Estimates vs. 
Actuals 
Summary
(S)

Compares estimated to 
actual cost and estimated 
to actual revenue for all 
customers and jobs, show-
ing the difference between 
the two amounts. Subtotals 
data by customer and then 
by job.

� Report Dates (All)
� Columns (Total only)
� Subcolumns (Est. Cost, Act. Cost, 

£ Difference; Est. Revenue, 
Act. Revenue, £ Difference)

Job Estimates vs. 
Actuals Detail 
(for one job)
(S)

For a customer or job, 
compares estimated to 
actual costs and estimated 
to actual revenues, show-
ing the difference between 
the two amounts. Subtotals 
data by item type and then 
by item.

� Report Dates (All)
� Columns (Total only)
� Subcolumns (Est. Cost, Act. Cost, 

£ Difference; Est. Revenue, 
Act. Revenue, £ Difference)

Job Progress 
Invoices vs. 
Estimates
(S)

Show estimates, and the 
amount and percentage of 
any progress invoices. 
Subtotals data by 
customer and then by job.

� Report Dates (Financial Year-to-date) 
on report header

� Columns
� Units of Measure (Stocking Unit)

Item Profitability
(S)

For each item, compares 
the actual cost to actual 
revenue and shows the 
difference between the two 
amounts. Subtotals data by 
item type and then by item.

� Report Dates (All)
� Columns (Total only)
� Subcolumns (Act. Cost, 

Act. Revenue, £ Difference)

Item Estimates 
vs. Actuals
(S)

For each item, compares 
estimated to actual cost 
and estimated to actual 
revenue, showing the 
difference between the two 
amounts. Subtotals data by 
item type and then by item.

� Report Dates (All)
� Columns (Total only)
� Subcolumns (Est. Cost, Act. Cost, 

£ Difference, Est. Revenue, 
Act. Revenue, £ Difference)

Profit & Loss
by Job
(S)

Like the standard profit and 
loss statement, but with 
columns for each customer 
and job. Amounts are for 
the financial year to date.

� Report Dates (Financial Year-to-date)
� Report Basis (Accrual)
� Columns (Customer:Job)
� Subcolumns
� Display Rows (Non-zero)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Job/mileage/
time report 
(type)

Description Modify Report options
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Estimates by Job
(T)

Shows all estimates, 
grouped and subtotalled by 
customer and then by job.

� Report Dates (All)
� Report Basis (Accrual)
� Columns (Customer:Job)
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Unbilled Costs 
by Job
(T)

Shows any outstanding 
reimbursed expenses that 
have not yet been charged 
back to a customer.

� Report Dates (All)
� Report Basis (Accrual)
� Columns
� Total by (Customer)
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Open Purchase 
Orders by Job
(T)

For each customer:job, the 
report shows the remaining 
line items that have not 
been received and their 
expected delivery date. You 
must enter customer:job 
information on purchase 
orders to have the informa-
tion display in this report.

� Report Dates (All)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Time by Job
Summary
(S)

Shows hours worked sub-
totalled first by customer or 
job and then by service 
item.

� Report Dates (Financial year-to-date)
� Columns (Total only)
� Formats (Time by Job by Item)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Time by Job 
Detail
(T)

Lists each time activity 
(work done by one person 
for a particular customer or 
job on a specific date) and 
shows whether it is billed, 
unbilled, or not billable.

� Report Dates (This Month-to-date)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)

Time by Name
(S)

Shows hours worked (or 
tracked as sick or holiday 
time), subtotalled first by 
the name of the person 
who performed the work 
and then by the customer 
or job the person 
performed the work for.

� Report Dates (Financial year-to-date)
� Columns (Total only)
� Formats (Time by Name by Job)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Job/mileage/
time report 
(type)

Description Modify Report options
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Time by Item
(S)

Shows hours worked sub-
totalled first by service item 
and then by customer or 
job.

� Report Dates (Financial 
year-to-date)

� Columns (Total only)
� Formats (Time by Item by Job)
� Subcolumns (such as Billed, 

Unbilled, Not Billable, and Estimated)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Mileage by
Vehicle 
Summary
(S)

Shows mileage and 
expense amount based on 
Inland Revenue published 
guidelines (mileage allow-
ance for employees who 
use their own cars for busi-
ness travel), subtotalled by 
vehicle.

� Report Dates (This Tax Year)
� Columns (Total only)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Income Tax Year)

Mileage by 
Vehicle Detail
(T)

Shows the mileage for each 
vehicle on a specific date, 
and shows the expense 
amount based on Inland 
Revenue published guide-
lines (mileage allowance 
for employees who use 
their own cars for business 
travel).

� Report Dates (This Tax Year)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance (Current)

Mileage by Job 
Sumary
(S)

Shows mileage subtotalled 
by customer and job.

� Report Dates (Financial 
year-to-date)

� Columns (Total only)
� Subcolumns (such as Billed, 

Unbilled, Not Billable)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Mileage by Job 
Detail
(T)

Lists each mileage entry for 
a particular customer or job 
on a specific date, with the 
amount billable to the cus-
tomer. It also shows the 
billing status for each entry: 
billed, unbilled or not bill-
able. The report groups and 
subtotals the entries by 
customer and job.

� Report Dates (Financial 
year-to-date)

� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance (Current)

Job/mileage/
time report 
(type)

Description Modify Report options
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Suppliers and payables reports

To generate these reports from the Reports menu, choose Suppliers & Payables, and 
then choose the report you want to create.

A/P report
(type) Description Modify Report options

A/P Ageing 
Summary
(S)

Shows the ageing status of 
unpaid bills in the accounts 
payable account, 
subtotalled by supplier.

� Report Dates (Today)
� Days per ageing period (30)
� Age through how many 

days (90)
� Open Balance/Ageing (Report date)

A/P Ageing Detail
(T)

Lists each unpaid bill, 
subtotalled by ageing 
period. Tells how many 
days a bill is overdue.

� Report Dates (Today)
� Report Basis (Accrual)
� Columns
� Units of Measure (Purchasing Unit)
� Open Balance/Ageing (Report date)

Supplier Balance 
Summary
(S)

Shows balances for 
suppliers with unpaid 
balances, as of the report's 
ending date.

� Report Dates (All)
� Columns (Total only)
� Subcolumns
� Display Rows (Non-zero)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� VAT Basis (Net)

Supplier Balance 
Detail
(T)

Lists all supplier-related 
transactions, subtotalled by 
supplier. The total for a 
supplier equals the 
supplier's unpaid balance.

� Report Dates (All)
� Report Basis (Accrual)
� Columns
� Total by (Supplier)
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Unpaid Bills 
Detail
(T)

Lists each unpaid bill, 
subtotalled by supplier.

� Report Dates (Today)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
� VAT Basis (Net)

Transaction List 
by Supplier
(T)

Lists all transactions for a 
supplier

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
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Purchases reports

To generate these reports from the Reports menu, choose Purchases, and then choose 
the report you want to create.

Purchases 
report (type) Description Modify Report options

Purchases by 
Supplier 
Summary
(S)

Summarisespurchasing 
expenses by supplier for 
this month.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Purchases by 
Supplier Detail
(T)

Like the previous report, 
but with credit card 
charges, bills, supplier 
credits, and cheques listed 
for each supplier.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Total By (Supplier)
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Purchases by 
Item Summary
(S)

Summarises unit and 
pound purchases for this 
month, subtotalled by item.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Units of Measure (Purchasing Unit)
� Columns (Total only)
� Subcolumns
� Display Rows (Non-zero)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Purchases by 
Item Detail
(T)

Like the previous report, 
but with credit card 
charges, bills, supplier 
credits, and cheques listed 
for each item.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Open Purchase 
Orders
(T)

Shows all open purchase 
orders, including the 
supplier, P.O. number, and 
expected receipt date.

� Report Dates (All)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Open Purchase 
Orders by Job
(T)

For each customer:job, 
shows line items not yet 
received and their expected 
delivery date. You must 
enter customer:job 
information on purchase 
orders for this report.

� Report Dates (All)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
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Stock reports

To generate these reports from the Reports menu, choose Stock, and then choose the 
report you want to create.

Stock report
(type) Description Modify Report options

Stock Valuation 
Summary
(S)

For each stock item, shows 
quantity on hand, average 
cost, asset value, sales 
price, retail value, % of total 
asset value, and % of retail 
value. Covers this month to 
date.

� Report Dates (Month-to-date)
� Units of Measure (Stocking Unit)
� VAT Basis (Net)

Stock Valuation
Detail
(T)

For each stock item, shows 
all transactions for month 
to date that affect the value 
of the item. This report has 
the same columns as the 
valuation summary report.

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Stock Status by 
Item
(T)

For each stock item, shows 
quantity on hand, quantity 
on order, date of next order 
receipt, and average quan-
tity sold per week. Covers 
this month to date.

� Report Dates (Month-to-date)
� Units of Measure (Stocking Unit)

Stock Status by 
Supplier
(T)

For each supplier, shows 
quantity of stock items on 
hand, quantity on order, 
date of next order receipt, 
and average sales per 
week. Designed to help in 
reordering items.

� Report Dates (Month-to-date)
� Units of Measure (Stocking Unit)

Stock Take
Worksheet
(N/A)

For each stock item, shows 
preferred supplier and 
quantity on hand with an 
empty column to write in 
the actual quantity from a 
stocktaking.

� Units of Measure (Stocking Unit)

Open Sales 
Orders by 
Customer
(T)

Lists all open sales orders, 
grouped and subtotalled by 
customer.

� Report Dates (All)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
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Employee and payroll reports

To generate these reports from the Reports menu, choose Employees & Payroll, and 
then choose the report you want to create.

Note: The P11 Report that was on this menu in some previous versions of 
QuickBooks has been superseded by the P11 Working Sheet on the 
Employees menu. It does not include any customisation options.

Pending Builds
(T)

For assembly items, shows 
those assemblies marked 
as pending.

� Report Dates (All)
� Report Basis (Accrual)
� Columns
� Total by (Total only)
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Stock report
(type)

Description Modify Report options

Payroll 
report (type)

Description Modify Report options

Payroll Summary 
(S)

Summarises amounts paid 
or deducted for each 
payroll item for each 
employee; also taxes and 
benefits.

� Report Dates (Month-to-date)
� Columns (Employees)
� Subcolumns (Hours, Rate)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Payroll Year)

Payroll Item 
Detail
(T)

Shows the individual 
transactions that make up 
each payroll item paid or 
deducted from each 
employee.

� Report Dates (This Month)
� Report Basis (Accrual)
� Columns 
� Total By (Payroll item detail)
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Payroll Pension 
Detail (T)

Shows the individual 
transactions that make up 
each payroll item paid or 
deducted from each 
employee which affect 
pension benefits.

� Report Dates (Payroll year-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
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Payroll Detail 
Review
(T)

Provides a breakdown of 
payroll transactions by 
employee, showing all 
payroll items and which tax 
table was used.

� Report Dates (Payroll year-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Employee 
Earnings 
Summary
(S)

As summary report, but 
with a row for each 
employee and a column for 
each payroll item.

� Report Dates (This Month)
� Report Basis (Accrual)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Payroll Year)

Payroll 
Transactions by 
Payee
(T)

Lists payroll transactions 
by payee (e.g. pay cheques 
issued to each employee).

� Report Dates (This Month)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Payroll 
Transaction 
Detail
(T)

Shows the line item detail 
for each payroll 
transaction.

� Report Dates (This Month)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Statutory 
Payments Detail
(S)

Shows statutory payments 
and recovery amounts for 
the specified tax year. No 
Modify Report options, but 
report can be filtered.

� Tax Year (Current year)
� Report Dates (Current tax and finan-

cial year)
� Type of statutory payment (All)
� Employees (All)

Payroll Liability 
Balances
(S)

Shows amount currently 
owed for each payroll 
liability item.

� Report Dates (This payroll year-to-
date)

� Columns (Month)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Payroll Year)

BACS Report
(T)

Lists BACS payments by 
employee

� Report Dates (This Month)

Payroll 
report (type)

Description Modify Report options
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Banking reports

To generate these reports from the Reports menu, choose Banking, and then choose 
the report you want to create.

Banking 
report (type) Description Modify Report options

Deposit Detail
(T)

Shows detailed information 
for each bank deposit, 
including customer names 
and payment allocations.

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Selling Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Cheque Detail
(T)

Shows detailed information 
for each cheque, including 
affected expense accounts 
and bill payment alloca-
tions.

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Purchasing Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Missing Cheques 
(for a selected 
account)
(T)

Lists cheques in a bank 
account by cheque number, 
invoices in a receivables 
account by invoice number, 
or payments in a current 
asset account by number. 
Shows both missing and 
duplicate numbers.

� Report Dates (All)
� Columns
� Units of Measure (Purchasing Unit)

Reconcile 
Discrepancy 
(Accountant)
(T)

For a specified account, 
hows entries or 
adjustments made after the 
account was reconciled.

� Report Dates (All)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Previous 
Reconciliation 
...Detail
(Accountant)
(T)

For a specified account, 
stores up to 120 previous 
reconciliation reports 
showing transactions 
sorted by type.

� Report Dates (All)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Previous 
Reconciliation 
...Summary
(Accountant)
(S)

For a specified account, 
stores up to 120 previous 
reconciliation summaries.

� Report Dates (All)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
76



C H A P T E R  3
Accountant and taxes reports

To generate these reports from the Reports menu, choose Accountant & Taxes, and 
then choose the report you want to create.

Accountant 
& Taxes 
report (type)

Description Modify Report options

Adjusted Trial 
Balance
(S)

Shows the effect of 
adjustments on the trial 
balance.

� Report Dates (Last month)
� Report Basis (Accrual)
� Columns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Trial Balance
(S)

Summarises debits and 
credits, subtotalled by 
account.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

General 
Ledger
(T)

Lists month-to-date GL 
transactions, subtotalled by 
account. Similar to the 
Transaction Detail by 
Account report.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Include (All)
� Open Balance/Ageing (Current)

Transaction 
Detail by 
Account
(T)

Lists month-to-date 
transactions subtotalled by 
account.

� Report Dates (Month-to-date)
� Report Basis (Accrual)
� Columns
� Total By (Account list)
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Adjusting 
Journal Entries
(T)

Displays adjusting journal 
entries.

� Report Dates (Last month)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Journal
(T)

Breaks down every 
transaction into debits and 
credits.

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)
77



W o r k i n g  w i t h  Q u i c k B o o k s  r e p o r t s
Audit Trail
(T)

For a specified date range, 
shows any transactions 
modified or deleted and 
what the modifications 
were. To create this report, 
“Use audit trail” must first 
be selected in the Transac-
tions Preferences window.

� Report Dates (All)
� Date Entered/Last Modified (Today)
� Columns
� Show Deleted Transactions (Yes)

Closing Date 
Exception Report 
(Accountant)
(T)

Tracks changes made to 
transactions for periods 
that have been closed.
You must set a Closing 
Date (Edit, Preferences) in 
order to run this report.

� Report Dates (to Closing Date)
� Days Entered/Last Modified (from 

Today)
� Columns
� Show Deleted Transactions (Yes)

Transaction List 
by Date
(T)

Lists all transactions in date 
order.

� Report Dates (Month-to-date)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Account Listing
(L)

Lists all accounts, grouped 
by type.

� Columns
� Units of Measure (Stocking Unit)

Fixed Asset 
Listing 
(L)

Lists all fixed assets with its 
original cost, 
purchase date and 
description..

� Columns
� Units of Measure (Stocking Unit)

Income Tax 
Preparation
(L)

Shows the tax line 
assigned to each account in 
the chart of accounts.

� Columns
� Units of Measure (Stocking Unit)

Income Tax 
Summary
(S)

Shows the amount associ-
ated with each tax line for 
the self-assessment tax 
form.

� Report Dates (Tax year)
� Report Basis (Accrual)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Income Tax Year)

Income Tax 
Detail
(T)

Shows the transactions 
associated with each tax 
line for the self-
assessment tax form.

� Report Dates (Tax year)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Accountant 
& Taxes 
report (type)

Description Modify Report options
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Budget and forecast reports

To generate these reports from the Reports menu, choose Budgets & Forecasts, and 
then choose the report you want to create.

Note: You must have set up a budget and/or forecast in order to run these 
reports.

Budget/ 
forecast 
report (type)

Description Modify Report options

Budget Overview
(S)

Shows budgeted amounts 
by month for each income 
and expense account for 
which you have set up a 
budget.

� Report Dates (Custom)
� Report Basis (Accrual)
� Columns (Month)
� Show actuals (No)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� Show only rows & columns with 

budgets (No)

Budget vs. Actual
(S)

Compares budgeted 
amounts for income and 
expense accounts with 
actual income and 
expenses. Shows the 
difference in pounds and as 
a percentage of budgeted 
amount.

� Report Dates (Custom)
� Report Basis (Accrual)
� Show actuals/£ difference/

% of budget (Yes)
� Show actuals (No)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� Show only rows & columns with 

budgets (No)

Profit & Loss 
Budget 
Performance
(S)

Shows actual income and 
expenditure compared to 
the budgeted amounts for 
the month and year, for 
each income and expense 
account for which you have 
set up a budget.

� Report Dates (Month)
� Report Basis (Accrual)
� Columns (Total)
� Show actuals (Yes)
� Show actuals (No)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� Show only rows & columns with 

budgets (No)
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Forecast
Overview
(S)

Shows the forecast income 
and expenditure for each 
month.

� Report Dates (Financial year-to-date)
� Report Basis (Accrual)
� Columns (Month)
� Show actuals (No)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� Show only rows & columns with 

budgets (No)

Forecast vs. 
Actual
(S)

Shows actual income and 
expenditure against what 
was forecast.

� Report Dates (Financial year)
� Report Basis (Accrual)
� Columns (Month)
� Show actuals (Yes)
� £ difference (Yes)
� % of forecast (Yes)
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)
� Show only rows & columns with 

budgets (No)

Budget/ 
forecast 
report (type)

Description Modify Report options
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List reports

To generate these reports from the Reports menu, choose List, and then choose the 
report you want to create.

List report 
(type) Description Modify Report options

Account Lists

Account Listing
(L)

Lists each account in the 
chart of accounts by name, 
type, balance, description, 
and tax-line assignment.

� Columns
� Units of Measure (Stocking Unit)

Item Lists

Item Price List
(L)

Shows the sales price, 
name, description, and 
preferred supplier of each 
item on the Item list.

� Columns
� Units of Measure (Selling Unit)

Item Listing
(L)

Shows more detail about 
each item on the Item list.

� Columns
� Units of Measure (Stocking Unit)

VAT Lists

VAT Code
(L)

Lists VAT codes and rates. N/A

Payroll Item List

Payroll Item
Listing
(L)

For each payroll item in the 
Payroll Item list, shows 
name, type, associated 
account, and tax tracking 
information.

� Columns
� Units of Measure (Stocking Unit)

Fixed Assets Lists

Fixed Asset 
Listing
(L)

Lists each fixed asset item 
with its original cost, 
purchase date and 
description.

� Columns
� Units of Measure (Stocking Unit)

Customer Lists

Customer Phone 
List
(L)

Lists each customer's name 
and phone number, using 
information from the 
Customer:Job list.

� Columns
� Units of Measure (Stocking Unit)

Customer 
Contact List
(L)

Lists contact information 
for each customer in the 
Customer:Job list (name, 
balance, phone, fax, 
contact names, and billing 
address). 

� Columns
� Units of Measure (Stocking Unit)
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Supplier Lists

Supplier Phone 
List
(L)

Lists each supplier’s name 
and phone number, using 
information from the 
Supplier list.

� Columns
� Units of Measure (Stocking Unit)

Supplier Contact 
List
(L)

Lists contact information 
for each supplier in the 
Supplier list (name, 
balance, phone, fax, 
contact name, address, and 
account number).

� Columns
� Units of Measure (Stocking Unit)

Employee Lists

Employee 
Contact List
(L)

Lists contact information 
for each employee in the 
Employee list: name, 
phone, and address.

� Columns
� Units of Measure (Stocking Unit)

Other Names Lists

Other Names 
Phone List
(L)

Lists the name and phone 
number for each person on 
the Other Names list.

� Columns
� Units of Measure (Stocking Unit)

Other Names 
Contact List
(L)

Lists contact information 
for each person in the 
Other Names list (name, 
address, phone, fax, and 
contact name).

� Columns
� Units of Measure (Stocking Unit)

Terms List

Terms Listing
(L)

Lists details of each 
payment term in the Terms 
list (name, type, discount 
percentage, net due days, 
discount days, and day of 
month due).

� Columns
� Units of Measure (Stocking Unit)

List report 
(type)

Description Modify Report options
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VAT reports

To generate these reports from the Reports menu, choose VAT, and then choose the 
report you want to create.

To Do Notes List

To Do Notes
(L)

Shows the date and 
description of each note in 
the To Do Notes list and 
whether it has been 
completed.

� Columns
� Units of Measure (Stocking Unit)

Memorised Transaction List

Memorised 
Transaction 
Listing
(L)

Shows details of 
memorised transactions.

� Columns
� Units of Measure (Stocking Unit)

List report 
(type)

Description Modify Report options

VAT report
(type)

Description Modify Report options

VAT 100
(S)

Shows the information 
needed to fill in the VAT 100 
return form

� Report Dates – via report header

VAT 
Summary
(S)

Shows a summary of input 
and output VAT.

� Report Dates – via report header

VAT 
Exception Report
(T)

Shows unfiled VAT transac-
tions up to the previous 
return, and VAT liability.
You can run this report only 
if you use accrual account-
ing.

N/A

VAT Detail
(T)

Shows detailed 
information for each trans-
action in the VAT Control 
account.

� Report Dates (Last VAT quarter)
� Columns
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

EC Sales List
(S)

Shows EC sales by cus-
tomer:job.

� Report Dates (This Financial Quarter-
to-date) – via report header

� Columns (Total only)
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Multicurrency reports

To generate these reports from the Reports menu, choose Multicurrency, and then 
choose the report you want to create.

Custom reports

Choose either of these reports from the Reports menu to create reports from scratch.

Multi-
currency 
report (type)

Description Modify Report options

Realised Gain & 
Loss
(T)

Shows actual gains and 
losses in foreign 
transactions due to 
exchange rate fluctuations.

� Report Dates (All)
� Report Basis (Accrual)
� Columns 
� Units of Measure (Stocking Unit)
� Include (In Use)
� Open Balance/Ageing (Current)

Unrealised Gain 
& Loss
(S)

For a selected currency, 
summarises potential gains 
and losses by account.

� Report Dates (All)

Custom 
report (type)

Description Modify Report options

Custom 
Summary Report
(S)

Shows totals and subtotals 
for groups of transactions 
without showing the 
individual transactions.

� Report Dates (This Month-to-date)
� Report Basis (Accrual)
� Columns (Total only)
� Rows (Income statement)
� Display Columns For Amount/

Quantity/Both (Amount)
� Subcolumns
� Display Rows (Active)
� Display Columns (Active)
� Reporting Calendar (Fiscal Year)

Custom 
Transaction 
Detail Report
(T)

Lists individual 
transactions showing each 
account involved in a
transaction on a separate 
line.

� Report Dates (This Month-to-date)
� Report Basis (Accrual)
� Columns
� Units of Measure (Stocking Unit)
� Total By (Total only)
� Sort By (Date/Transaction)
� Include (In Use)
� Open Balance/Ageing (Current)
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QuickReports

Whenever you have a list, a register, or a form displayed, you can create a QuickReport 
for the payee, account, or item. 

Note: The exact customisation options and defaults depend on the type of 
transaction. For example, the Units of Measure for customer and sales 
transactions usually defaults to Selling Unit, but for supplier and purchase 
transactions it usually defaults to Purchasing Unit. Similarly, some Quick-
Reports do not include the Report Basis option.

Transaction reports

Quick 
Report
(type)

Description
Modify Report options
may include

QuickReport
(T)

Shows transaction history 
for information being 
viewed.

� Report Dates
� Report Basis
� Columns
� Units of Measure
� Include (In Use)
� Open Balance/Ageing (Current)

Other report
(type) Description Modify Report options

Transaction 
History (for a 
selected 
transaction)
(T)

Lists transaction 
information in two forms: 
invoices and the payments 
against them, and 
payments and the invoices 
they are against.

� Columns
� Show Detail (yes)

Transaction 
Journal (for a 
selected 
transaction)
(T)

Breaks down the selected 
transaction into debits and 
credits.

� Report Dates (Custom)
� Columns
� Units of Measure (Stocking Unit)
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Filtering report data

Regardless of which type of report you create, you filter the data the same way. When 
you create a report, click Modify Report, and then click the Filters tab to display the 
list of filters available for that report:

This table describes each report filter available in QuickBooks. The actual filters 
available depend on the report. Go to the Filters tab in the Modify Report window to 
apply any of these filters to your reports. For more information about any of these 
filters, click the Tell me more button on the Filters tab.

Field, option, or button Use to:

Account Limit the report to certain accounts. For example, choosing All Bank 
Accounts limits the report to the accounts from which you write 
checks.

Amount (Any/=/</>) Restrict transactions on the basis of a particular amount. 
(Click the =, <, or > button and type an amount in the field.)

Ageing Restrict the transactions included in a report on the basis of 
ageing—the number of days an invoice or bill is past due.

Billing Status Limit the report to show billing status of your customers: whether 
you have billed them or not, or whether they are considered not bill-
able.

Class Restrict the report’s transactions to particular classes.

Cleared (Either/No/Yes) Have QuickBooks choose transactions for the report based on 
whether they have cleared.

Currency Limit the report to one or more currencies.

Customer Type Limit the report to transactions related to one of your customer types.
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Date Restrict the report to transactions that fall within this date range.

Detail Level Show or suppress the detail lines (line items on an invoice or expense 
account detail on check) for each transaction in the report.

Due Date Limit the report to transactions with due dates within a specific date 
range. The Due Date is the date a customer owes a payment on an 
invoice or the date your company owes payment on a bill.

Entered/Modified Limit the report to transactions entered or edited within a specific 
date range (for audit trail report).

Estimate Active Choose whether to include only estimates that are active, inactive or 
either.

Filed (Either/No/Yes) Choose whether to include VAT items already filed (i.e. included in 
returns).

FOB Limit the report to include invoices with a specific FOB (free on 
board).

Foreign amount (Any/=/</>) Restrict transactions on the basis of a particular amount in a foreign 
currency. (Click the =, <, or > button and type an amount in the field.)

Item Restrict the report to transactions that include specified items. Items 
are goods and services you buy and sell.

Job Type Limit the report to transactions related to one of the job types on the 
Job Types list.

Memo Restrict the transactions included in the report on the basis of the 
contents of their Memo fields. (Enter the text you want to match.)

Mileage Expense (Any/=/</>) Restrict the transactions included in the report on the basis of a 
particular amount of mileage expense. (Click the =, <, or > button and 
type an amount in the field.)

Name...
� Address
� City
� County
� Postcode
� Phone Number
� Fax Number
� Email
� Acc. Num/Note

Specify words or characters that must appear in the selected field.

Name Limit the report to transactions related to certain names from your 
Customer:Job, Supplier, Employee, or Other Names lists.

Number Restrict the transactions included in a report on the basis of an 
invoice or check number.

Online Status Indicate whether you send a payment electronically to your bank 
through the QuickBooks online banking feature.

Paid Status Limit a report to include only transactions that are open (unpaid), 
closed (paid), or either.

Field, option, or button Use to:
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Paid Through Limit a report to include only transactions that are paid within the 
time period you specify.

Payment Method Limit a report to show only customer payments you received by cash, 
check, credit card, and so on.

Payroll Item Limit the report to transactions related to a particular payroll item.

P.O. Number Restrict the report to a specific purchase order number.

Posting Status (Either/No/Yes) Restrict transactions included in the report on the basis of whether 
they have been posted or not.

Printed Status (Either/No/Yes) Restrict transactions included in the report on the basis of whether 
they have been printed or not.

Received (Either/No/Yes) Limit the report to show only purchase orders that are open, closed, 
or either open or closed.

Rep Limit the report so it shows the sales for a particular employee (rep).

Ship Date Limit the report to show sales with a ship date within a period of time 
or between two specified dates.

Ship Via Limit the report to show sales or purchases in which you used a 
specified shipping method.

Supplier Type Limit the report to transactions related to one of your supplier types.

Template Restrict the report to transactions for which a particular template was 
used. Template refers to the form type used when a sales or purchase 
transaction was entered.

Terms Limit the report to transactions with specified terms.

Total Miles (Any/=/</>) Restrict transactions on the basis of the number of miles. (Click the =, 
<, or > button and type an amount in the field.).

Transaction Type Choose the type of transaction (checks, payments, and so on) you 
want included in the report.

Trip End Date Limit the report to trips that ended within a period of time or between 
two specified dates.

VAT Code Limit the report to transactions with a specified VAT code.

Vehicle Limit the report to include only specified vehicles.

Voided Limit the report to include only transactions that are voided, not 
voided, or both.

Custom Fields Restrict the current report to transactions that contain information in 
one or more of your customised fields.

Field, option, or button Use to:
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Saving report settings

After you have modified a report in any of the ways described in this chapter, you may 
want to save or memorise the settings for future use. 

Memorising the report saves all your customising and filtering changes. It also saves 
the print settings and layout of the report. The next time you (or your client) generate 
the report, QuickBooks recreates the format, but uses the latest financial data.

To memorise report settings:
1 After customising a report, click Memorise on the report buttonbar to display the 

Memorise Report dialog box:

2 Enter a title for the report (or accept the default title).

3 Tick the Save in Memorised Report Group box and select a group from the drop-
down list (optional).

4 Click OK.

To use a memorised report:
1 From the Reports menu, choose Memorised Reports and then Memorised Report 

List to display this window:

2 Select the report you want.

3 Click Display or Print as desired.
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Processing reports in groups

QuickBooks allows you to easily process multiple reports at one time. Before you can 
display or print reports in batches, the reports must be memorised. QuickBooks comes 
with predefined groups of memorised reports already set up. You can use the 
predefined groups as is, modify them to suit your needs, or create your own. You can 
also memorise reports without including them in a group.

This table lists the predefined groups of memorised reports set up in QuickBooks.

*The Employees group will not be generated automatically in files that have payroll 
features turned off.

You can set up groups of reports that you would like to have your clients run at certain 
times of the year. For example, you could create a memorised report group called “Year 
End” and include in that group all of the reports that you would like your clients to 
run for you at year end. At year end, your clients need only select the “Year End” group 
and QuickBooks will process all reports you need (with the settings you specified) at 
one time.

To create a new memorised report group:
1 From the Reports menu, choose Memorised Reports, and then choose Memorised 

Report List.

2 From the Memorised Report menu button, choose New Group.

3 Enter a name for the group, and then click OK.

To add a report to a group:
1 Generate the report you want to add to the group.

2 Click Memorise on the report buttonbar.

3 Enter a name for the report (or accept the name QuickBooks provides).

4 Click to select the “Save in Memorised Report Group” checkbox.

Group Reports included

Accountant 
(Accountant only)

Balance Sheet, General Ledger, Journal Entries 
Entered/Modified Today, Profit & Loss, Trial Balance

Banking Check Detail, Deposit Detail

Company Balance Sheet, Profit & Loss

Customers A/R Ageing Summary, Customer Balance Detail, 
Customer Balance Summary, Open Invoices

Employees* Payroll Item Detail, Payroll Liabilities, Payroll Summary

Suppliers A/P Ageing Summary, Supplier Balance Detail, 
Supplier Balance Summary, Unpaid Bills Detail
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5 From the “Save in Memorised Report Group” drop-down list, choose the name of 
the group into which you want to place the report.

6 Click OK.

To process multiple reports:
1 From the Reports menu, choose Process Multiple Reports.

2 Select the memorised reports you want to process.

Note: You can save time by changing the report date before you view or print a 
memorised report.

3 Click Display to display the selected reports onscreen, or click Print to print the 
reports.

Exporting memorised report settings as templates

You can export the settings for a memorised report, or for a group of reports. The 
export file containing the templates has the extension .QBR.

If you are exporting templates, their memorised settings can include most types of 
filters, but not filters for specific accounts, customers, jobs, suppliers, employees or 
items. 

You are recommended to use filters that do not use specific names. This ensures that 
the filters will still work for clients’ data or for other company files.

You can then import the template to use with another company file, or your client 
can import the templates for use with their own data. It does not matter whether they 
are using QuickBooks Regular, Pro or Accountant. However, they should be using a 
version of QuickBooks released in the same year, and may also need to have 
downloaded the same update patches

To export a report template:
1 From the Reports menu, choose Memorised Reports, then choose Memorised 

Report List.

2 Select the memorised report or report group.

3 Click the Memorised Report menu button, and choose Export Template.

4 Click Browse and specify a location.

5 Accept the default filename, which is the same as the report or report group you 
chose, or specify a new filename.

6 Click Save.

To import a report template:
1 From the Reports menu, choose Memorised Reports, then choose Memorised 

Report List.

2 Click the Memorised Report menu button, and choose Import Template.
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3 Click Browse and specify the location of the template file.

4 Select the template file.

5 Click Open.

QuickBooks creates the new memorised report or report group.

Saving report data

When QuickBooks memorises a report, it memorises your custom report settings, not 
your report data. If you want to save the actual data, you can:

� Export the report to a Microsoft Excel spreadsheet (this option is available in 
QuickBooks Pro/Accountant only). This allows further customisation and 
filtering.

� Print the report to a file (ASCII, tab-delimited or comma-separated value).

� Save the report in PDF format (QuickBooks Pro/Accountant only)

To export a report to Excel:
1 Display the Memorised Report List as described above.

2 Select the report you want.

3 Click the Excel button to display this dialog box.

4 Indicate whether you want to open a new spreadsheet or an existing one (enter or 
browse for the filename.

5 Click the OK button to open the desired spreadsheet.

Or, click the Advanced button for more options.

For more information about exporting report data to Microsoft Excel, see “Analysing 
financial data” in the QuickBooks Training Guide, or search the onscreen Help index for 
Microsoft Excel, exporting reports to.
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Printing reports

You can print reports from either the Report window or Report Finder.

When you print reports, you can choose to do any of the following:

� Print in portrait (vertical) or landscape (horizontal) orientation

� Select a printer or send the report to a file

� Print in colour

� Control widows and orphans (prevent headings from printing near the bottom of 
a page or single lines at the top of a page) by selecting Smart Page Breaks

� Fit the report to __ page(s) wide

� Insert a page break after each major grouping

� Print a range of pages

� Enter the number of copies

� Change margins

� Preview the report before you print
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Overview

This chapter includes an introduction to some of the services available for which you 
can sign up to use with QuickBooks.

To sign up and use these services, you will need an Internet connection. Fees apply.

QuickBooks Card Solutions

With QuickBooks Card Solutions, you can accept payments by credit or debit card, 
which your customer can pay online or directly.

When you create an invoice, you can choose to send your customer an email that 
includes a link to a secure payment page to enable them to pay their invoice online. 
You can then receive the payment against the invoice.

You can also receive a credit or debit card payment that a customer has made directly. 

If you are selling directly and have not created an invoice, you can create a sales receipt 
for a credit/debit card payment.

Payments are transferred to your bank account, and you can get a statement for 
reconciliation that includes details of payments, service charges and fees.

Signing up for QuickBooks Card Solutions

In order to sign up for QuickBooks Card Solutions, you will need an Internet 
connection.

You will need to have personal or company details to hand, such as:

� Company registration number and address.

� Company bank account information.

� Credit or debit card.

To sign up for QuickBooks Card Solutions:
1 From the Banking menu, choose Banking Services, then choose Accept Online 

Card Payments, or 
From the Customers menu, choose Customer Services, then choose Accept Online 
Card Payments.

QuickBooks opens the QuickBooks Card Solutions window. From here, you can 
click the tabs at the top for information.

2 From the Common Questions or Getting Started tab pages, click the Apply Now 
link, and follow the onscreen instructions.
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3 Once your application has been accepted, you will be sent an ID. You will then 
need to set up passwords on the Card Solutions webpage and in QuickBooks.

You can then log on to the webpage at any time to set up or change your config-
uration prefences, to get statements, and so on.

4 You will also need to set up accounts to use for assigning QuickBooks Card 
Solution payments and expenses, for example:

� Card Service Expenses: expense account

� Due from QB Card Services: other asset account

Using QuickBooks Card Solutions

There are three ways you can use the service to accept credit/debit card payments:

� Send an invoice by email with online payment link, so the customer can pay 
online. You then receive the payment against the invoice.

� Prepare an invoice in the normal way, which the customer then pays directly. You 
record the credit/debit card payment against the invoice.

� Enter a sales receipt for a credit/debit card payment made directly by phone or in 
person.

Tip: If you have a customer who pays regularly by credit/debit card, you can 
record their card details on the customer record. QuickBooks will then use 
these details when you receive payment or record a sales receipt and select 
the relevant card as the payment method. For security, the card number is 
partly obscured after you have entered it.

Emailing an invoice with online payment option

In order to send an invoice by email to your customer, you must have an Internet 
connection, an email account, and your default email package must be MAPI-
compliant.

Tip: You can amend the default cover note for the email message text: from the 
Edit menu, choose Preferences. Select Send Forms, and click Company 
Preferences. 

To email an invoice with online payment option:
1 From the Customers menu, choose Create Invoices.

2 Enter the details of the invoice.

3 Click the the drop-down arrow next to the Email button, and choose ‘Email 
invoice with online payment option’.
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4 When QuickBooks prompts you to save the invoice, click Yes.

If the customer record does not include an email address, QuickBooks prompts 
you to enter an email address for this customer.

5 Type the email address, and click OK.

Your default email package opens with a new message to the customer. The 
message text also includes a link to a secure payment page to enable the customer 
to pay their invoice online., and the invoice is included as a PDF attachment.

Note: If your default email package is not MAPI-compliant, you have the option 
instead of saving the invoice as a PDF file. You can then create your own 
email and attach the file, but the email would not include the link to allow 
online payment.

6 You can then amend the text of the message if you wish, before sending the email.

Receiving a payment made online

When the customer has made their payment online, you receive an email confirming 
that payment has been made.

If the email includes an Online Invoicing Payment file (.OIP) as an attachment, you 
can then import the file. This will mark the invoice as paid, and it will also update the 
journal to transfer the receivable amount to the ‘Due from Credit Card Services’ 
account, as follows:
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� Debits the transaction fees including VAT to the expenses account for Card Service 
Expenses.

� Credits the sum of fees plus VAT at standard rate to the other current asset account 
for Due from Card Services.

If the confirmation email does not include an attachment, you would need to make a 
manual journal entry to transfer the amount, and you would then record the payment 
against the invoice in the normal way.

To import an OIF file:
1 When you receive the email, save the attachment to your chosen folder.

2 From the File menu, choose Import, then choose Online Invoicing Files.

3 Click Browse, navigate to your chosen folder, and select the OIP file.

QuickBooks marks the invoice as paid, and performs the journal entry.

Recording a debit/credit card payment to an invoice

If you have invoiced a customer and they make a debit or credit card payment directly 
to you, perhaps over the phone, you need to record the payment.

To record a debit/credit payment against an invoice:
1 From the Customers menu, choose Receive Payments.

QuickBooks displays the Receive Payments window.
99



A d d i t i o n a l  Q u i c k B o o k s  s e r v i c e s
2 In the Received from field, select the customer/job from the drop-down list.

QuickBooks displays details of the outstanding invoice(s) for the customer in the 
Applied To fields.

3 In the Amount field, type in the amount and press Tab.

4 In the Pmt. Method field, choose the relevant type of credit card from the drop-
down list, or choose Add New and set up the name and type of card:

5 Click in the tick column to select the invoice(s) to which this payment applies.

6 If you want to process the card payment online when saving, leave the tick in the 
box:

If you choose to process online, QuickBooks automatically selects to deposit the 
payment to “Due from QB Card Solutions”

7 Click Save & New or Save & Close.

QuickBooks displays the Enter Customer Card Information window. If you have 
already set up card details for the customer, these are displayed, but you can 
amend them if necessary.

8 Record the cardholder’s name and card details:

9 Click Send.

This sends and records the payment. The customer payment record indicates that 
the transaction has been processed:

A “PAID” stamp will appear on the invoice the next time it is retrieved.
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Entering a debit/credit payment at the time of sale

If you receive payment at the time you make a sale and do not raise an invoice, you 
fill in a cash sales receipt instead. The QuickBooks cash sales receipt includes 
information about the items or services purchased, and also includes information 
about how payment was made.

To enter a card payment sales receipt in QuickBooks:
1 From the Customers menu, choose Enter Sales Receipts.

QuickBooks displays the Enter Sales Receipts window.

2 Select the customer/job from the drop-down list.

3 Complete the item details.

If you want to process the card payment immediately, tick the box for Process 
online when saving:

QuickBooks automatically selects to deposit the payment to “Due from QB Card 
Solutions”.

4 Click Save & New or Save & Close.

QuickBooks displays the Enter Customer Card Information window. If you have 
already set up card details for the customer, these are displayed, but you can 
amend them if necessary.

5 Record the cardholder’s name and card details:

6 Click Send.

This sends and records the payment. The sales receipt indicates that the 
transaction has been processed:
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Recording a customer’s card details

If you want to record a customer’s card details for future reference, these details will 
be available as the default next time you select to receive payment or enter a sales 
receipt.

To record a customer’s card details on the customer record:
1 From the Lists menu, choose Customer:Job List.

2 Select the customer, then click the Customer:Job menu button, and choose Edit.

3 Click the Payment Info tab.

4 From the Preferred Payment Method drop-down list, select or add the type of card.

5 Enter the card details and customer card billing address.

QuickBooks obscures most of the digits in the credit card number after you have 
entered them, for security reasons.

6 Click OK.
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QuickBooks BACS e-Payment Solutions 
(Pro/Accountant)

QuickBooks e-Payments Solutions enables you to make BACS payments to employees 
or suppliers. This service uses the BACSTel-IP system. 

You can make choose to make payments using BACS. This generates an encrypted 
BACS file, which you can then transmit. Alternatively you can choose to generate a 
non-encrypted BACS file, which you can use with an existing BACS service provider.

You will receive a monthly statement of charges, sent by email. QuickBooks 
automatically creates a cheque for the direct debit payment.

To use this service, you must be using QuickBooks Pro or Accountant.

Signing up for e-Payment Solutions

There are two stages to signing up for e-Payment Solutions: 

� Applying for BACSTel-IP membership. 

� Enrolling for QuickBooks e-Payments Solutions.

To apply for BACSTel-IP membership:
� Contact your bank and complete a BACSTel-IP application form.

When your application has been processed, you will receive a BACS username, 
password and 6-digit service ID. You will need these details before you can enroll 
for QuickBooks e-Payments Solutions.

To enroll for QuickBooks e-Payments Solutions:
1 From the Employees menu, choose Employee Navigator.

2 Click the link “Find out how you can pay your employees online using BACS”. 
(You can use this link even if you are intending to pay only suppliers and not 
employees.)

QuickBooks opens the QuickBooks e-Payment Solutions window. From here, you 
can click the tabs at the top for information.

3 From the Common Questions or Getting Started tab pages, click the Apply Now 
link, and follow the onscreen instructions.

Preparing to use QuickBooks e-Payments Solutions

In order to use QuickBooks e-Payment Solutions, you need to set up the relevant 
preferences and account details in QuickBooks, for:

� Company bank settings

� Employees you want to pay by this method

� Suppliers you want to pay by this method
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Company bank settings

You need to set up the banking preferences to use BACS for e-Payment Solutions, and 
you also need to set up the BACS details in the bank account from which you want to 
make the payments.

To set up banking preferences to use BACS for e-Payment Solutions:
1 From the Edit menu, choose Preferences.

2 Select Banking, and click the Company Preferences tab.

3 Tick the boxes next to “Create BACS output files” and “I am signed up for 
e-Payment Solutions”.

Note: If you tick the e-Payment Solutions box, the file will be encrypted ready for 
submission using the QuickBooks e-Payment Solutions. If you use another 
system to submit files directly, you would not tick the second box. The file 
would not be encrypted, and you would use your existing system to 
encrypt and submit it.

4 Click BACS User Number.

QuickBooks displays the Company BACS Details window.

5 Type in the BACS user service ID number that you received from your BACSTel-IP 
application, then click OK.

Note: This number must always be 6 digits.

6 Click OK.

7 Specify the locations where your encrypted BACS files will be stored for:

� Payroll export file location.

� Non-Payroll export files.
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8 Click OK.

Next, you need to set up the BACS details in your bank account.

To set up BACS details in your bank account:
1 From the Lists menu, choose Chart of Accounts.

2 Select Master Bank Current.

3 Click the Account menu button, and choose Edit.

4 Click the BACS Information tab.

5 Complete the BACS details as follows:

� Account Name

� Sort Code

� Account Number

6 Click OK.

Setting up employee records

If you want to pay employees by using QuickBooks e-Payments solutions, you need to 
set up their records to enable them to be paid by BACS.

Each employee needs to supply you with details of the bank account into which they 
want you to make payment.

To set up employees to be paid by BACS:
1 From the Employees menu, choose Employee List.

2 Select the employee from the list.

3 Click the Employee menu button, and choose Edit.

4 From the Change tabs drop-down list, choose Payroll and Compensation Info.

5 For Pay Method, choose BACS from the drop-down list.
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6 Click Bank Details.

QuickBooks displays the Bank Details window. 

7 Complete the account information:

� Account Name

� Sort Code

� Account Number

You can also enter the bank details.

8 Click OK to return to the Edit Employee window.

9 Click OK.

Setting up supplier records

In order to pay suppliers through e-Payments Solutions, you need to set up their bank 
details to enable them to be paid by BACS. 

The supplier needs to provide you with details of the bank account into which they 
want you to pay. If they want you to notify them by fax or email that you have made 
the payment, they will need to provide these details as well.

You can use BACS payments only for UK suppliers (or for foreign suppliers with UK 
bank accounts into which you can pay in UK sterling). 

To set up suppliers to be paid by BACS:
1 From the Suppliers menu, choose Suppliers List.

2 Select the supplier name from the list.

3 Click the Supplier menu button, and choose Edit.

4 On the Address Info tab, enter the email address for the supplier, if you have it.

5 Click the BACS Information tab.

6 Complete the supplier’s bank information as follows:

� Account Name

� Sort Code

� Account Number
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7 Click OK.

Making payments through e-Payments Solutions

Paying employees

To pay employees through e-Payments Solutions:
1 From the Employees menu, choose Pay Employees. 

QuickBooks displays the Select Employees To Pay window.

2 Click in the tick column to the left to select the employees.

3 Click Create.

If you ticked “Enter hours and preview payment before creating”, QuickBooks 
displays the Preview Payment window. Enter the hours and click Create. Repeat 
this for each employee.

QuickBooks redisplays the Select Employees To Pay window.

4 Click Leave.

QuickBooks produces a payment for the employees in this batch. 

5 Close the Employee List.

QuickBooks produces an encrypted BACS payment file for the employees in this 
batch. The filename starts QBOut-, and has the suffix .bacs. It is saved in the folder 
you specified for Payroll Output Files.

6 Click OK.
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7 Close the Employee List.

Since the file is encrypted, you can view the BACS report to see details of the 
payment: From the Reports menu, choose Employees and Payroll, then choose 
BACS Report.

The next stage is to process the electronic payment using the encrypted file. 

To process the BACS payroll payment:
1 From the Banking menu, choose Banking Services, then choose Pay Employees via 

e-Payment Solutions. 

2 Log in to the payment services page.

3 Select the relevant file to transmit, and click Upload File. 

A summary message appears when transmission is complete. 

Paying suppliers

To pay suppliers through e-Payments Solutions:
1 From the Suppliers menu, choose Pay Bills.

QuickBooks displays the Pay Bills window.

2 Select the bill(s) you want to pay.

3 For Payment Account, choose the account for which you set up BACS payment 
details.

4 For Payment Method, choose BACS from the drop-down list.

5 Click Pay & Close.

QuickBooks produces an encrypted BACS payment file for each supplier in this 
batch. The filenames start QBOut-, and have the suffix .bacs. They are saved in 
the folder you specified for non-Payroll Output Files.
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6 Click OK for each message.

QuickBooks also produces a BACS Bill Payment Cheque to record each payment. 
If you want to review them, from the Banking menu, choose Write Cheques and 
click the Back button until you see the BACS Payment to each supplier.

The next stage is to process the electronic payment using the encrypted file. 

To process the suppliers’ BACS payments:
1 From the Suppliers menu, choose Suppliers Navigator.

2 Click the link for “Process BACS Payments online using e-Payment Solutions”. 

3 Log in to the payment services page.

4 Select the relevant file(s) to transmit, and click Upload File. 

A summary message appears when transmission is complete. 

You can then notify your suppliers that you have made payment. You can use an 
additional e-Payment Solutions service so that they are sent remittance advices by 
email or fax. 

Otherwise you can print the remittance advices and send them by fax or post.
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Overview

This chapter covers some basic procedures and troubleshooting techniques you and 
your clients will use with QuickBooks to produce reports, set up payroll and VAT, track 
sales and customers or purchases and suppliers, and resolve printing problems.

QuickBooks reports

Cash-basis transaction reports

QuickBooks produces reports on an accrual basis, unless you change the reporting 
preference (from the Edit menu, choose Preferences and select Reports & Graphs from 
the scroll box) to cash basis. However, the report basis you set up in the Reporting 
Preferences window applies only to QuickBooks summary reports (not to transaction 
reports). If you want to see a cash-basis transaction detail report, you must use a 
different method.

There are two ways you can generate a cash-basis transaction detail report:

� You can QuickZoom a cash-basis summary report. When you QuickZoom on a 
cash-basis summary report, QuickBooks displays a cash-basis transaction report.

� You can also generate cash-basis transaction reports by generating an accrual-basis 
transaction detail report and customising it so it uses cash basis. (After you 
generate the accrual-basis transaction detail report, click the Modify Report button 
and click “Cash” for Report Basis.)
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Cash-basis report examples

A cash-basis transaction report can look complicated when the report includes items 
that post to balance sheet accounts. This is because the report has to show a balancing 
entry for each amount. Without the balancing entries, the company finances would 
be out of balance.

Example 1: Payment in full for an invoice

Suppose you sell an stock item to a customer on 31 August. The item’s cost is £10.00; 
its sales price is £25.00. On 1 September, you receive a payment for the full £25.00. A 
cash basis transaction by date report represents the two transactions as follows:

When you record the invoice, you sell an item whose value as stock is £10.00. 
Accordingly, the Stock Asset account decreases by £10.00. To balance this amount, 
Accounts Receivable increases by £10.00:

When you apply the customer’s payment to the invoice, you incur the cost of selling 
the item. Accordingly, the Cost of Goods Sold Account increases by £10.00. To balance 
this amount, Accounts Receivable decreases by £10.00:

Because the customer’s payment is £25.00, the Sales account (where you track sales 
income) decreases by £25.00. (The account decreases because accounting conventions 
treat income as a negative number.) To balance this amount, Accounts Receivable 
increases temporarily by £25.00:

31/08/2007 Stock Asset Sales -10.00

31/08/2007 Accounts Receivable Sales 10.00

01/09/2007 Cost of Goods Sold Sales 10.00

01/09/2007 Accounts Receivable Sales 10.00

01/09/2007 Sales Accounts Receivable -25.00

01/09/2007 Accounts Receivable Undeposited Funds 25.00

01/09/2007 Undeposited Funds Accounts Receivable 25.00

01/09/2007 Accounts Receivable Undeposited Funds -25.00

31/08/2007 Stock Asset Sales -10.00

31/08/2007 Accounts Receivable Sales 10.00

01/09/2007 Cost of Goods Sold Sales 10.00

01/09/2007 Accounts Receivable Sales -10.00

01/09/2007 Sales Accounts Receivable -25.00

01/09/2007 Accounts Receivable Undeposited Funds 25.00
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Finally, the Undeposited Funds account increases by £25.00, the amount that the 
customer paid. (Undeposited Funds is where QuickBooks “holds” money you receive 
until you deposit it in a bank account.) To balance this amount, Accounts Receivable 
decreases by £25.00:

The net effect on the accounts is as follows:

� Stock Asset decreases by £10.00.

� Cost of Goods Sold increases by £10.00.

� Sales decreases by £25.00.

� Undeposited Funds increases by £25.00.

� Accounts Receivable remains unchanged.

Note that the total of all the changes is £0.00. The accounts are in balance.

Example 2: Partial payment of an invoice

What happens when you receive a partial payment for an invoice? Let's assume the 
same invoice as before, but this time you receive a payment of £12.50—half of the 
invoice total. The cash basis transaction report now looks like this:

Notice that QuickBooks has reduced all of the 1 September amounts by one half to 
reflect that fact that you only received half of the invoice total:

� Cost of Goods Sold increases by £5.00, not £10.00 as in the previous report.

� The cost of the sale is one half of the item's stock value, not its full value.

� Sales decreases by £12.50, not £25.00 as in the previous report.

� Undeposited Funds increases by £12.50, not £25.00 as in the previous report.

Each of these entries corresponds to a balancing entry in Accounts Receivable. As in 
the previous report, the total of all the entries is £0.00.

01/09/2007 Undeposited Funds Accounts Receivable 25.00

01/09/2007 Accounts Receivable Undeposited Funds -25.00

31/08/2007 Stock Asset Sales -10.00

31/08/2007 Accounts Receivable Sales 10.00

01/09/2007 Cost of Goods Sold Sales 5.00

01/09/2007 Accounts Receivable Sales -5.00

01/09/2007 Sales Accounts Receivable -12.50

01/09/2007 Accounts Receivable Undeposited Funds 12.50

01/09/2007 Undeposited Funds Accounts Receivable 12.50

01/09/2007 Accounts Receivable Undeposited Funds -12.50
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Payroll

Entering payroll year-to-date information

QuickBooks provides two options for entering year-to-date (YTD) payroll information. 
The first option is to recreate all pay cheques and liability payments from the 
beginning of the year. The second (shorter) option is to enter your previous payroll 
transactions as year-to-date adjustments. Both options provide summary information 
for payroll reports, payroll forms and accurate tracking of your payroll liabilities and 
employees’ taxes, deductions, and additions. Whichever option you choose, be sure 
to enter your year-to-date information before creating any new pay cheques for 
employees.

Recreating payroll cheques and liability payments

Recreating payroll cheques and liability payments from the beginning of the tax year 
gives you the most detailed information about your payroll transactions. This is the 
method Intuit recommends and it’s a good way to become familiar with the built-in 
Payroll feature.

Set up employees

When you set up all your employee information, make sure you include any previous 
SSP or SMP details (from the Add Employee window, select Statutory Pay Info and click 
Previous Info).
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Entering year-to-date adjustments

QuickBooks provides an Enter YTD Amounts wizard to help you enter the year-to-date 
adjustments. There are two basic types of information you must enter:

� YTD summaries for each employee

� YTD summaries of payments of payroll taxes and other liabilities

To enter YTD amounts:
1 From the Employees menu, choose Set Up YTD Amounts.

2 Click Next, and follow through the questions for each stage.

Be sure to enter your year-to-date information before creating any new pay cheques 
for employees.

The earnings basis

The earnings basis is the total amount of employee wages or earnings on which a 
payroll tax is calculated. This can be different from total gross earnings if the employee 
has pre-tax deductions. If there is an annual wage limit for the tax (for example, the 
Upper Earnings Limit for National Insurance Contributions), the earnings basis for the 
payroll year does not exceed this limit. QuickBooks calculates an employee’s wage 
basis using the total for salary, hourly wage, and commission payroll items, plus any 
additions to gross that are subject to a tax, minus any deductions from gross that 
reduce a tax.

When entering YTD amounts, it is very important that gross earnings and all additions 
and deductions affecting the earnings basis are entered correctly; otherwise 
QuickBooks will not be able to calculate payroll taxes correctly.

YTD summaries for each employee

You must enter summaries of earnings, taxes, and other amounts for each individual 
employee (both current and former) you paid during the current tax year, through 
your QuickBooks start date. For each employee you must enter both taxes withheld 
and taxes that are a company expense, as long as you owed them as a result of the 
employee’s earnings. For example, you must enter employee’s and employers’s 
National Insurance summaries for each employee.

YTD summaries of payments of payroll taxes and 
other liabilities

If the company has not made any payments for payroll taxes or other liabilities during 
this tax year, skip this adjustment.

For this adjustment, you’ll need to know how much you paid from 5 April of this year 
through your QuickBooks start date for each of the following:
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� Each payroll tax (whether withheld or paid as a company expense)

� Each employee-paid deduction you withheld and then paid (e.g., dental 
insurance)

� Each company contribution you tracked by payroll period and then paid (e.g., 
company-paid health insurance)

This adjustment is just for payroll liabilities you paid. It is not for expenses paid 
directly to employees.

Paying payroll taxes and liabilities

When you want to pay payroll taxes and other liabilities, QuickBooks shows you all 
of your current liabilities, lets you choose all or just some of them to pay, and creates 
cheques to pay them. You can also add penalties and expenses to these cheques.

Important: Before you can pay these liabilities, you must have a payee name associ-
ated with each liability. Usually these payees are tax agencies, but they may also be
banks or insurance companies.

To set up the payee names:
1 From the Employees menu, choose Payroll Item List.

2 Select the item you want to edit.

3 Click the Payroll Item menu button, and choose Edit.

4 Click Next; then, in the first field of the window, enter or choose a payee name.

To pay payroll tax liabilities:
1 From the Employees menu, choose Pay Payroll Liabilities.

2 Enter the date range for which you want to pay liabilities.

3 Indicate whether you want to print the cheques you create.

To print the cheques later, select the “To be printed” tick box. If you’re trans-
mitting this request by phone or you’re writing the cheques by hand, clear the “To 
be printed” tick box.

4 If you have more than one current account, choose the account from which you 
want to write the cheques.

5 If you want a date other than today’s date to appear on your liability payment 
cheques, enter that date in the Payment Date field.

6 If you want to view your liabilities as of a date other than the last day of the 
previous tax month, enter a different date in the “Show liabilities from/through” 
fields.

7 If you want QuickBooks to sort your list of liabilities in a different way, choose 
another option from the Sort By drop-down list. You can sort the list alphabeti-
cally by payee name, alphabetically by payroll item, or by amount due (largest 
first).
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8 Select the liabilities you want to pay now. If you have not yet entered a payee 
name, QuickBooks prompts you.

� To select liabilities one by one, click the field next to the liability to add or 
remove a tick mark.

� To select all liabilities, click Mark All. QuickBooks changes the button name to 
Unmark All and places a tick mark next to every liability.

� To clear (unmark) all liabilities, click the Unmark All button. QuickBooks 
changes the button name back to “Mark All” and clears the tick box next to 
every liability.

� If you select one of two related liabilities, QuickBooks automatically selects the 
other liability. For example, if you select PAYE, QuickBooks automatically 
selects employee’s and employer’s National Insurance.

Note: QuickBooks writes a single cheque for all liabilities to the same 
supplier name. If you want to write different cheques to the same 
supplier, you can go through the Pay Liability process once for each 
cheque, or give the supplier more than one name in your Supplier list.

9 (Optional) If you want to pay less than the full amount of a liability you selected, 
enter the amount you want to pay in the “Amt. To Pay” field.

10 Choose whether to preview the cheques before QuickBooks creates them.

� Select “Create liability cheque without reviewing” if you want QuickBooks to 
write cheques for all selected liabilities as soon as you click Create. This option 
saves time if you do not need to preview the cheques to enter penalties or 
expenses.

� Select “Review liability cheque to enter expenses/penalties, Class 1A NIC, SSP 
or SMP” if you need to add expenses, penalties, Class 1A National Insurance 
contributions, or statutory sick pay or maternity pay to one or more of the 
cheques you are creating.

If you choose to preview the liability cheque, you can enter expenses or penalties 
on the Expenses tab of the Liability Cheque window. After you enter the expenses 
or penalties, you can click Next or Prev to enter expenses or penalties on other 
cheques.

If the penalty or interest is for several taxes, you can increase the balance for one 
tax or distribute it among all the taxes. Then, pay the entire amount you owe 
when you write your liability cheque.

11 Click Create.

Troubleshooting payroll liability amounts due

Is the “Show Liabilities as of” date correct?

By default, QuickBooks uses the last day of the previous tax month as the “Show 
Liabilities as of” date. If your payroll taxes are paid on a weekly basis, change the 
“Show Liabilities as of” date to the week-ending date. To change the date:
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1 From the Employees menu, choose Pay Payroll Liabilities.

2 In the Select Date Range for Liabilities window, change the “Show liabilities from” 
date to your week-ending date.

For additional information search the onscreen Help index for payroll liabilities, paying.

Checking the amounts you are comparing

Are you comparing the amounts to the amounts on the payroll liabilities report? The 
Pay Liabilities window shows current outstanding liabilities through the date in the 
“Show liabilities as of” field. The payroll liability report shows liabilities that were 
outstanding as of the date of the report, even if the liabilities were paid on a later date.

When comparing the numbers, the amounts will match only when the report and the 
Pay Liabilities window dates are the same. For additional information, search the Help 
index for payroll liabilities, paying and income taxes, reports about.

Is a liability account associated with the item?

If the account is an expense account, QuickBooks does not show the amount in the 
payroll liabilities window.

To see if the item is associated with a liability account:
1 From the Lists menu, choose Payroll Item List.

2 Select the payroll item, then choose Edit from the Payroll Item menu button.

3 Click Next until you see the window that lists the associated liability account.

4 In the Liability Account field, check the type of account selected.

Are the amounts double or too high?

To run a QuickReport for a payroll item for all dates:
1 From the Lists menu, choose Payroll Item List.

2 Select the payroll item whose amount is too high, and then choose QuickReport 
from the Reports menu button.

3 At the top of the report, choose All from the Dates drop-down list.

This report displays all the transactions for the item. Review the report for duplicate 
transactions.

Have there been changes to Director’s NI during the 
year?

If the details and summary sections of the director’s P11 disagree because their NI code 
has changed during the year, you can get additional information by looking at the NI 
End of Year Summary, available through Report Finder, Employees & Payroll.
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Value Added Tax

Value Added Tax is tracked in a separate account in QuickBooks, and is handled 
differently from your regular accounts payable. 

Setting up an opening balance for the VAT Control account

In QuickBooks, how you enter an opening balance for your VAT Control account 
depends on the setup method you’re using:

� Re-creating all transactions for the financial year

� Entering opening balances

� Upgrading from an earlier version of QuickBooks

Re-creating all transactions

If you plan to re-create all transactions for this financial year, turn on the VAT feature 
in Preferences (on the Edit menu). Enter your transactions normally. The opening 
balances will be calculated automatically using the transactions you enter.

Entering opening balances

If you’ve entered opening balances for balance sheet and income/expense accounts as 
of your start date and you need to make entries in the VAT Control account, follow 
these instructions:

To make entries in the VAT Control account:
1 From the Edit menu, choose Preferences, then choose VAT, and click the 

Company Preferences tab. Turn on VAT and choose the appropriate settings.

2 From the Company menu, choose Make Journal Entry.

In the Date field, enter your start date.

3 In the Account column, select VAT Control from the drop-down list.

4 Enter the accrued VAT due (as of the start date) in the Credit column. If you've 
paid in advance or have a credit owed to you, use the Debit column.

5 In the Name field, choose HM Customs & Excise (or add it if not shown).

6 On a new line of the general journal entry, select Opening Bal Equity as the 
account. QuickBooks calculates the debit amount automatically.

7 Click Save & Close to save the entry.

To make sure you entered the journal entry correctly, verify that this amount appears 
when you choose Pay VAT Liability from the Suppliers menu.

If you have created opening balances by re-creating the current year’s transactions, but 
still have a carryover from the previous year, follow Steps 2–8 above. Select the 
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appropriate date (the end of your last fiscal year) for the general journal entry 
transaction.

Upgrading VAT from an earlier version of QuickBooks

When upgrading from a version of QuickBooks earlier than 2003, if you are using 
accrual accounting, QuickBooks flags as “Filed” all transactions for which a VAT 
liability payment or refund has already been made. This is because QuickBooks now 
tracks VAT differently, and enables you to report on and automatically include 
unreconciled transactions from previous periods when you make the next return.

Note: Once transactions have been flagged, this step cannot be undone. Make 
sure you have the date of your last VAT return ready when you upgrade 
your company file.

To flag VAT when upgrading from an earlier version than 2003 
(accrual accounting):
1 Back up the company file in the old version of QuickBooks.

2 Restore the backup in the current version of QuickBooks.

QuickBooks displays a message that all users need to run the new version in order 
to access the company file, then displays a window asking for your last VAT return 
date:
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3 Type in the ending date for the last date on which you paid VAT liability or 
received a refund, and click Next.

QuickBooks asks you to confirm.

4 Click OK.

QuickBooks restores and upgrades the company file.

5 From the Banking menu, choose Use Register, and select VAT Control from the 
drop-down list.

QuickBooks displays the VAT Control account register. All cleared VAT 
transactions are flagged with F.

Note: If the “1-Line” box is ticked, you need to clear it in order to see the flags.

Paying VAT

There are two methods of paying VAT, depending on whether you use accrual or cash 
based accounting.

To pay VAT liability (accrual accounting):
1 From the Suppliers menu, select VAT, then File VAT.

QuickBooks displays the File VAT window.

2 If necessary, change the “Show VAT through” date and press Tab.

QuickBooks recalculates the details, and prefills the necessary fields.
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3 Click in the Pay column so that a tick appears.

4 Select “To be printed”.

5 Click Next.

QuickBooks displays the Value Added Tax Return report:

6 Click Next.

An information message is displayed.

7 Click OK.

QuickBooks redisplays the Pay VAT window.

8 Click Print.

The Print dialog box appears.

9 Click Print.

QuickBooks sends the VAT return to your printer, records the VAT cheque in the 
current account register, and deducts the amount from the VAT Control account. 

You can use the QuickBooks return to fill in the VAT 100 return that you send to 
HM Customs and Excise. The VAT cheque can be printed in the usual way.

Note that VAT payments do not affect VAT reports at all. After you pay your VAT for 
a reporting period, your VAT reports for that period maintain the amount you paid. 
This provides you with the necessary support in the event of a VAT audit.
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To pay VAT liability (cash accounting)
1 From the Reports menu, choose VAT, then VAT 100.

QuickBooks displays the VAT 100 report.

2 Use these figures to fill in the return form.

3 From the Reports menu, choose VAT, then VAT Summary.

QuickBooks displays the VAT Summary report.

4 From the Suppliers menu, choose Pay VAT Liability.

QuickBooks displays the Write Cheques window, and prefills the necessary fields 
in the top part of the window.

5 In the Net Amt field (on the Expenses tab), enter the Total VAT Owed amount 
from the VAT Summary report.

6 Click Save & Close.

When you record the VAT cheque, QuickBooks automatically deducts the amount 
from the VAT Control account.

Note that VAT payments do not affect VAT reports at all. After you pay your VAT for 
a reporting period, your VAT reports for that period maintain the amount you paid. 
This provides you with the necessary support in the event of a VAT audit.
125



C o m m o n  Q u i c k B o o k s  p r o c e d u r e s
Entering a VAT-only bill

There are certain situations when you might receive a bill from a supplier which is for 
VAT only. This might be for a number of reasons: maybe they have recently registered 
for VAT, or maybe they are overseas and they need to send you a bill for just the VAT 
portion of an order. 

This example shows how to enter a £50.00 bill which is all VAT. The two “Net Amt” 
entries on lines 1 and 2 cancel each other out to equal zero.

Purchases and suppliers

Applying credits and discounts from suppliers

This section describes how to apply supplier credits and discounts.

Handling supplier credits

To enter a supplier credit:
1 From the Suppliers menu, choose Enter Bills, and then select Credit. 

Create the credit just as you would a bill.

2 When you want to pay a bill to that supplier (and apply the credit against the bill), 
from the Suppliers menu, choose Pay Bills.

3 Select both the bill and credit (click to the left of each).

4 Confirm the credit amount you want to apply to the bill.
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5 Click Done.

QuickBooks automatically applies the credit to the bill, and reduces the amount 
you owe. You can also choose to apply credits to specific bills.

For multiple bills, QuickBooks applies the credit to the smallest bill first, and then 
to the remaining bills in ascending order, unless you select the credit and the one 
bill to which you want to apply it.

6 Click Save & Close.

Tip: In the Pay Bills window, change the Sort Bills By option to “Supplier” in 
order to group transactions for the same supplier.

Handling supplier discounts

You can record and apply a discount on supplier bills directly from the Enter Bills 
window.

To apply a discount:
1 From the Suppliers menu, choose Enter Bills.

2 In the Enter Bills window, click Credit.

The window now displays the Credit form.

3 Select the supplier from the drop-down list. 

4 Complete the Credit Amount field.

5 In the Account field, enter the name of the account you use to track discounts 
received from suppliers. (e.g., Cash Discounts). This information is required.

6 Complete the VAT code, Net Amt and VAT Amt fields.

7 Click Save & Close. 

Sales and customers

Tracking reimbursable expenses

When you record expenses, you can assign part or all of the expense to a customer or 
job. Later, QuickBooks can recall the amount and add it as a line item to an invoice, 
sales receipt, or statement charge.

To assign reimbursable expenses:
1 Open the form where you want to enter the expense. It can be a cheque, credit 

card charge, bill, item receipt, or a special transaction (general journal entry).

2 Choose the supplier from the Supplier drop-down list, and enter any supplier-
related information.
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3 Enter the expenses and items.

� If you’re recording a direct expense such as freight or shipping, enter the 
expense on the Expense tab. 

� If you’re recording customer- or job-related items or services contracted, enter 
the item or service you purchased on the Items tab (this feature is only 
available in QuickBooks Pro/Accountant). 

Any description you manually enter on the Items tab is not transferred to the 
invoice. The invoice uses the description from the New/Edit Item window.

4 In the Customer:Job field of the detail area, enter the name of the customer(s) or 
job(s) that you want to assign the expense to.

If you are assigning an expense to a job, enter the customer's name followed by a 
colon (:) and the job name. For example, Fred Ahl:Kitchen.

5 Indicate in the billable column (the column headed by the small invoice icon) 
whether to pass this charge on to the customer. 

� If the invoice icon does not appear in the billable column, you probably did 
not select an Expense or Other Current Asset type of account. 

� If the expense is billable to the customer, leave the invoice icon next to the 
customer's name as it is. 

� If the expense is not billable to the customer, click the invoice icon next to the 
customer's name to mark an “X” through it. (Clicking the invoice icon again 
removes the “X”.) 

Note: You may want to attribute an expense to a customer but not make it 
billable. For example, you may need to redo a job without charging the 
customer, but still need to track the expenses incurred on behalf of the 
customer. In that case, click the Expense button (the Time/Cost button 
in the Pro/Accountant version) on the invoice, and select the option 
to “Hide” the expense; it will not appear on the invoice.

� After you record the invoice that includes the expense, the invoice icon is 
dimmed for that expense, indicating that you have billed the expense to the 
customer. 

6 (Optional) If you are assigning only part of the expense to this customer or job, 
select the amount shown in the Amount column, and enter the amount you want 
to assign. 

7 Click OK to record the expense. 

If you delete the invoice or the invoice line containing the reimbursable expense, and 
you want to invoice the customer again, go back to the form where the expense is 
recorded. Select it as billable by clicking on the dimmed invoice icon next to the 
customer or job.

Note: With QuickBooks Pro/Accountant, you can use the options to enter time 
and vehicle mileage and indicate if they are billable, then pick up these 
details on the invoice (via the Time/Cost button).
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Fixing payments misapplied to invoices

This section describes how to find and reapply misapplied payments. This process can 
be lengthy or quick, depending upon when payments were first misapplied. There are 
three steps involved in fixing payments applied to the wrong invoices:

� Use a customer balance detail report to find the first misapplied payment. 

� Delete and reapply each incorrectly applied payment.

� If the misapplied payments were caused by a customer credit, account for the 
credit in a new way, so you don’t have the same problem again with this customer.

Finding the first misapplied payment

To find the first misapplied payment:
1 From the Reports menu, choose Customers & Receivables, and then choose 

Customer Balance Detail.

2 Click Modify Report, then click the Filters tab.

3 In the Filter scroll box, select Name.

4 From the Name drop-down list, select the Customer:Job with the misapplied 
payments.

5 Click OK.

QuickBooks displays the customer balance detail report for the customer you need 
to work with.

6 On the report, QuickZoom the latest payment. (Use the mouse to point to the 
payment amount, and double-click.)

QuickBooks displays the Receive Payments window for this payment.

7 Check whether the invoices QuickBooks indicates were paid by this payment are 
the correct ones. If they are not, click Cancel and check the previous payment on 
the report until you find the first misapplied payment.

Make sure you check the Existing Credits field. Often, misapplied payments are caused 
by a credit to this customer; QuickBooks always applies all existing credits before 
applying the current payment amount.

When you find the first misapplied payment, move on to the next section.

Deleting and reapplying payments

To reapply payments to the correct invoices, you’ll have to delete the payments, re-
enter them, and apply them to the proper invoices. If the payments have been 
deposited, you first have to delete the deposit. 

We recommend that you back up your company file before deleting payments.
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To delete the payment:
1 Display the first misapplied payment.

2 Write down the information about the payment, since you’re about to delete it.

3 Press Ctrl+D.

If the payment has been deposited, QuickBooks will not let you delete it until 
you’ve deleted the deposit in which it’s included.

4 If you have already deposited the payment, complete the following steps before 
continuing:

� To find out which deposit the payment is linked to, press Ctrl+H from the 
Receive Payments window. The Transaction History window shows the paid 
invoices and the deposit linked to the payment.

� To get to the deposit, click on the deposit line and click the Go To button.

� At the Make Deposits window, click the Print button to print a list of the items 
(payments) included in this deposit, since you’ll have to delete and then re-
enter this deposit. (Or, write down the contents of the deposit.)

� Press Ctrl+D to delete the deposit. Once the deposit has been deleted, delete 
the payment.

5 Re-enter the payment you deleted, making sure the payment is applied to the 
correct invoice(s). 

If there is a credit in the Existing Credits field when you enter the payment, see 
the next section before proceeding. When you’ve cleared any existing credits, 
continue with Steps 6 and 7.

6 Re-enter the deposit you deleted, including the newly entered payment.

7 Repeat these steps until you’ve re-entered and applied each payment to the correct 
invoices.

Handling existing credits

QuickBooks applies any existing credits to invoices before it applies the current 
payment amount. If you’d rather apply a current payment amount to an invoice 
instead of the existing credit amount, clear the “Apply Existing Credit” tick box in the 
Receive Payments window.

Handling customer overpayments

When you have a customer who has overpaid an invoice, QuickBooks keeps track of 
the overpaid amount. The best way to handle the overpayment is to enter the 
overpayment in QuickBooks and then apply the overpayment (either to another 
invoice or to a refund cheque).
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Creating the overpayment

To enter the overpayment in QuickBooks:
1 From the Customers menu, choose Receive Payments.

2 Select the Customer:Job from the drop-down list.

3 Enter the amount being received.

QuickBooks enters the amount received in the Total to Apply field, enters the 
payment of the invoice, and enters the amount of the overpayment in the Unap-
plied Amount field.

4 (Optional) Click Print Credit Memo to print a credit memo for the unapplied 
amount.

5 Click Save & Close in the Receive Payments window.

6 Click OK in the message window that QuickBooks displays.

Applying the overpayment

There are two ways to handle the overpayment. You can wait until you have another 
invoice to apply it to, or you can issue a refund cheque for the overpayment amount 
in the Create Credit Memo/Refund window.

To apply the overpayment to an invoice:
1 From the Customers menu, choose Receive Payments.

2 Select the Customer:Job from the drop-down list.

3 Do not type an amount in the Amount field. Enter an amount only if you are 
receiving an additional payment at the same time.

4 Select the “Apply Existing Credits?” tick box.

5 Click Save & Close.

QuickBooks automatically applies the existing credit to the outstanding invoice. If 
you do not use all of the existing credit, the unapplied amount remains as an existing 
credit.

To issue a refund cheque for the overpayment:
1 From the Customers menu, choose Create Credit Memos/Refunds.

2 Click Refund. DO NOT fill in the Credit Memo.

3 If QuickBooks asks if you want to write a refund cheque that is not directly linked 
to this credit memo, click Yes.

4 In the Write Cheques window, choose the Customer:Job from the drop-down list 
in the “Pay to the Order of” field.

5 Enter the amount of the overpayment in the dollar amount field.

6 Select “To be printed” to print the cheque.
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7 Click in the Account column on the Expenses tab and choose Accounts Receivable 
from the drop-down list.

8 Click Save & Close.

9 In the Create Credit Memo/Refund window, click Clear and then close the 
window (do not save the credit memo).

The final step is to link the refund cheque to the existing credit.

To apply the refund cheque to the overpayment:
1 From the Customers menu, choose Receive Payments.

2 Select the Customer:Job for which you just wrote the refund cheque.

You’ll see the amount of the credit included in the Existing Credits field, and the 
refund cheque in the bottom section of the window.

3 Select the “Apply Existing Credits?” tick box. Make sure that the refund cheque 
line is selected in the bottom section of the window.

4 Click Save & Close.

Applying an existing credit to an invoice

If you’ve already created a credit memo for a customer, follow these steps to apply the 
credit memo to an invoice.

To apply a credit amount to the oldest invoice:
1 From the Customers menu, choose Receive Payments.

2 Select a Customer:Job.

The amount of the credit appears in the Existing Credits field.

3 Select the “Apply Existing Credits?” tick box to apply the credit amount to any 
invoice for this customer.

4 If the credit amount is not displayed next to the first invoice listed, click the Auto 
Apply button.

5 Click Save & Close.

If you have set QuickBooks to automatically apply payments, QuickBooks applies the 
credit to invoices that match the amount of the credit first, and then to the oldest 
outstanding invoice.

To apply a credit amount to a specific invoice:
1 In the Receive Payments window, click the Clear Payments button, if it is 

available.

2 Select the “Apply existing credits?” tick box and choose the invoice you want to 
pay by clicking in the tick mark column next to the invoice being paid.

The amount of the credit should now appear in the payment column next to the 
invoice you have selected.
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3 Click Save & Close.

Handling returned items on an unpaid invoice

If you have a customer who is returning items from an unpaid invoice, you may want 
to void the invoice instead of deleting it to keep complete records of all sales. If the 
customer is returning items, but there are items remaining on the invoice, you can 
create a credit memo to record the returned item.

To void an invoice:
1 Display the sales form you want to void.

2 From the Edit menu, choose Void Invoice.

QuickBooks changes the amounts on the sale to zero and displays “Void” in the 
Memo field.

3 Click OK in the Create Invoices window, or click Record in the Accounts 
Receivable register.

To record a return:
1 From the Customers menu, choose Create Credit Memos/Refunds.

2 Fill in the credit memo, entering the returned items in the line-item area.

Use the same information that was on the original invoice or cash sale.

QuickBooks decreases the income accounts of the invoice items by the amount of 
the return.

3 (Optional) To print the credit memo, click Print.

4 Click Save & Close.

QuickBooks enters a negative amount in the A/R register for the credit memo.

QuickBooks accounts

Using the Undeposited Funds account

When you use the Receive Payments window, a payment item on an invoice, or the 
Enter Cash Sales window, QuickBooks knows you’ve received money. You may hold 
the money in a drawer or cash register and later go to your bank to make a deposit.

QuickBooks holds the amount in an Other Current Asset account called Undeposited 
Funds until you record a deposit. QuickBooks then transfers the money into your bank 
account. The Undeposited Funds account is specifically designed to hold money a 
company has received that has not yet been deposited in the bank. This makes it easier 
to reconcile your bank account because deposits match those appearing on your 
statement.
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Here is a summary of how QuickBooks uses the Undeposited Funds account:

� The business owner receives payment from a customer.

� QuickBooks holds the payment in the Undeposited Funds account.

� When the business owner deposits the payment into a bank account, QuickBooks 
moves the money from Undeposited Funds to the specified bank account.

Deposits display “Undeposited Funds” in the Account 
field

When you choose payments to deposit, they appear in the Make Deposits window 
with Undeposited Funds as the originating account.

When you click Save & Close in the Make Deposits window, QuickBooks enters the 
deposit in your bank account register. Because the payment amounts have moved 
from the Undeposited Funds account to your bank account, your register shows 
Undeposited Funds as the account in the deposit transaction. Use Make Deposits 
whenever you go to the bank so your bank statements will match your account 
registers in QuickBooks.

Changing the name of the Undeposited Funds account

You can change the account name to something that suits you better. The new name 
appears in your account register.

To change the name of the account:
1 From the Lists menu, choose Chart of Accounts.

2 In the Chart of Accounts window, select the Undeposited Funds account.

3 Click the Account menu button and then choose Edit.

4 Enter a new name for this account.

Some suggestions for new names are “Sales income holding account,” “Payments 
received,” “Funds from A/R,” or “Payments to be deposited.”

5 Click OK.

Reviewing journal entries

You can review journal entries by opening the General Journal.

In QuickBooks Accountant, you can see a report of today’s journal entries.

If you need to reverse a journal entry, you can do this automatically without having 
to retype the original entry. The reversed entry will be dated the 1st of the next month.
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To report on today’s journal entries:
� From Report Finder, choose Memorised Reports, then Accountant, and then 

Journal Entries Entered/Modified Today.

QuickBooks displays the report:

To reverse a journal entry:
1 From the Banking menu, choose Make Journal Entry.

2 Click Previous until you find the entry you want to reverse.
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3 Click Reverse.

QuickBooks creates a journal entry with the same number with an R suffixed, 
dated the 1st of the following month:
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Printing

Troubleshooting techniques for printing problems

Most printing problems can be resolved by changing the printer settings in 
QuickBooks or the Windows operating system. This section discusses many of the 
factors that affect printing. Try to categorise the printing problem accordingly, then 
follow the appropriate steps below.

Keep this in mind as you troubleshoot: if everything was printing correctly in the past 
but now it is not, the system may have been changed recently. For example, has new 
software been installed?

Nothing prints out at all
� Make sure the printer is turned on and is indicating that it is “online.”

� Try printing from another application to verify that Windows is still communi-
cating with the printer.

� Check the printer window for other previously stalled documents and clear them 
if necessary. (In Windows, click the Start button, choose Settings, and then choose 
Printers. Double-click the icon for the printer you want to view. You’ll see the 
print queue with all print jobs listed.)

All printers have some type of indicator to let you know they are ready and waiting to 
receive data. Check that the printer is in this “online” state.

Since Microsoft Windows controls the printer, a good test is to print from the basic 
Windows text editor called WordPad. During this test, be sure that you select the same 
printer that you are having difficulty with in QuickBooks.

To test printing from WordPad:
1 In Windows, click the Start button, then choose Run. In the Open field, type 

wordpad and then click OK.

2 In the WordPad window, type a test sentence.

3 From the File menu, choose Print and click OK.

If the test sentence printed correctly, the problem is probably with QuickBooks. 
Try to print another type of document or form from within QuickBooks to isolate 
the problem area, then confine the changes to that setup area only.

4 If the test sentence does not print from WordPad, this means that Windows is not 
communicating with the printer and, therefore, neither can QuickBooks.

Next, check the print queue in Windows to see if there are other print documents 
stalled there.
137



C o m m o n  Q u i c k B o o k s  p r o c e d u r e s
To check for stalled documents:
1 In Windows, click the Start button, choose Settings, and then choose Printers. 

Double-click the icon for the printer you’re testing.

2 If there are documents listed under the printer name, click the first one to high-
light it. If Windows says it is stalled, choose Cancel Printing from the Document 
menu to stop the print job.

3 You can also choose Purge Print Jobs from the Printer menu to clear out all of the 
queued documents. This is especially useful if Windows fails to delete a queued 
document. If this is a chronic problem, you may wish to disable the “spool 
settings” for this printer.

Windows lets you “spool” your printing jobs, so that you can work on the computer 
while printing in the background. If you disable print spooling, you must wait until 
the document prints out before you can use the computer again. However, since 
eliminating print spooling simplifies the printing process, it may allow you to print 
correctly.

Important: If you share your printer with others (for example, you print to a network
printer), print spooling is required.

To disable print spooling:
1 In Windows, click the Start button, point to Settings, and then choose Control 

Panel.

2 In the Control Panel window, double-click the Printers icon.

3 Click the icon for the printer you want.

4 From the File menu, choose Properties.

5 Click the Details tab, and then click the Spool Settings button.

6 In the Spool Settings window, select “Print directly to the printer.”

7 Click OK until you return to the Control Panel window.

8 Close the Control Panel window.

There is “garbage” or clipped text on the printout
� The presence of “garbage” generally indicates that the printer does not understand 

the language Windows is using to communicate. Make sure that the printer driver 
listed in the Printer name field of the QuickBooks Printer Setup window is the 
correct one.

Select the correct printer from the Printer name drop-down list. If the correct 
printer driver is not on the list, you need to install it. You can get the right driver 
from the printer manufacturer or from Microsoft. If you need detailed instructions 
on installing a printer, search the Windows onscreen Help for printer drivers, 
installing.

� Some printers can emulate several other printers. Check that the printer is in the 
same emulation mode as the printer selected in QuickBooks Printer Setup. Refer to 
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your printer manual for clarification. If the printer manual lists several alternate 
compatible printer drivers, install and try them in the order listed.

� Text clipping and, occasionally, garbage can indicate that the selected font is too 
complex or too large for the print area. In the QuickBooks Printer Setup window, 
choose the appropriate font area and select another font, or reduce the font size.

� Occasionally, a font controller or enhancer, such as Adobe Type Manager, may 
cause QuickBooks to produce unwanted results on the printout. If changing the 
font or size did not reduce the clipping or garbage, exit QuickBooks, disable the 
font program, and then try printing again. Refer to that program’s documentation 
for instructions on disabling it.

The printout is not aligned correctly, or large areas or 
lines do not print
� Run through the form alignment process again.

� On reports, make sure the margins are not set too large or too small.

Most users need only perform cheque and form alignment once to set up QuickBooks 
for a specific printer.

� If you have a continuous-feed printer, note the position of the forms after aligning 
so you can accurately position the forms by hand the next time. Otherwise you 
will have to coarse-align every time you print on preprinted cheques and forms. If 
you have a page-oriented printer, forms only need to be fine-aligned.

� If the entire right-hand vertical line of an invoice is not printing, try fine-aligning 
the form to the left.

� On reports, clipping can be caused by having too-narrow margins in the Report 
Printer Setup. Most printers cannot print closer than one-half inch from the 
paper’s edge. Therefore, margins set at 0-inch, for example, will probably result in 
clipped text near the margins. On invoices with marginal clipping, choosing to 
use a custom form may resolve some clipping problems, as the internal margins 
are different from those on standard forms.

For detailed instructions on print alignment in QuickBooks, search the onscreen Help 
index for aligning forms in printer.

The printer is pulling from the wrong tray or feeding 
incorrectly
� Check that the printer settings in the QuickBooks Printer Setup window such as 

paper source, paper size, and printer memory are correct for what you are printing.

� Check the printer manual to understand what the manufacturer intended to 
happen during printing.

If the printer is using the wrong paper tray, or wrong orientation, or printing in the 
wrong place on the page, verify your printer setup settings.
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To verify the settings in printer setup:
1 From the File menu, choose Printer Setup.

2 Click the Settings tab, and then click Options.

3 Click the Paper tab.

Make sure that these settings are correct for the document and the printer you are 
having trouble with.

Some printers feed cheques and forms face up from their paper trays, while others feed 
face down. If your printer feeds face down, a stack of numbered cheques should be fed 
in the wrong order. Be sure to manually resort the stack of cheques so that the cheque 
number recorded in the register matches the printed document. Check the printer 
manual to understand the manufacturer’s intended paper handling.

Wingdings or Symbol fonts are printing on my P60 
forms

The P60 form uses the OCR-A.ttf font that QuickBooks installs to the 
Windows\System directory, or in a Fonts folder in Windows. If QuickBooks cannot 
find this font, it uses another, typically the Windings or Symbols font. If your 
QuickBooks forms print in what looks like pictures or gibberish, the OCR-A font is 
unavailable or damaged. Below are the common causes and their solutions.

� You haven’t finished installing QuickBooks. If you’ve just installed QuickBooks, 
make sure to restart Windows prior to using the program.

� Your OCR-A font is missing or damaged. In Windows, select Fonts from your 
Control Panel. Double-click the OCR-A font. In the font window that displays, 
click Print. If you can’t locate this font or print successfully, it can be reinstalled.

� You may have hidden the OCR-A font with a font program. If you’re using a font 
controller like HP FontSmart or Adobe Type Manager, go into the font program 
and select the option to “Show All Fonts” or a similar option that un-hides or 
displays all fonts.

Printing company logos on QuickBooks forms

You can have QuickBooks print a logo (a .BMP file) on your forms. By default, it prints 
to the left of the company name and address on forms. If you like, you can move the 
logo to a different part of the form, for example, centred at the top.

The logo can be a .BMP, .GIF, .JPEG or similar file created with a Windows 95 or higher 
application. You can reduce or expand the size of the logo by using the mouse to select 
and resize it.

For details, see “Customising forms” in chapter 1.
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Section 2 Working with 
clients who use 
QuickBooks
S e c t i o n  2

As a sophisticated QuickBooks user, you can be a valuable resource for your clients. By 
setting up their QuickBooks companies for them, or by reviewing the setup of clients 
already using QuickBooks, you may be able to suggest ways that they can maximize 
their use of QuickBooks to suit their businesses. For example, you may see a way that 
a client can use QuickBooks classes to track the profitability of different segments of 
the business.

When your clients are set up on QuickBooks, there are many ways you can choose to 
work with them and use their data files. Much is dependent on how much assistance 
your clients want, and how confident they feel in creating or customizing their own 
QuickBooks reports. Here are some possible scenarios:

� Clients may enter their day-to-day transactions in QuickBooks and create their 
own monthly financial statements. They may give you the data only when they 
want you to prepare a yearly tax return.

� Clients may enter their day-to-day transactions in QuickBooks but want you to use 
their data disk to create monthly financial statements. This gives you an oppor-
tunity to check their transactions and make recommendations on how they can 
improve the accuracy of their data. Depending on the needs of the client, you may 
want to offer training on a specific aspect of QuickBooks.

� After seeing profitability reports, clients may request business-management 
advice. You can use their data disk to create financial reports that allow you to 
determine areas of risk in the business (for example, dependency on a particular 
customer) or areas of high expenses.

� Clients may want to send you a backup copy of their data on a periodic basis, as a 
method of quick, off-site data storage.

This section gives you information about setting up QuickBooks for clients, modifying 
QuickBooks to suit their businesses, and working with a client’s QuickBooks data file. 
The section also contains information about some reports you may find helpful in 
working with and analysing your clients’ data.
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Converting from a manual system

This section describes how to set up QuickBooks for a client who has been using a 
manual bookkeeping system. If you have clients who have been using Quicken to 
track their business’s financial transactions and who have decided to upgrade to the 
small-business capabilities of QuickBooks, see the User Guide.

Before you set up QuickBooks for clients, you should know how the business operates, 
what information they need to track, and what information they require for 
management decisions. This will help you determine which QuickBooks features they 
should use.

QuickBooks setup also requires detailed information about employees, customers, and 
suppliers. The next section provides a checklist of the information you should have 
available before you create the client’s new QuickBooks company.

Tip: QuickBooks contains onscreen Help topics written to address the needs of 
many professions, such as architects, consultants, medical personnel, and 
product sales businesses. These topics may help you gain insight into the 
special problems and reporting needs of your clients’ businesses. To view them, 
search in the Help for Your Type of Business.

Client setup checklist

You should have these items available before you set up a new QuickBooks company 
for your client:

� Name

� Address

� Company registration number

� Financial year end

� QuickBooks “start date”

� Type of business

� Trial balance for the period up to the QuickBooks start date

� Chart of accounts

� List of customers, including addresses, contact names, and phone numbers

� List of types of items being sold (either products or services), sale prices (or hourly 
rates), and whether taxable

� List of invoices outstanding as of the QuickBooks start date

� VAT registration number and other information, if applicable. For example, you 
need to know which tax rates are charged for different products or services.

� List of suppliers, including addresses, contact names, and phone numbers

� List of supplier invoices that have not been paid as of the QuickBooks start date
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� Details of any business done in foreign currencies

� Budget for the financial year, if any

� Payroll tax information:

- PAYE reference number

- Types of regular additions or deductions from employee pay (such as auto-
mobile reimbursements, employee loan repayments, insurance co-payments)

- List of employees, including tax codes, National Insurance numbers, 
addresses, rates of pay, and other regular additions or deductions from pay

- Tax year-to-date employee pay, summarised by employee by month

When you have gathered the information above, create a new QuickBooks company 
as described in Chapter 3, “Setting up your company in QuickBooks,” in the 
QuickBooks User Guide. Choose the preset chart of accounts that most closely applies 
to the client’s type of business. Later, you can add to or edit the chart of accounts as 
necessary. Then set up QuickBooks lists for your client, as described in the next 
section.

Setting up QuickBooks lists for your client

After you add a QuickBooks company, you’ll want to set up QuickBooks to suit the 
needs of your client. For more information on what to do next, see “Setting up a new 
company,” in Chapter 2 of the QuickBooks User Guide.

The information stored in QuickBooks lists can be added to or corrected as you process 
transactions. However, if you’re doing the QuickBooks setup for your client, you’ll 
want to add the most common list items, to increase efficiency and accuracy when the 
client enters transactions.

Item list

Whether the client sells products or services, any line item to be included on an 
invoice must be on the QuickBooks Item list. Add a QuickBooks item for each type of 
charge that appears on an invoice.

Items are how you associate an income account with goods or services a company 
invoices for, so it’s important that you set up items correctly to generate meaningful 
financial reports. The following table summarises the types of QuickBooks items.
146



C H A P T E R  6
Item type Use for
Usual effect on 
accounts

Service Services you charge for or services 
you purchase.

On sale: Increases income.

Stock Part Products you purchase, track as 
stock, and then resell.
Examples: Electrical outlets, 
T-shirts

On sale: Increases income, 
increases cost of goods sold, 
and decreases stock assets.
On purchase: Increases 
stock assets.

Stock Assembly Products you assemble from stock 
items that you have purchased (or 
from sub-assemblies), and then 
resell.
If the component items are also 
stock items that you resell, selling 
price of the assembly can be set 
independently of the combined 
selling prices of the components.
Examples: Finished goods, 
computer, gift basket

On build: Decreases stock assets 
for the components, increases 
stock assets for the assemblies, 
calculates cost of asset based on 
average cost of components.
On purchase: Increases stock 
assets.
On sale: Increases income, 
increases cost of goods sold, 
decreases stock assets for the 
assemblies; independent of any 
accounts affected by the individ-
ual component stock parts.

Non-stock part Products you sell but do not 
purchase; items you purchase and 
resell but do not track as stock.
Examples: Custom-made 
slipcovers, pizza

On sale: Increases income.
On purchase: Increases 
expenses.

Other Charge Other charges on a sale or a 
purchase.
Examples: Shipping charge, 
delivery charge, finance charge

On sale: Increases income.
On purchase: Increases 
expenses.

Subtotal Calculating and printing a subtotal 
on sales forms.

Subtotal items have no effect on 
accounts.

Group Fast entry of a group of individual 
items already on the list.
Examples: A group of services and 
food items provided by a caterer.

Each item in the group affects 
the same account it affects when 
used by itself.

Discount Calculating an amount to be 
subtracted from a total or subtotal.
Examples: A 10% discount given to 
nonprofits.

Either decreases income or 
increases expenses (depending 
on item setup).
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Enter a VAT code (exempt, standard, zero-rated, or not registered) for each item.

If you are using units of measure, make sure you enter the units when you first set up 
the stock item (the unit can be different for stocking unit, selling unit and purchasing 
unit).

Complete all the fields in the New Item window, so that invoices and cash sales 
receipts are entered accurately.

These items are affected by price levels.

For more information, refer to the Help.

Customer:Job list

Determine whether the client will want to sort later based upon the type of customer. 
If so, create customer types. For example, you can use customer types to distinguish 
between corporate and individual or wholesale and retail customers.

If the client wants to track jobs (or projects) for each customer, make sure you know 
the amount owed to the client for each job as of the QuickBooks start date.

Complete all of the information requested in the Customer:Job list. If the customer 
purchases for resale, obtain the resale number and record it in the list.

If your client uses QuickBooks Pro, you can set up different price levels and associate 
them with specific customers. Each time your client creates an invoice, credit memo, 
or sales form for that customer, QuickBooks will use the price level associated with 
that customer to calculate the rate for service, inventory, and non-inventory items.

For more information about setting up and using price levels in QuickBooks Pro, 
search the onscreen Help index for price levels.

For a new QuickBooks company, you need to enter the opening balance for each 
customer as of the client’s QuickBooks start date. Enter a summary invoice for each 
customer using an item called “opening balance.” Assign the item to the appropriate 
income account. Each invoice should be dated before the QuickBooks start date.

Payment On invoices: Payment received at 
the time of invoicing, so that 
amount owed on invoice is 
reduced.
On cash sales summaries: To show 
totals for each type of payment 
(cash, cheques, credit card 
charges).

Increases the balance of either a 
specific bank account or the 
account for undeposited funds 
(depending on item setup).

Item type Use for
Usual effect on 
accounts
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QuickBooks allows you to create custom fields for customers. For example, if your 
client wants to track additional information for customers, such as the customer’s 
e-mail address, administrative assistant, or region, you can add custom fields to the 
Customer:Job list. For more information on custom fields, search the onscreen Help 
index for custom fields.

Supplier list

Before adding the supplier information, determine whether the client will want to sort 
later based upon the type of supplier. If so, create supplier types. For example, supplier 
types allow your client to distinguish between suppliers who provide business supplies 
and those who provide construction materials.

For a new QuickBooks company, you need to enter the opening balance for each 
supplier as of the client’s QuickBooks start date. Enter a summary bill for each supplier 
in the Enter Bills window. Assign the amounts to the appropriate expense account. 
Each supplier bill should have a date earlier than the QuickBooks start date.

In the Supplier list, use the Account field (on the Additional Info tab) to record the 
client’s account number with the supplier. QuickBooks puts this information in the 
Memo field of cheques that pay bills from this supplier. 

If you want to store additional information about suppliers (such as an e-mail address 
or region), you can use a custom field.

Payroll Item List

QuickBooks maintains a list—called the Payroll Item list—for everything that affects 
the amount on a payroll cheque and for every company expense related to payroll. 
When you indicate you want to use payroll, QuickBooks creates an initial Payroll Item 
list with items for salary and wages, income tax, and National Insurance 
contributions. However, you’ll need payroll items for other payroll additions and 
deductions such as bonuses, commissions, pension and health contributions.

For more information, search the onscreen Help index for payroll items.

Employee list

If your client will be using QuickBooks for payroll and has more than one or two 
employees, you’ll want to set up an employee template. The employee template lets 
you set up several employees quickly, because you use the template to enter 
information that most employees have in common (such as payroll period and tax 
information). Then, when you go to the Employee list to set up individual employees, 
many of the fields will be prefilled with the information you entered on the employee 
template.

For more information on setting up the employee template, search the onscreen Help 
index for employee defaults, creating.
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To add the information for each employee in the Employee list:
1 Provide general employee information on the Address Info tab.

2 Provide other pertinent information on the Additional Info tab. Add any custom 
fields for additional employee information you want to track (such as birthdays).

3 Use the Payroll Info tab to set up regular earnings, additions and deductions which 
you haven’t entered on your employee template (you can also modify each pay 
cheque when you run payroll). 

4 Click Sick/Holiday to enter details of sick and holiday pay.

5 Click Tax/NI Details to enter tax code and NI status.

6 Click Bank Details to enter the employee’s bank details for Giro or BACS 
payments.

7 Click Previous Employment to enter P45 details if the employee joined the 
company in the current tax year.

8 Use the Statutory Pay Info tab to enter details of SSP, SMP, SPP or SAP. If there are 
any previous details to enter, click Previous Info.

For more information about setting up employee payroll information, search the 
onscreen Help for employees, payroll information about.

Classes

If your client wants to classify expenses and income, you can use class tracking. You 
need to turn it on and set up the classes before any transactions are entered. 

If you turn on class tracking later on, existing transactions will not have a class applied 
to them, and will appear in reports as Unclassified.

Classes can be used on a line-by-line basis on forms like invoices and purchase orders.

You can set the preferences so that QuickBooks warns users if they try to enter a 
transaction without assigning a class.

Fixed Assets Items

In QuickBooks Pro/Accountant, if your client wants to be able to record information 
about their fixed assets, such as the purchase price, serial number and warranty expiry 
date, you can use the Fixed Assets Item list.

Fixed asset items can be tracked in reports, and used in transactions, for example in a 
purchase order, or if an item is repaired or sold.
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Converting from Quicken to QuickBooks

When you convert data from Quicken to QuickBooks, QuickBooks makes a copy of the 
Quicken file and performs the conversion on the copy. QuickBooks does not modify 
the original Quicken data file. Your client may continue to use Quicken with the 
original data while using QuickBooks with the converted data, but keep in mind that 
the Quicken file and the new QuickBooks data file are different and do not 
communicate with one another.

Converting a client’s data from Quicken to QuickBooks involves these steps:

� Making a backup copy of the client’s Quicken data disk.

� Removing accounts that are inactive or not related to the business.

� Making changes to the data after conversion.

Preparing for the conversion

Before converting, make a copy of the Quicken data disk and include only the current 
financial, payroll, and calendar year information. This lets you maintain the 
information needed to process the payroll year-end and prepare the P11, P60, and P35 
payroll information. Rename the file using your client’s initials and conv (for 
“convert”)—for example, PSIconv.

Review the account listing and remove those accounts that are either inactive or not 
related to the business. Convert only the accounts you want to use in QuickBooks.

Now follow the conversion instructions in the manual. (See Chapter 3 in the User 
Guide.)

Making changes to the converted data

When you convert Quicken data to QuickBooks, the conversion saves you the time of 
typing in all the transactions, but you’ll probably want to make some changes to the 
converted data.

Before your client starts using the QuickBooks data file, you may want to complete the 
following steps to help them get up and running with QuickBooks.

To set up the converted QuickBooks file for your client:
1 Complete company information: From the Company menu, choose Company 

Information.

2 Customise QuickBooks to match the needs of your client’s company by turning 
on the features they need, turning off the features they don’t, and customising the 
forms they’ll use. To do this, you’ll need to go through the all of the menu choices 
in the QuickBooks Preferences window (available from the Edit menu) that apply 
to your clients. 
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3 Depending on your client’s business, some options in the Preferences window are 
especially important to check:

� Accounting. By default, the “Use account numbers” option is turned off. If 
you want your client to use account numbers and account names, select this 
option.

� Chequing. By default, printing account names on the voucher portion of 
cheques is turned off. Turn it on if you want your clients to print account 
names on voucher cheques.You may also want to select default bank accounts 
to use in the Write Cheques, Pay Bills, Pay Liabilities, and Make Deposits 
windows.

� Payroll & Employees. By default, payroll is turned off. If your client has a 
payroll—even if it is not processed using QuickBooks—you will want to turn 
payroll on by selecting either “Full payroll features” or “Payroll reports only.”

� Purchases & Suppliers. Turn on stock by selecting “Stock and purchase orders 
are active”. If they want to use units of measure, you can turn this on here, but 
note that once turned on you cannot turn it off again.

� VAT. The option, “Do you track VAT” is turned off by default. If necessary, 
turn it on and set up your client’s VAT reporting details.

This is a list of some of the changes you may have to make to the converted data, as 
well as where you can find complete information in the standard QuickBooks 
documentation:

� Look at the new chart of accounts and make necessary changes. QuickBooks 
supports many more types of accounts than Quicken and has more flexibility in 
how the accounts can be organised. You’ll want to make changes in your 
converted chart of accounts to take advantage of the additional flexibility in 
QuickBooks. For example, you might want to do the following:

- Remove or merge duplicate accounts.

- Add accounts.

- Verify that accounts are assigned to the correct type, and edit the account type 
if necessary.

- Edit accounts that you want to be subaccounts of another account.

- Rearrange the position of accounts in the list.

For details on how to do each of the procedures above, search the onscreen Help 
index for accounts, and double-click the appropriate Help subtopic.

Important: If you create subaccounts, make sure your client understands that
they need to select the subaccounts rather than the parent accounts when they en-
ter transactions. If they have selected the parent account, the P&L reports will
show the parent account name followed by “- Other”. 

� Enter opening balances for asset and liability accounts that were not previously 
maintained (for example, your client may not have tracked the office building as 
a fixed asset in Quicken). You can do this by editing the chart of accounts, or you 
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can create a journal entry by choosing Make Journal Entry from the Company 
menu. The advantage of using a journal entry is that it gives a better audit trail.

� Enter adjusting journal entries, as necessary, so that all accounting information is 
correct and represented in QuickBooks. Because Quicken does not support many 
types of business activities, you’ll usually find it necessary to make adjustments in 
QuickBooks for information not tracked in Quicken. See the last two items in this 
list for how to enter balances for accounts receivable and accounts payable.

You can create a working trial balance by printing the QuickBooks trial balance 
report to disk, in tab-delimited format. (To do so from the Reports menu, choose 
Accountant & Taxes, and then choose Trial Balance. Click Print. In the Print 
Reports window, click the Settings tab, click File, and choose Tab delimited file.) 
You can then open the “working trial balance” in your spreadsheet program and 
prepare journal entries to obtain an adjusted working trial balance. After verifying 
that the balances are what you expect them to be, record the journal entries to 
QuickBooks (from the Company menu, choose Make Journal Entry), using the 
client’s QuickBooks start date as the “entry date” for the journal entries.

� During conversion, QuickBooks gives you the option to assign each of the 
Quicken payee names to one of these QuickBooks lists: Customers, Suppliers, 
Employees, or Other Names. If you don’t know which list a name belongs on, 
leave it on the Other Names list. After conversion, you can edit the Other Names 
list to change Quicken payees to QuickBooks suppliers, customers, or employees, 
and to enter additional information not previously stored by Quicken. See “Edit 
your Other Names list” in Chapter 3, “How do I bring my data into QuickBooks,” 
of the User Guide.

Once you assign a name to the customer, supplier, or employee list, you will not 
be able to switch it to a different list, so it’s safest to choose the Other Names list 
when you’re unsure.

� Set up invoice items in QuickBooks. Whether the client sells products or services, 
any line item to be included on an invoice must be on the QuickBooks Item list. 
Add a QuickBooks item for each type of charge that appears on an invoice.

� If your client was tracking accounts receivable in Quicken: When QuickBooks 
converts a Quicken A/R account, it makes the following changes:

This transaction in the Quicken 
A/R account...

Is converted to this in 
QuickBooks...

Each transaction that increases the A/R 
balance

An invoice to a customer

Each transaction that decreases the A/R 
balance and has only one split line

A credit memo

Each transaction that decreases the A/R 
balances and has more than one split line

A credit memo to a customer

Each payee A customer on the QuickBooks 
Customer:Job list
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QuickBooks marks invoices as paid by assigning each payment it converts to the oldest 
invoice for that customer first.

You may want to change the names of some of the converted invoice items. For 
example, if the Quicken category your client used in most A/R transactions was “Sales 
income,” you’ll want to change the name of the converted invoice item from “Sales 
income” to the product or service they actually sell, such as “Consulting hours.” In 
addition, you should set up your clients so they can start using QuickBooks invoices 
and accounts receivable for all future invoices they create.

� If your client was not tracking accounts receivable in Quicken: You probably 
want to enter detail for outstanding customer balances, rather than just entering 
opening balances for customers in the Customer:Job list. Enter a summary of each 
customer invoice. To do this, create a QuickBooks item called “Convert,” and 
assign the total invoice (including any VAT) to a Sales income account. Each 
invoice should have a date earlier than the client’s QuickBooks start date.

� If your client was tracking accounts payable (A/P) in Quicken: QuickBooks 
converts the Quicken A/P account to a QuickBooks current liability account type. 
You need to show the client how to enter bills in QuickBooks accounts payable for 
all future bills.

� If your client was not tracking accounts payable in Quicken: Enter each 
supplier invoice (bill) and assign the amount to the appropriate expense account. 
Each supplier invoice should have a date earlier than the client’s QuickBooks start 
date.

Completing the EasyStep Interview

Although it’s possible to set up a QuickBooks company on your own by working 
through the menus, we strongly encourage users to take advantage of the EasyStep 
Interview.

Many Professional Advisors do company setup for their clients. However, some prefer 
to serve as backup in case of trouble, and the clients actually set up the QuickBooks 
company themselves. If you deal with clients who will be setting up a QuickBooks 
company on their own, the best advice you can give them is to work through the 
EasyStep Interview.

The EasyStep Interview gives your clients information about each choice they are 
asked to make during setup. They’ll learn the advantages and disadvantages of 
potential choices, and they will be better partners with you as a result.

Each category Both an item on the Item list and an 
income account on the chart of accounts

This transaction in the Quicken 
A/R account...

Is converted to this in 
QuickBooks...
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Break it down into smaller steps

You should recommend to clients that they do not attempt to complete the EasyStep 
Interview while they are in the middle of a busy workday. Most business owners find 
their setup time is more efficient if they go through the interview before or after work 
hours or at the weekend. They should allow a couple of hours to complete the 
interview.

Admittedly, setting up a QuickBooks company takes time. Most small-business owners 
do better with QuickBooks setup if they break the job into manageable chunks. 

Your clients’ goal while setting up is to provide as much information as necessary to 
get going, but not to provide all the details at once. We recommend, for example, that 
users enter only a portion of their customer, supplier, employee, and list data while 
they are completing the Interview. They can enter data for three customers, for 
example, and then go on to the next part of the Interview. This lets them enter the 
rest of their customer data as they go and as they begin working in QuickBooks.

Have them follow the order of tasks on this list.

1 Choose the QuickBooks start date.

2 Gather the necessary business information and documents.

3 Set up the company using the EasyStep Interview.

4 Fine-tune the chart of accounts.

5 Enter any historical transactions.

6 Complete customer and supplier information.

7 Complete the Item list.

8 Enter any optional adjustments.

Choose a start date

The QuickBooks start date is the date for which you give QuickBooks a financial 
snapshot of the company. The date your client chooses determines what they will 
enter in the Interview.

To choose a start date that’s best for their company, consider the following questions:

� When does the company’s financial year start?

� How close is today to the end of the financial year?

� Is there an accurate balance sheet for the current financial year?

� Is there an accurate profit and loss statement for the current financial year?

� How far back in time are they willing to enter historical transactions?
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Gather the necessary business information and 
documents

Refer your clients to the detailed list of information that they’ll need in Chapter 2, 
“Setting up your company in QuickBooks”, in the QuickBooks User Guide.

Go through the EasyStep Interview

When you click the General tab on the right side of the EasyStep Interview window, 
QuickBooks displays five tabbed sections along the top: Welcome, Company Info, 
Preferences, VAT, and Start Date. We recommend that all users begin with the General 
tab, so that QuickBooks has the basic information it needs for the remaining interview 
questions.

� The Welcome section explains how to navigate through the Interview.

� Company Info is where your client provides general information about the 
company, such as name, address, tax identification number, and so on.

� Preferences is where your client turns on several optional QuickBooks features, 
such as stock, payroll, estimates, time tracking, progress invoicing, multicurrency, 
and classes. It is also where clients can choose a preset invoice format, how they 
want to handle bill-paying, and whether they want the Reminders window to 
appear.

� VAT is where the client turns on VAT tracking and enters the VAT reporting 
period, reporting method (accrual or cash basis) and accounting method (Net or 
Gross).

� Start Date is where the client views information on how to choose a start date, and 
is asked to enter the date.

The rest of the Interview asks users to enter information about:

� Income and expense accounts.

� Income and stock item details.

� Opening balances for customers, suppliers, and accounts.

� Payroll details.

The Interview concludes with suggestions on what to do next.

After the Easy Step Interview

After your clients complete the EasyStep Interview, we recommend that you help 
them with these tasks.

Fine-tune the chart of accounts

First, review the chart of accounts QuickBooks has set up. You may need to add 
income and expense accounts, add subaccounts, delete accounts, or move accounts. 
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It is important to decide on an account structure before your clients begin entering 
transactions. 

In particular, if multicurrency is enabled, accounts may need to be set up for payables 
and receivables, bank and credit cards in each foreign currency used.

Enter any historical transactions

If the QuickBooks start date is before today’s date, clients also need to enter past 
transactions, in order to have complete financial records from the start date forward. 
It is not necessary to enter all historical transactions at one time, but the picture of 
their financial status will not be complete until they do.

If your clients are going to use QuickBooks to track payroll, they should enter 
historical payroll information so QuickBooks has complete year-to-date records of 
wages and salaries already paid.

Entering historical transactions in bank accounts is only part of the picture. Your 
clients must also enter these types of transactions:

� Cheques or other charges that occurred before the start date but didn’t appear on 
statements before the start date.

� Other cheques written after the start date that were not for bills or accounts 
payable.

� Deposits made after the start date that were not customer payments.

� Deposits made before the start date, but which didn’t appear on statements before 
the start date.

� Bank charges and fees.

� Interest paid on the account.

Advise your clients that is important to enter historical transactions in this order:

1 Invoices sent since the start date.

2 Purchase orders issued since the start date.

3 Cash or cheques received since the start date.

4 Bills received since the start date.

5 Bills paid since the start date.

6 Deposits made to any of the accounts since the start date.

7 Any other cheques written (for things other than bills) since the start date.

Complete customer and supplier information

Your clients entered only some of their customer and supplier data. Next, they need 
to fill in the customer and supplier records, to provide detailed information such as 
addresses, phone numbers, and credit limits.
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Businesses with a large number of customers or suppliers may want to hire a data-entry 
clerk to handle this task.

Complete the Item list

QuickBooks starts a list of items when you go through the Interview, but your clients 
will want to add to the list. Remind them that each item they want to use on a sales 
form must be on their QuickBooks Item list.

Enter any optional adjustments

After your client has created a company in the EasyStep Interview, you may need to 
make a few adjustments as of its start date.

Enter VAT liability

If your client is registered for VAT, you may need to record a balance for VAT owed as 
of the company’s start date in the VAT Control account register. Make sure that HM 
Revenue & Customs is a supplier on the client’s Supplier list.

Note: Do not enter the amounts in the register if you have entered historical 
invoices. VAT is already included on them. However, you will want to check 
to see if you owe more VAT than is represented on the invoices. In that case 
you will need to enter an adjustment in the VAT Control account register for 
the remaining tax liability.

For further information, see “Value Added Tax” in Chapter 4.

Adjust the Uncategorised Income and Uncategorised 
Expenses (for accrual basis only)

When you enter unpaid balances for customers, QuickBooks assigns the income to an 
account called Uncategorised Income. Similarly, when you enter unpaid balances for 
suppliers, QuickBooks assigns the expenses to the Uncategorised Expenses account.

If your clients keep their books on an accrual basis, QuickBooks shows these two 
accounts on a profit and loss statement as of the QuickBooks start date. You may want 
to make an adjustment so that the income from all invoices and the expenses from all 
bills before the start date are also tracked on an accrual basis, regardless of whether 
payment has occurred.

Adjust for current income and expenses if the start date is 
not at the beginning of the client’s financial year

If your client is setting up with a midyear start date and you know what your client’s 
income and expenses are for the period from the beginning of the financial year to the 
start date, you can enter an adjustment for them. Then, when you create a profit and 
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loss statement in QuickBooks, it will be accurate for the period starting with the 
beginning of the financial year and ending on any date after the start date.

Distribute earnings and equity from before the client’s start 
date

After you have entered all of the client’s opening balances and made other 
adjustments, you may want to move the amount in the Opening Bal Equity account 
to the other equity accounts if you want to identify retained earnings or the equity of 
several owners.

Using QuickBooks payroll

To help ensure compliance with Inland Revenue regulations, QuickBooks uses tax 
tables to calculate payroll. Your clients can get current tax tables, and keep them 
current, by subscribing to the QuickBooks Payroll Service.

If your clients choose not to subscribe to the payroll service, they will need to calculate 
and enter their payroll tax deductions manually for each pay cheque.

To learn more about the QuickBooks Payroll Service, from the Help menu, choose 
Information & Support, and then click on QuickBooks Payroll Service.

For more information about setting up payroll in QuickBooks, see Chapter 7, “Payroll 
and employees”, in the QuickBooks User Guide.

Setting up QuickBooks Pro/Accountant for 
multiple users

Your clients who have QuickBooks Pro/Accountant can use the program in multi-user 
mode, with up to five people working in the same company file at the same time.

Multi-user mode is only available in QuickBooks Pro or Accountant. Each user must 
have a unique copy of QuickBooks Pro or Accountant installed with a unique 
Installation Key Code. Each user must be using the same version of QuickBooks.

In addition, to run QuickBooks Pro/Accountant in multi-user mode you must have:

� Windows 2000 Server, NT 4.0 Server with Service Pack 6a. 

OR

� Peer-to-Peer network, using either Windows NT 4.0 with Service Pack 6a or 
Windows 95, 98, 2000 or XP.

� One licensed copy of QuickBooks Pro or QuickBooks Accountant for each 
networked computer (up to five).
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Important: Intuit recommends you have the latest Service Pack or update for your
operating system or network software. If you are uncertain whether you have the latest
Service Pack or update, contact Microsoft, Novell, or your network administrator.

Multi-user installation

Each user who wants access to the QuickBooks company file should have read/write 
access and create/delete rights to the directory where the company file is stored. 
QuickBooks must be installed on each of the networked workstations, but the 
company file is in one shared location.

If the QuickBooks CD is mounted on a server or a shared CD-ROM drive, you can 
install from the mounted CD, but you cannot install across the network to a remote 
computer. That is, you must be sitting at the computer you’re installing to, but you 
should store the company file on the shared resource.

Important: If your clients are using the multi-user feature in an earlier version of
QuickBooks Pro/Accountant and want to continue using it in the current version of
QuickBooks Pro/Accountant, they must replace all copies of the earlier version of
QuickBooks Pro/Accountant with the current version. Company files updated in the
current version of QuickBooks cannot be read by earlier versions—and such files can-
not be converted back to earlier QuickBooks versions after they’ve been updated.

For more details, see Chapter 1, “System requirements and installation,” in the User 
Guide.

Setting up users

The Set up Users and Passwords feature lets you set up users in QuickBooks and guides 
you step-by-step through the different access areas of QuickBooks. For each access area 
of QuickBooks, you can give a user no access, full access, or customised access.

Note: You can set up as many users as you wish; however, only five users may 
have access to the company file at a time.

Until you set up users in a QuickBooks company file, any person who accesses the 
company file has full access, just as they always have. However, no two people can 
access the company file simultaneously. If you want to have concurrent usage or you 
want to restrict access, you must set up users. The first person to set up users has the 
ability to set the password for the QuickBooks Administrator, who is a special user and 
has abilities that no other user can be granted (such as setting up other users).

The QuickBooks Administrator

When you create a new QuickBooks company file, QuickBooks creates a user called 
“Admin.” This is the QuickBooks Administrator for that company file. The 
QuickBooks Administrator has unlimited access to all data in the company file, and is 
the only person who can add additional users to access the company file.
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Assigning user passwords and permissions

When you (as the Administrator) set up a user, you also assign a password that the user 
can change later. You can restrict access to certain users by specifying the areas of 
QuickBooks in which they are allowed to work.

To set up users and customise their access:
1 From the Company menu, choose Set Up Users.

2 Set up the Administrator’s password and click OK.

3 In the User List window, click Add User.

4 Follow the onscreen instructions to set up users and passwords.

Accessing client data

From time to time, both during and after setup, you may need to access your clients’ 
data files. In most cases, you need to be using the same version of QuickBooks as the 
client with whom you are working. This section describes how to install multiple 
versions of QuickBooks on your computer, and discusses several scenarios you might 
use to access client data when you are not at the client’s site.

Using remote access

If you have QuickBooks Accountant, you can use the QuickBooks remote access 
service to access a QuickBooks company file on another computer. With remote 
access, you can check something in a client’s file, enter changes, or even set up a new 
company file without being at your client’s place of business. 

To use remote access, both you and your client must have an Internet connection. 
Remote access lets you work with your client’s QuickBooks software and other 
programs that integrate with QuickBooks, but not programs unrelated to QuickBooks.

Note: You can also sign up to access your own company file from a remote 
location.

To learn about...
Search the onscreen 
Help index for...

Setting up users users, adding

The role of QuickBooks 
Administrator

admin

The different access areas of 
QuickBooks

passwords, access areas

Setting up passwords passwords, adding
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To sign up for remote access: 
1 Connect to the Internet as you usually would.

2 From the Accountant menu, choose Remote Access. 

3 Click the link to Sign Up Now. 

Note: Internet access is required. One 12-month basic subscription valid for 
customers who purchase and install QuickBooks Accountant Edition 
software before the end of December. After 12 months, users can subscribe 
to the service for a fee. Fees apply for additional subscriptions. Service 
subject to change.

To access a client’s QuickBooks file: 
1 Connect to the Internet as you usually would.

2 From the Accountant menu, choose Remote Access. 

3 Log in with your user name and password. 

4 Call or email your client with his or her unique session number and the web page 
he or she should visit. 

5 Request control of your client's QuickBooks file. 

6 When the client approves your request, work with their QuickBooks data as you 
normally would. 

Note: Internet access is required. Service subject to change.

Installing multiple versions of QuickBooks on your computer

Since your clients may use different versions of QuickBooks, it is likely that you will 
need to install multiple versions of QuickBooks on your computer. 

You can have QuickBooks Regular, QuickBooks Pro and QuickBooks Accountant on 
the same computer. 

When installing new versions of QuickBooks, if you want to continue to use an older 
version of QuickBooks, be sure to install the newer version in a new folder or directory.

Within the same version of QuickBooks, you can open data files created with 
QuickBooks, QuickBooks Pro or QuickBooks Accountant. However, when using 
QuickBooks Regular to view a file created in QuickBooks Pro or Accountant, the 
Pro/Accountant features cannot be edited; the data is still in the file, but it cannot be 
changed using QuickBooks Regular. 

Note: If the QuickBooks Pro/Accountant file uses multicurrency, it is not 
possible to open the file in QuickBooks Regular.

Sharing data files with clients

Following are several scenarios of how you might want to work with your client’s data 
file. No matter which method(s) you choose, it’s always a good idea to have your 
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clients send you a backup of their QuickBooks data file on a regular basis (monthly or 
quarterly, depending on the amount of activity); if the computer or data are damaged 
or lost for any reason, you can help clients get up and running with the backup stored 
at your location.

Scenario 1: Using the Accountant’s Review feature, your client sends an 
“Accountant’s Copy” data file on disk to you. You modify the data file, as necessary, 
and return an export data file containing only your adjustments to your client.

To use the Accountant’s Review feature, both you and your client must be using the 
same version of QuickBooks, QuickBooks Pro or QuickBooks Accountant for 
Windows.

1 Your client backs up data using the QuickBooks Accountant’s Review feature, 
“Create Accountant’s Copy,” and sends the data file to you.

2 You restore the data file to your hard drive using the QuickBooks Accountant’s 
Review feature, “Start using Accountant’s Copy.”

3 You review the file and make adjustments as necessary, using the journal entry 
screen.

4 When you finish your adjustments, create an export file containing your adjust-
ments to send back to your client. Using the Accountant’s Review feature, choose 
“Export changes for Client.”

5 Your client uses the QuickBooks Accountant’s Review feature to “Import 
accountant’s changes” from the file you returned—your adjustments will then be 
added to their data file.

Important: While you have the data file, your client can continue to enter 
transactions into QuickBooks. However, there are certain limitations to what you can
do in the Accountant’s Copy. For details on what you can and cannot do in the
Accountant’s Copy, see “What an accountant can do with an Accountant’s Review
copy” on page 20.

Scenario 2: Client sends QuickBooks data file on disk to you. You modify the data file, 
as necessary, and return the data file to your client. In this scenario, you must have 
the same version of QuickBooks as your client. QuickBooks, QuickBooks Pro and 
QuickBooks Accountant data files are interchangeable if they are the same version.

1 Your client backs up data using the QuickBooks Backup feature and sends the data 
file to you.

2 You restore the data file to your hard drive using the QuickBooks Restore feature.

3 You make adjustments and corrections, as necessary, directly to your client’s 
QuickBooks data file. You can use the journal entry screen or modify the actual 
transactions.

4 When you finish your adjustments, back up the QuickBooks data file using the 
QuickBooks Backup feature and send the disk(s) back to your client.
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5 Your client uses the QuickBooks Restore feature to restore the data file you return 
to them. The client overwrites the data file that is on the hard drive, since the copy 
you returned is more current.

Important: While you have the data file, your client must either stop entering trans-
actions into QuickBooks or must re-enter the transactions that occurred while the file
was at your office. (The transactions must be re-entered into the data file you return.)

Scenario 3: Client sends QuickBooks data file on disk to you. You modify the data file 
as necessary and give your client a report of adjustments for the client to enter into 
their copy of the data file. In this scenario, you must have the same version or a more 
recent version of QuickBooks, QuickBooks Pro or QuickBooks Accountant than your 
client.

1 Your client backs up data using the QuickBooks Backup feature.

2 You restore the data file to your hard drive using the QuickBooks Restore feature.

3 You make adjustments/corrections, as necessary, directly into your client’s 
QuickBooks data file. This works best if you make only general journal entries for 
the adjustments, so you can easily generate a report on the changes/adjustments 
made to the data file.

4 When you complete your adjusting entries, print a journal report. (From the 
Reports menu, choose Accountant & Taxes, and then choose Journal.) Filter the 
report for transaction type “Journal” and specify the date range for your adjust-
ments.

Scenario 4: You use a modem and remote control communications software to log on 
to your client’s computer. You enter adjustments directly into the client’s data file that 
resides on your client’s computer.

� You must have a modem and special communications software that allows you to 
remotely control another computer. Depending on the communications software, 
you may also have to install some software on your client’s computer.

� Your client cannot use the computer while you have remote control of the 
computer.

1 You start QuickBooks on your client’s machine, make changes and adjustments as 
necessary, and print any necessary reports.

2 When you’ve finished your corrections, you log off your client’s computer. 

Your client can use the QuickBooks data file again.

Scenario 5: Client sends the QuickBooks data file to you electronically, using a 
modem and communications software. You enter the adjustments directly into the 
client’s data file and return the data file via modem.

Both you and your client must have a modem and communications software. You will 
also want to compress (or zip) the QuickBooks data file before sending it, to reduce the 
file size—this greatly reduces the time necessary to transmit the data file. Common 
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compression software includes PKZIP and WINZIP; these programs are “shareware” 
and are distributed free of charge on most online services.

You might also try using the Backup and Restore features in QuickBooks. QuickBooks 
backup files are compressed.

1 Your client first must compress or zip the data file and then send it to you via 
modem.

2 You download the file to your hard drive and then uncompress or unzip the file.

3 You can enter adjustments as necessary and print any needed reports. When you 
are done with your work, you must compress or zip the QuickBooks file again and 
return it to your client via modem.

4 Your client then must download the file, uncompress or unzip it, and make sure 
the updated data file is in their QuickBooks directory.

For more information about backing up and restoring QuickBooks files, see “Backing 
up company data” on page 190, and “Restoring company data” on page 201.
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Tools for evaluating client data

If you want to provide financial management and analysis services for your clients, 
you may find the information in this section especially helpful.

Getting an overview of company data

If you’d like to get an overview of your client’s company before running reports to 
evaluate data in depth, start with the Company Centre. The Company Centre gives 
you a snapshot of your client’s company information by showing the following 
information in a single location.

� All company account balances

� A graph of the income and expense trends

� Summary information for accounts payable and accounts receivable

To display the Company Centre:
� From the Company menu, choose Company Centre.

In addition to the Company Centre, QuickBooks provides three other centres: the 
Customer Centre, the Customer Detail Centre, and the Supplier Detail Centre.

QuickBooks centres collect and group data for specific areas of a business. In each 
centre you can look at several sets of related data, analyse the information, and take 
appropriate action on it.
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Creating and using QuickBooks standard reports

The following is a description of standard reports you may want to generate for your 
clients. You can set up the customised reports in your client’s data file and memorise 
them. This makes it easier to recall the reports you find useful, without repeating all 
the steps to customise each time.

Statement of cash flows

The statement of cash flows report shows how your client’s cash position changed 
over a period of time. It shows the amount of cash earned from profit, where the client 
received additional cash, and where cash was spent. Use the report t osee how much 
cash was provided or used by operating activities, investing activities and financing 
activities.

To create a statement of cash flows:
1 From the Reports menu, choose Company & Financial.

2 Choose Statement of Cash Flows.

For instructions on how to classify cash in the statement of cash flows report, search 
the onscreen Help index for statement of cash flows report.
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Balance sheet

The QuickBooks comparison balance sheet lets you see current balances compared 
with prior periods (such as the previous year). If you are preparing a statement of cash 
flows for a client, the comparison balance sheet lets you see which items would be 
affected. It also helps you determine “where the cash went” when the client is 
reporting net income but no comparable cash increase.

To create a comparison balance sheet:
1 From the Reports menu, choose Company & Financial.

2 Choose Balance Sheet Prev Year Comparison.

3 If required, modify the report to show a different date range to look only at a 
specific month or quarter.

Before printing the report, you can view it onscreen. If you see balances that appear 
abnormal, you can use QuickZoom (by double-clicking the balance in question) to see 
a detailed transaction report on that balance.

With the detailed transaction report displayed, you can change the date range to look 
only at a specific month or quarter. You can then print the detailed transaction report 
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for your files. (New fixed asset purchases are a typical use of this type of transaction 
report. Just QuickZoom on the fixed asset amount on the balance sheet.)

Profit and loss report (income statement)

For year-end preparation of tax returns or financial statements, you can create a 
standard profit and loss report and change the date range to “Financial year to date.” 
You can customise the report to include columns for Previous Period, % Change (from 
previous period), and % of Income.

To create a customised profit and loss report at year-end:
1 From the Reports menu, choose Company & Financial.

2 Choose Profit & Loss Standard.

3 In the Report window, click Modify Report.

4 In the Report Dates field, select “This Financial Year-to-date” from the drop-down 
list.

5 For Other Columns, select “Previous Period,” “% Change,” and “% of Income.”

6 Click OK to see the customised report.
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You can analyse the income and expense accounts, and see a detailed transaction 
report by using QuickZoom to view any amounts that seem abnormal.

If the income statement points out a need for “reclassification,” you can either merge 
accounts or QuickZoom to the original transaction and make the changes.

If the changes you want to make would affect the balance sheet, you may want to 
create a journal entry. (From the Company menu, choose Make Journal Entry.) For 
example, suppose the client recorded a purchase of equipment as “office supplies.” 
You would prepare an entry to debit Fixed Assets and credit Office Supplies.

Cash disbursements journal

QuickBooks cheque detail report gives you the same information you would see in a 
cash disbursements journal. The report lists all transactions that decrease (credit) the 
bank account, and the expense accounts associated with each transaction for the 
specified date range. For each transaction, QuickBooks also displays the transaction 
type (for example, whether it is a cheque, bill payment cheque, payroll cheque, 
liability cheque, payroll YTD adjustment, or general journal entry).

To create a cash disbursements journal:
1 From the Reports menu, choose Banking.

2 Select Cheque Detail.

This is one of the few reports that provides all the account information for each 
transaction—even for transactions that are associated with more than one account. 
(On other reports, QuickBooks displays the word “split,” rather than listing each 
account assigned to a transaction.)
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Cash receipts journal

The QuickBooks deposit detail report provides the information you would normally 
see in a cash receipts journal. The report lists all transactions that increase (debit) the 
bank account. QuickBooks does not display the income accounts that the payment is 
linked to. Instead, it displays “Undeposited Funds” or “Accounts Receivable,” 
depending on how the payment was deposited.

To create a cash receipts journal:
1 From the Reports Menu, choose Banking. 

2 Choose Deposit Detail.

Because the QuickBooks deposit detail report (cash receipts journal) does not provide 
income account information, you may want to generate an additional report that 
displays all sales (paid and unpaid), with account detail, during a specified period of 
time. To generate a report that displays all sales and account information, you can 
customise a QuickBooks journal report.
173



E v a l u a t i n g  c l i e n t  d a t a
To show all sales, with account detail:
1 From the Reports menu, choose Accountant & Taxes.

2 Choose Journal.

3 Click Modify Report, then click Filters.

4 Click Account in the Filter scroll box, and select “All accounts receivable” from the 
Account drop-down list.

5 Click OK.

Purchase journal

The QuickBooks unpaid bills detail report lists all unpaid bills by supplier. When you 
combine this report with the cash disbursements journal, you have a complete picture 
of all purchases during a specified period of time.

To create a purchase journal report:
1 From the Reports menu, choose Suppliers & Payables.

2 Choose Unpaid Bills Detail.
174



C H A P T E R  7
If your clients also make credit card purchases that they track in QuickBooks, you may 
want to create an additional report that details the purchases on that credit card.

To create a report that details credit card purchases:
1 From the Reports menu, choose Accountant & Taxes.

2 Choose Journal.

3 In the report window, click Modify Report, then click Filters.

4 Click Account in the Filter list.

5 From the Account drop-down list, choose “All credit cards.”

6 Click OK.

This report lists all credit card transactions, with complete account detail, for the 
specified period of time.

Payroll summary report

The QuickBooks payroll summary report shows amounts paid to each employee, with 
details for all deductions, employer expenses, and contributions.

Important: If your client does not use a separate bank account for payroll, pay
cheques appear in the cheque detail report. However, the payroll summary report
gives more detail, so you can easily determine how net pay was calculated.

To create a payroll summary report:
1 From the Reports menu, choose Employees & Payroll.

2 Choose Payroll Summary.
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Comparing payroll totals to the income statement

If you want a report that you can use to compare totals for earnings, taxes, and other 
payroll expenses to totals shown for these items on the income statement, you can 
customise the payroll summary report.

To compare totals for payroll items to totals shown on the income 
statement:
1 From the Reports menu, choose Employees & Payroll, then choose Payroll 

Summary.

2 Click Modify Report.

3 Modify the date range to match the date range used on the income statement.

4 In the Other Columns section, click the Hours and Rate columns to clear them.

5 Click OK.
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If payroll item totals vary from those shown on the income statement, use QuickZoom 
on the income statement to create a detailed transaction report and locate the 
variance. (The variance is often due to another tax payment, e.g. corporation tax, 
incorrectly posted, or penalties and interest on late payments.)

Displaying the earnings basis for a payroll tax

To help you review payroll information, you can have QuickBooks display the 
earnings basis used to calculate a particular tax by following these steps.

To display the earnings basis used to calculate a particular tax:
1 From the Reports menu, choose Employees & Payroll, and then choose Payroll 

Summary.

2 Double-click (QuickZoom) the payroll tax amount for which you want to know 
the earnings basis.

QuickBooks displays the transactions by payroll item report.
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This report shows the earnings basis and the calculated tax amount for each pay 
cheque for the specified period, with overall totals for each.

Trial balance

To create and print a trial balance report, from the Reports menu, choose Accountant 
& Taxes, and then choose Trial Balance. You may find it useful to work from this trial 
balance when making journal entries.
178



C H A P T E R  7
You can also save the report to disk to use in creating a working trial balance using a 
spreadsheet program. If you use Microsoft Excel (97 or higher) and QuickBooks Pro or 
Accountant, you can export the trial balance report directly into Microsoft Excel. For 
more information, see “Exporting a report to Microsoft Excel” on page 25.

General journal

You can make journal entries by choosing Make Journal Entry from the Company 
menu.

Note: General journal entries auto-number in all QuickBooks 2002 and higher 
versions. (You can turn this preference off by choosing Accounting in the 
Preferences window and then clicking the Company Preferences tab.)

You can prepare “standard journal entries” for recurring items such as depreciation, 
expensing prepaid items, regular accruals of expenses, or amortisation of interest on 
notes payable (using 1/12th of the annual expected interest expense). You can 
memorise each of these transactions in QuickBooks and have them automatically post 
at the end of each month. This lets you capture a significant portion of the year-end 
expenses.
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Tip: When entering a description for the journal entry in the Memo field, you 
can tick the Autofill Memo box to repeat the description in all lines of the 
entry, or use the Copy and Paste commands (on the Edit menu) to copy an 
individual description.

For QuickBooks Accountant, you can reverse a general journal entry by opening the 
original entry and clicking the Reverse button. Reversing an entry creates a new entry, 
dated the 1st of the following month, that reverses the debit and credit amounts. It 
has the same journal number, suffixed with “R”.

In QuickBooks Accountant, within the General Journal Entry window you can:

� Display a list of journal entries and edit entries from one screen.

� Find (and edit) a transaction from the Make Journal Entry window using the Find 
button in the window’s buttonbar.

� Access five journal reports from the Make Journal Entry window Reports drop-
down list: entries entered today, last month, last fiscal quarter, this fiscal year to 
date, and all entries.

� See totals for the Debit and Credit columns to see if the transaction is in balance.

Make sure you provide the client with the journal entries and have the client record 
the entries in the original data file. Otherwise, you may be repeating entries each time 
you prepare a financial statement and the client will not have accurate information.

To create a general journal report:
1 From the Reports menu, choose Accountant & Taxes.

2 Choose Journal.

3 Click Modify Report, then click Filters.

4 In the Filter list, select Transaction Type, and then select Journal from the 
Transaction Type drop-down list.
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5 Click OK.

QuickBooks displays all general journal entries for the specified period of time.

General ledger

If you maintain copies of your clients’ data disks, you may not need to print a general 
ledger.

However, after making the journal entries, you can print a general ledger. From the 
Reports menu, choose Accountant & Taxes, and then General Ledger. You can 
customise the dates and print a report for the entire financial year, or any other period.
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Reconciliations

For your client files, you may want to have a hard copy of the QuickBooks bank 
reconciliations, along with the client’s last bank statement.

If your client does the reconciliation, simply print the last reconciliation report by 
selecting Reconcile from the Banking menu, choosing the account to reconcile, and 
clicking the Print Last Report button.

If you are using QuickBooks Accountant (and your client is using the same version) 
you have several reports available to help you find discrepancies when you reconcile 
an account in your client’s data file:

� Reconcile Discrepancy – lists transactions that have changed since you last 
reconciled an account.

� Reconciliation Detail – lists all the transactions that were cleared in a given 
reconciliation period. (120 reports can be saved per reconciled account.)

� Reconciliation Summary – lists the overall totals for cheques/payments and 
deposits/credits for a reconciliation period. (120 reports can be saved per 
reconciled account.)

If you are reconciling the account for the client and need reconciliation instructions, 
search the onscreen Help index for reconciling.
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Determining concentration of credit risk 

The following reports can help you prepare full-disclosure financial statements or 
advise your clients of potential business risks given their current operations.

Checking for dominant customers

When preparing financial statements, or sometimes for discussions with the client, 
you may need to determine if there is a significant concentration of credit risk (or if 
one customer forms more than 10% of the client’s business). You can determine this 
by creating a sales by customer summary report.

To create a sales by customer summary report:
1 From the Reports menu, choose Sales.

2 Choose Sales By Customer Summary.

3 Click the Modify Report button.

4 Change the date range to match the period covered in the financial statements.

5 For Other Columns, select “% of Column.”

6 Click OK.

Another useful report is a sales journal arranged by customer, listing each unpaid 
invoice and unapplied credit memo. When you combine the sales journal with the 
cash receipts journal, you’ll have information on all sales during a specified period.
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To create a sales journal:
1 From the Reports menu, choose Customers and Receivables.

2 Choose Open Invoices.

If you prefer to see sales information for each item (that is, each service provided or 
each product sold), you can generate an item summary or item detail report.

To create an item summary or item detail report:
1 From the Reports menu, choose Sales.

2 Choose Sales by Item Summary or Sales by Item Detail.
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You can create a report that displays total sales for each customer:job, so you can 
determine if a single customer dominates.

To see sales for each customer:
1 From the Reports menu, choose Custom Summary Report.

2 In the Display rows field, select Customer.

3 Click Filters.

4 Select Name in the Filter list, and then select “All customers/jobs” from the Name 
drop-down list.

5 Click OK.

Checking the ageing of accounts receivable

Use the ageings for A/R to determine if there should be an allowance for doubtful 
accounts, or even adjustments to accounts. From the A/R ageing summary report, you 
can determine whether your client runs the risk of having to write off a large bad debt, 
and you can recommend that the client not extend further credit to a risky customer.

To create a customer ageing report:
1 From the Reports menu, choose Customers and Receivables.

2 Choose A/R Ageing Summary.
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Displaying customer information

You can print a customer list which shows the details held on each customer, sorted 
in the same order as the Customer:Job List.

To display customer information:
1 Display the Customer list by choosing Customer:Job List from the Lists menu.

2 From the File menu, choose Print List.

If you want to determine the area your client serves, you can print mailing labels for 
customers—sorted by post code and printed on blank paper—by following these steps:

To display customer geographical information:
1 From the File menu, choose Print Forms, and then choose Mailing Labels.

2 From the Name drop-down list, select “All customers/jobs.”

3 From the “Sort mailing labels by” drop-down list, select Post Code.

4 Click OK.

5 Click Print in the Print Labels window.

QuickBooks prints customer name and address information, sorted by post code.

Checking for dominant suppliers

This report displays the total purchases from each supplier, so you can determine if 
your client is dependent on one or more suppliers.

To display sales by supplier information:
1 From the Reports menu, choose Custom Summary Report.

2 In the Display Rows By field, select Supplier.

3 Click the Filters tab.

4 Select “Name” in the Filter scroll box, and select “Selected names” in the Name 
drop-down list.

5 In the dialog box, select all essential suppliers (those from whom your client 
purchases goods, and that are necessary for the continued operation of the 
business).
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6 Click OK.

7 To determine if your client is dependent on a supplier for a key item, you can 
choose “Item detail” from the Columns drop-down list in the Customise Report 
window to have QuickBooks display purchases by supplier for each item.

8 Click OK in the Modify Report window.

Checking the ageing of accounts payable

Use the ageings for A/P to highlight disputed amounts (which may need to be 
adjusted) or possible duplicated entries.

This report tells you if your client is behind on paying bills. Given this information, 
you can (as appropriate) make financial recommendations to help them pay off 
overdue bills.

To create a supplier ageing report:
1 From the Reports menu, choose Suppliers & Payables.

2 Choose A/P Ageing Summary.

Displaying supplier information

You can print the Supplier list which shows the details held and balances for each 
supplier.

To display supplier information:
1 From the Lists menu, choose Supplier List.

2 From the File menu, choose Print List.

If you want to determine whether your client is dependent on a particular 
geographical area for supplies, you can print mailing labels for suppliers, sorted by 
post code and printed on blank paper.

To display supplier geographical information:
1 From the File menu, choose Print Forms.

2 Choose Mailing Labels.
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3 From the Name drop-down list, select “All suppliers.”

4 From the “Sort mailing labels by” drop-down list, select Post Code.

5 Click OK.

6 Click Print in the Print Labels window.

QuickBooks prints supplier name and address information, sorted by post code.
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Daily tasks

Backing up company data

Encourage your clients to back up their QuickBooks company file daily or at the end 
of each QuickBooks session. Backup copies are important insurance against data loss. 

The QuickBooks Back Up command compresses company data into a compact file that 
has the same filename as the company data, but with the extension QBB, rather than 
QBW. (For example, Acme.QBW contains the company data, while Acme.QBB 
contains the compressed company data.)

To make a backup copy of the company data:
1 Open the file you want to back up by choosing Open Company from the File 

menu.

QuickBooks displays this window.

2 Select the company you want to back up, and click Open.
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3 From the File menu, choose Back Up.

In the “File name” field, QuickBooks displays the company you have open.

4 In the “Backup Current Company” section, type in the name of the backup copy, 
and select the drive and folder where you want to save it. This can be on the hard 
drive, floppy drive or CD-ROM drive. If you are backing up to floppy disk, you also 
have the option to tick “Format each floppy disk during backup”.

5 If required, tick Verify Data Integrity.

6 Click Back Up.

If you are backing up to a 3.5-inch disk and the data doesn’t fit on a single disk, 
QuickBooks prompts you when it’s time to put in another disk.

If you are backing up to a location that already contains a file with the same name, 
QuickBooks asks, “This file already exists. Do you want to replace it?” If you click Yes, 
QuickBooks asks you to confirm again with “Are you sure you want to delete the 
already existing file (drive, directory, filename.qbb)?” The options are Yes or No:

� If you choose Yes, QuickBooks overwrites the existing backup file.

� If you choose No, QuickBooks returns to the Back Up Company File window so 
you can enter a different name.
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Automatic and scheduled backups

Encourage clients to use the automatic backup features, which creates a backup in the 
QuickBooks Autobackup folder. In addition, clients can schedule backups. 

For example, they can choose to back up every time they close the company file (or at 
an interval that is more appropriate for their usage level), then schedule a weekly 
backup that is stored offsite. 

To set automatic and scheduled backups:
1 From the File menu, choose Backup.

2 Click the Schedule a Backup tab.

3 For automatic backup when closing the file, type in the frequency, for example 1 
for every time.

4 To schedule a backup, click New.

5 Type a description for the scheduled backup.

6 Browse for a location.

7 Select the start time, day and frequency.

8 You can set a password and specified user if required..
192



C H A P T E R  8
9 Click OK.

QuickBooks displays your scheduled backup details in the lower part of the 
window.

10 Click OK.

See “Restoring company data” on page 201 for instructions on how to restore a backup 
copy.

As needed tasks

Condensing data to reduce file size

The QuickBooks Condense Data command reduces the size of the company file by 
summarising transactions dated on or before a date that you specify. After QuickBooks 
summarises the transactions (in a General Journal entry), you can have it delete items 
from the company lists that you haven’t used.

When you condense data, QuickBooks automatically creates an archive copy 
(ArchiveCopyMMDDYYYYourCompanyFileName.qbw) of your company date file 
before the condense/removal process begins. This archive snapshot is intended as a 
safeguard in the event that the condense process is interrupted and to provide a 
reference for past periods. You should not use the archive copy for active data entry.
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Notes on using Condense Data
� You can’t “uncondense” data after QuickBooks condenses it. Before condensing 

the data, QuickBooks requires you to make a backup copy. You can select a 
directory other than the default if you don’t want to overwrite this “uncon-
densed” backup with subsequent backups.

� The time QuickBooks requires to condense the data depends on the computer’s 
speed and memory, the size of the company file, and other factors. It can take from 
a few minutes to a few hours.

� While QuickBooks is condensing the data, you can’t use other applications. 
Therefore, you may want to select Condense Data when you can leave the 
computer running for an extended, uninterrupted period of time, such as over-
night.

� QuickBooks will not condense stock transactions.

� The condensing process may stay at a certain percentage of completion for a long 
time. If you notice activity occurring on the hard drive (that is, you can hear the 
hard drive or can see the light flashing), let the process continue.

� On average, condensing a QuickBooks data file will reduce its size by a maximum 
of 30%.

When you condense data, QuickBooks first creates general journal entries in each 
account for the total amount of the transactions being deleted. It then deletes the 
transactions. So, keep the following in mind when condensing data:

� After the data is condensed, you can no longer generate cash-basis or transaction 
detail reports for the period of time that was condensed, because the transactions 
are no longer in the data file.

� You can still run summary reports (for example, profit and loss and balance sheet 
reports) for prior periods in the condensed data. This means that you’ll still be able 
to run comparative financial reports covering periods that have been condensed.

Transactions not deleted by Condense Data

Important: If you are not familiar with Condense Data, please read this section care-
fully so you understand exactly which transactions Condense Data will not condense
before you attempt to condense the data file.

� Transactions with an open balance. These include partially paid or unpaid 
invoices, undeposited payments, unpaid bills, or unused credit memos.

� Transactions linked to a transaction with an open balance, e.g. an undeposited 
customer payment that you applied to an invoice. QuickBooks doesn’t delete the 
invoice or the undeposited payment. Although the invoice is paid, QuickBooks 
doesn’t delete the invoice because it has a link to an open transaction (the unde-
posited payment).

� Transactions not marked as cleared. These include any unreconciled transactions 
in a bank, credit card, asset, liability, or equity account.
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� Transactions marked “To be printed.” These include any invoices, bills, credit 
memos, sales receipts, or cheques for which you selected the “To be printed” tick 
box. From the File menu, choose Print Forms to find these transactions.

Running Condense Data

To condense data:
1 Before running Condense Data, run several reports, such as Profit & Loss, Balance 

Sheet, and transaction reports.

This lets you compare figures before and after you condense the data.

2 From the Window menu, choose Close All.

3 From the File menu, choose Archive and Condense Data.

4 In the “Remove closed transactions on or before” field, enter the ending date of 
the time period for which you want QuickBooks to summarise transactions and 
click Next.
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5 Select the tick box for each additional criterion you wish to apply, and then click 
Next.

6 Select the tick box for each list item that you want QuickBooks to remove after it 
condenses the data, and then click Next.

7 Click Begin Condense to continue.

QuickBooks may display several warning messages, cautioning you that if you 
condense data, you’ll lose certain YTD payroll information. You can click OK or 
Cancel.

8 Click OK when QuickBooks displays a message that a backup must be made.

9 Accept the default location for the backup or select another, and click Save.

QuickBooks condenses the data after finishing the backup.
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Keeping QuickBooks up to date

Intuit sometimes provides updates to QuickBooks that are available for downloading 
from the Internet. These updates might contain any of the following:

� A maintenance release for an existing version of QuickBooks which Intuit creates 
when a problem is discovered and fixed after the version has been distributed to 
customers.

� A new feature.

� A new service.

� Timely information relevant to you and your clients.

You can receive these updates by downloading them from our Web site into your 
QuickBooks software, or by ordering an update on CD-ROM from Intuit.

Note: New versions of QuickBooks are not available for downloading.

To check your release number:
1 Open QuickBooks.

2 Press Ctrl-1.

Requirements for downloading updates

To download an update to QuickBooks 2003, you need the following:

� A modem (baud rate of at least 28.8 recommended), or other means of connecting 
to the Internet.

� Access to the Internet.

The first time you use a QuickBooks Internet feature (such as when you update 
QuickBooks), you will need to run through a short, one-time setup program. In this 
setup program, you indicate which Internet Service Provider you will be using with the 
Internet features in QuickBooks.

Choosing an update method

QuickBooks offers two methods for obtaining updates from the Internet: Automatic 
updating and immediate updating. You can use these methods concurrently.

There are some special considerations when downloading and installing QuickBooks 
updates when multiple users access the same company file. For more information, see 
“Downloading updates with multi-user QuickBooks” on page 199.
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Updating QuickBooks automatically

Using this method, updates of your choice are automatically downloaded from the 
Intuit server to your computer. QuickBooks periodically checks the Intuit server for 
new updates, and downloads the information gradually at times when your open 
Internet connection is not being used by another process or application.

Some of the advantages of this method include the following:

� You can download updates without interrupting a QuickBooks session or other 
tasks you perform with your computer.

� You can download updates whether or not QuickBooks is running (as long as your 
computer is connected to the Internet).

� You can disconnect from the Internet at any time. When you reconnect to the 
Internet, QuickBooks resumes downloading at the point it was previously halted.

To set up for automatic updating:
1 From the File menu, choose Update QuickBooks.

2 Click Options.

3 For the Automatic Update option, click ON.

4 Select the updates you want to download by clicking the tick box next to the 
update name. (A tick mark means the update is selected.)

5 Click Save.

Updating QuickBooks immediately

Using this method, you decide when to go online and download an update from the 
Intuit server to your computer. You can use this method at any time—even when your 
computer is set up to download updates automatically.

Once QuickBooks downloads an update, the program installs the necessary files to the 
correct directories or folders on your computer. When the update includes a 
maintenance release (or patch), you must exit QuickBooks so that the new 
information can be installed and applied to the QuickBooks program.

The time it takes to download an update using this method varies depending on the 
speed of your Internet connection, the size of the update file(s), and the amount of 
traffic on the Internet.

To perform an immediate update:
1 From the File menu, choose Update QuickBooks.

2 Click Update.

3 Select the updates you want to download by clicking the tick box next to the 
update name. (A tick mark means the update is selected.)

4 Click Get Updates.
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Once the download process is complete, QuickBooks displays the date and time of the 
download in the Last Checked column. In the File Received column, QuickBooks 
displays the status of the download. Click the text in the Files Received column for 
additional details about the download.

Downloading updates with multi-user QuickBooks

In most cases, you will not need to change the location to which QuickBooks updates 
are downloaded. However, if you want all users in a multi-user environment to share 
all downloaded updates, you will want to change the location so that all users can 
access the updates. To share QuickBooks updates in a multi-user environment, users 
must access the same directory to which updates are downloaded. The procedure 
below assumes the following:

� All of the computers are properly networked.

� Each computer is configured to share files across the network.

Each user in your multi-user environment must complete the following procedure to 
enable the sharing of downloaded updates.

To change the download location:
1 Open the shared company file.

2 From the File menu, choose Update QuickBooks.

3 Click Options.

4 In the Options windows, click ON for the Share Download option.

5 Click Save.

After everyone has completed these steps, users can update their copies of QuickBooks 
and downloaded information will apply to each user’s copy of QuickBooks.

Installing updates downloaded from the Internet

In most cases, QuickBooks installs updates once it downloads them from the Intuit 
server to your computer. However, maintenance releases (and some other updates) 
require you to exit QuickBooks before the new information goes into effect. When this 
is the case, QuickBooks displays a message when you exit QuickBooks asking if you 
want to install the update upon leaving the program. If you choose Yes, QuickBooks 
closes and installs the update. If you choose No, QuickBooks will close without 
installing the update.

Using a sample data file to update QuickBooks

If you do not have a company file available, but want to update QuickBooks, you can 
use one of the sample data files included with QuickBooks.
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To update using a sample data file:
1 From the File menu, choose Open Company

2 In the Open a Company window, navigate to the folder where you installed 
QuickBooks.

For QuickBooks Pro/Accountant, select the file “Grangeworth Premier Kitchens 
Ltd.qbw”

For QuickBooks Regular, select the file “Port Meadow IT Solutions.qbw” or 
“Grangeworth Kitchens Basic Ltd.qbw”.

3 Click Open.

4 Once the chosen sample data file is open, from the File menu, choose Update 
QuickBooks.

5 Click Update.

6 Select the updates you want to download and then click Get Updates.

Obtaining updates without Internet access

The fastest and easiest way for you and your clients to obtain updates is to download 
them from the Update QuickBooks window in QuickBooks, or from the Internet at 
www.quickbooks.co.uk.

If your clients do not have Internet access, please instruct them to call Intuit Direct 
Sales to request the release on CD-ROM. (To find the telephone number, from the 
Help menu, choose Phone Directory.) Only the registered QuickBooks user can order 
an update CD-ROM. Please do not order updates for your clients.

Getting payroll updates

If you have a valid subscription to QuickBooks Payroll Service, you can get payroll 
updates from the Internet.

For instructions on how to get payroll updates, search the onscreen Help index for tax 
tables.

Reinstalling QuickBooks

You may need to reinstall QuickBooks if you have hard disk or other equipment 
problems, or if you suspect that the QuickBooks program file has been damaged.

To reinstall QuickBooks:
1 Insert the QuickBooks CD-ROM in your CD-ROM drive.

The installation program starts automatically and detects that QuickBooks is 
already installed.

2 From the CD screen window, choose Reinstall QuickBooks.
200



C H A P T E R  8
3 When prompted, you must enter your original Installation Key Code.

If you are re-installing to a new computer, you will need to repeat the registration 
procedure. Make sure you have the original registration number to hand.

Note: If you have installed a maintenance release for QuickBooks and you later 
reinstall, QuickBooks will prompt you to reinstall the maintenance release.

For more information on how to install maintenance releases, see 
“Keeping QuickBooks up to date” on page 197.

Restoring company data

If the working data is damaged, the hard disk has malfunctioned, or you need to put 
the data on another computer, you will want to restore the data.

To restore company data:
1 From the File menu, choose Restore.

If a company is already open, QuickBooks tells you that it must close the current 
file in order to restore a file. Choose OK to restore the data file or Cancel if you do 
not want to continue restoring the data file.

QuickBooks displays a window where you can choose the file you want to restore 
(the latest automatic backup file is shown in the illustration).

2 If you are restoring from a 3.5-inch disk or CD-R, make sure the correct disk or CD 
is in the drive.

3 In the “Get Company Backup from” section, enter the name and location of the 
backup file you want to restore . Or, click Change to navigate to the correct 
location and file.

4 In the “Restore Company Backup To” section, enter a name for the restored file 
and the drive and folder to which you want to restore the file.

5 Click Restore.

6 If the filename already exists, QuickBooks prompts you for confirmation.
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� If you click Yes, QuickBooks overwrites the existing file on the hard disk.

� If you click No, QuickBooks returns to the Restore Company Backup window 
so you can enter a different filename.

Year-end procedures

QuickBooks is one of the few accounting programs that does not require you to close 
the books. By not requiring you to close the books, QuickBooks offers two main 
advantages:

� Detail. You always have easy access to last year’s data, including all the details of 
every transaction.

� Reporting. You can create comparison reports to compare this year with last year.

This section describes the year-end procedures for QuickBooks. QuickBooks makes 
some automatic adjustments to the books at year end, and although you don’t have 
to close the books, you can protect last year’s transactions from accidental change by 
using a password. 

If the data file is getting large and you want to reduce its size, you can condense the 
data. See “Condensing data to reduce file size” on page 193 for more information.

Important: All year-end activities (like processing payroll year end) should be com-
pleted before you condense the data file for the year.

QuickBooks automatic year-end adjustments

QuickBooks performs these year-end adjustments, based on the month you enter as 
the start of your financial year (in the Company Info window, under the File menu):

� QuickBooks automatically adjusts the income and expense accounts at year-end 
to zero them out. Therefore, you start the new financial year with a zero net 
income. 

� QuickBooks automatically creates an adjusting entry with the net income (the 
income minus the expenses for the year), posting it to a Retained Earnings account 
which is created by QuickBooks.

Suppose, for example, that the net profit for the year was £12,000. A balance sheet on 
the last day of the financial year would show a net income of £12,000 in the equity 
section of the balance sheet.

At the beginning of the new financial year, QuickBooks increases the Retained 
Earnings equity account by the previous year’s net income (£12,000 in this example) 
and decreases the net income by £12,000, leaving a net income of zero for the first day 
of the new financial year.
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Making year-end accounting entries

Every business has its own bookkeeping procedures and practices. These are 
suggestions for year-end tasks to perform.

To make year-end entries:
1 Reconcile the bank accounts against the bank statements up to the final month of 

the accounting year. (For example, if you are on a calendar year, you would use 
December 2003.)

Reconciling ensures that you have recorded every cheque, deposit, and other 
charge and that the records agree with the bank’s.

2 Make adjusting entries as necessary for year-end accruals, adjustments, correc-
tions, or distribution of earnings.

3 Print financial reports and detailed transaction reports as desired.

Safeguarding last year’s data

Make two backups of the company file at year-end, labelled with the year. Keep one 
onsite; keep the other offsite for added security

Freeze the past year’s transactions with a password after all adjustments have been 
made. You’ll be able to view the earlier transactions as you normally do, but 
QuickBooks will ask for the password if you try to change them.

To protect last year’s data from accidental change:
1 From the Edit menu, select Preferences.

2 In the Preferences window, select Accounting.

3 Click on Company Preferences .

QuickBooks displays the Company Preferences tab:

4 In the Closing Date section, enter the date.
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5 Click Set Password.

QuickBooks displays the Set Closing Date Password dialog box:

6 Type the required password in the first field, and again in the second field, then 
click OK.

7 Click OK to close the Preferences window.

To grant access to transactions entered before the closing date:
1 From the Company menu, choose Set Up Users.

2 In the User List window, select the name of the user and click Edit User.

3 Click Next until the Changing or Deleting Transactions screen appears.

4 Select Yes in response to the question, “Should this user also have the ability to 
change or delete transactions that were recorded before the closing date?”

To view changes made since the closing date (Accountant only):

From the Reports menu, choose Accountant & Taxes, then Closing Date Exception 
Report.
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Producing yearly tax forms at Payroll Year End

Here’s how to use QuickBooks to generate yearly tax forms, which you can file online 
if you have signed up for online filing with Inland Revenue:

� P11 Working Sheet: This is on the Employees and Payroll menu, and provide the 
information needed to fill in the end-of-year company forms for Inland Revenue.

� Print reports for self-assessment tax information: QuickBooks includes an 
income tax summary and an income tax detail report (in the Accountant & Taxes 
section of the Reports menu); these reports list amounts for each tax line asso-
ciated with a QuickBooks account for the Self-Assessment Tax Return, if selected 
in the Company Information window. 

� Process Payroll Year End: QuickBooks guides you through all the stages necessary 
to process Payroll Year End. You can print copies of your P60 end-of-year 
employee forms and P35. Follow these steps: 

To process Payroll Year End:
1 From the Employees menu, choose Process Payroll Year End. 

2 Choose the employees you want to process.

3 Click Review P14/P60 Data.

4 Click Print P14/P60 Forms.

5 Click Review P35 Data.

6 Click Checklist & Declaration.

7 Click Print P35 Form.

8 Click File Online, if you have signed up with Inland Revenue.
205



P e r i o d i c  t a s k s
206



• • • • • • • • • •

CHAPTER 9 Diagnosing and 
fixing common 
client errors
 5

Troubleshooting is part of the job 208

A cash-basis balance sheet shows a balance for A/R or A/P 209

Liabilities shown on the payroll liabilities report don’t match the payroll 
liabilities shown on the client’s balance sheet 210

Amounts shown on the stock valuation report don’t match the amounts 
shown for stock on the balance sheet 211

Some of the A/R and A/P reports don’t match the amounts shown on the 
balance sheet 211

Retained earnings have changed from last year 212

Why is there a balance remaining in Opening Balance Equity? 213

How can a client track customer advances as a liability? 214

Client’s opening balance sheet has changed from when the company was 
originally set up 215

What to do about “Fatal Error” messages 216
207



D i a g n o s i n g  a n d  f i x i n g  c o m m o n  c l i e n t  e r r o r s
Troubleshooting is part of the job

As an accountant, a large portion of your time is probably spent diagnosing and fixing 
client errors. Some of the errors are easy to spot and fix, while others involve dedicated 
investigative work and time-consuming solutions. This chapter describes some typical 
and not-so-typical client errors and how to handle them.

The problems discussed in this chapter are:

� Client has a cash-basis balance sheet that shows a balance for A/R or A/P.

� Client’s balance sheet is “out of balance”—assets don’t equal liabilities and equity.

� The payroll liabilities by item report doesn’t match the payroll liabilities shown on 
the client’s balance sheet.

� The stock valuation report doesn’t match the amounts shown for stock on the 
balance sheet.

� Some of the A/R and A/P reports don’t match the amounts shown on the balance 
sheet.

� Retained earnings have changed from last year.

� Why is there a balance remaining in Opening Balance Equity?

� How do I handle a customer advance as a liability?

� Client’s opening balance sheet has changed from when he or she originally set up 
the company.

� What to do about “Fatal error messages”.
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A cash-basis balance sheet shows a balance 
for A/R or A/P

This means that the client has assigned a payable or a receivable to a balance sheet 
account, rather than to an expense or income account.

Often, this occurs on a purchase that is both a liability (payable) and a fixed asset. For 
example, if your client enters a bill for a computer system and posts it to a fixed asset 
account, it never gets posted as an expense and, therefore, the client’s payables aren’t 
reduced.

To find bills that have been assigned to a balance sheet account:
1 Create an unpaid bills report.

From the Reports menu, choose Suppliers & Payables, and then Unpaid Bills 
Detail.

2 Set the date range to the end of the year, or to match the period you’re trying to 
analyse.

If the client assigned one of the unpaid bills to a balance sheet account, it will still 
be in payables. When you find the bill, you can go back and assign it correctly 
(debit the Accounts Payable account and credit the Fixed Asset account).

To find receivables that have been posted incorrectly:
1 Create an open invoices report.

From the Reports menu, choose Customers & Receivables, and then Open 
Invoices.

2 Set the date range as of the end of the year.

3 Look at the items that appear on the invoices, and see if any of these were directed 
to balance sheet accounts.
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Liabilities shown on the payroll liabilities report 
don’t match the payroll liabilities shown on the 
client’s balance sheet

In this situation, it’s somewhat difficult to find the problem, because the payroll 
liabilities report breaks out payroll liabilities for each payroll item (such as NIC-
company, NIC-employee). The balance sheet, in comparison, groups the liabilities 
into one amount. If you add up payroll liabilities by item to get a total, it often does 
not match the amount for payroll liabilities shown on the balance sheet.

Sometimes the problem is caused by clients paying their payroll liabilities the “old 
way”—they just write a cheque for what they owe, rather than going through the 
Employees menu (Pay Payroll Liabilities). This makes the liabilities shown on the 
report huge, as if they’ve never paid taxes. (QuickBooks thinks it’s a normal cheque, 
not a liability cheque.) Payroll also doesn’t know when you’ve made a journal entry, 
so that can be an additional source of figures that don’t match.

QuickBooks adds just one account for all payroll expenses and one account for all 
payroll liabilities. If you want to see payroll amounts broken out on the balance sheet, 
just as they are in payroll reports (where QuickBooks itemises each payroll expense 
and liability), you can add payroll liability and payroll expense subaccounts.

In the chart of accounts, create a separate subaccount under Payroll Liabilities for each 
type of liability (PAYE, NIC, and so on). Then create a separate subaccount under 
Payroll Expenses for each type of expense (salary, holiday pay, SSP, SMP, and so on). 
Display the Payroll Item list and, item by item, assign each payroll item to the 
appropriate Payroll Liabilities subaccount or Payroll Expenses subaccount. 
QuickBooks makes these changes for you retroactively.
210



C H A P T E R  9
Amounts shown on the stock valuation report 
don’t match the amounts shown for stock on 
the balance sheet

If the total for Asset Value on the stock valuation summary does not match the 
amount shown for Stock Asset on the balance sheet, there are two possible reasons:

� Someone made a journal entry in the Stock Asset account. QuickBooks doesn’t 
pick up the entry, because an adjustment made through the general journal does 
not affect the stock item.

� If the client has made an stock item inactive, but it still has a value, that could 
account for the discrepancy. (The client may have inadvertently made the wrong 
item inactive.)

You can create a stock take worksheet and compare it to the valuation report. (The 
stock take worksheet shows all items, so even if an item is now inactive, it should 
still show up.) Check to see whether something is on the stock take worksheet that 
doesn’t show up in the valuation report.

Some of the A/R and A/P reports don’t match 
the amounts shown on the balance sheet

A common question asked by CPAs and other QuickBooks users is, “Why is it that 
some of the A/R and A/P reports don’t tie to the general ledger?” For example, the 
receivables listed on a client’s balance sheet might be £9,266.30, but the total for the 
open invoices report (an A/R report listing all customers and outstanding invoices) for 
that same date might be £995.

When the figures on an A/R or A/P report don’t agree with the balance sheet, check 
the Customise settings for the report. In this example, where the open invoices report 
doesn’t match the receivables on the balance sheet, you just need to fix the open 
balance/ageing setting. When you have the open invoices report displayed, click 
Customise. The Open Balance/Ageing field has two choices: Current (the default) and 
As of Report Date. Change the setting to “As of Report Date.”

1 From the Reports menu, choose Customers & Receivables and then choose Open 
Invoices.

2 Click Modify Report. 

3 Click the Advanced button on the Display tab.

4 Change the Open Balance/Aging field to Report Date.

5 Click OK.

It’s important to note that some of the A/R and A/P reports (such as the ageing reports) 
do tie to the general ledger, without report customisation.
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Retained earnings have changed from last 
year

Retained earnings are profits from earlier accounting periods that have not been 
distributed to the company’s owners. At the end of your financial year, QuickBooks 
computes your profit (or loss), and transfers it into an equity account named Retained 
Earnings.

If, prior to the end of your client’s financial year, the profit differed from the amount 
QuickBooks transferred into Retained Earnings, that means your client inadvertently 
changed a prior-year transaction. (They may have added a new transaction to that year 
or changed an existing one.) This is easy enough to do: when people begin a new year, 
it may take a while before they remember to type the correct year on transactions.

To prevent this in the future, you may want to restrict access to the transactions of 
prior accounting periods. By requiring permission to delete, add, or edit any 
transaction before a chosen date, you can discourage accidental or casual changes to 
“closed” periods, but still make corrections when necessary.

You can grant this access when setting up a user in the “Set up user password and 
access” wizard. If you’d like to allow a user access to “closed” periods, grant them the 
permission to change or delete transactions recorded before the closing date.

To grant access to prior period transactions:
1 From the Company menu, choose Set Up Users, and then click Add User.

2 At the Changing or Deleting Transactions window of the wizard, answer Yes to the 
question, “Should this user also have the ability to change or delete transactions 
that were recorded before the closing date?”.

For more information about using the “Set up user password and access” wizard to set 
up new users, search the onscreen Help index for users, adding.
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Why is there a balance remaining in Opening 
Balance Equity?

QuickBooks automatically creates the Opening Bal Equity account when you enter the 
opening balance of your first balance sheet account. As you enter the opening 
balances for all your balance sheet accounts, QuickBooks records the amounts in 
Opening Bal Equity. This ensures that you get a correct balance sheet for the 
QuickBooks company, even before you've entered all the company's assets and 
liabilities.

If, after your client has entered balances for company assets, liabilities, and equity, 
there is a balance remaining in Opening Bal Equity, it could mean that the client has 
not set up opening balances completely.

If the client has set up opening balances completely, and there is a balance remaining 
in the Opening Bal Equity account, the client may have clicked the Done button 
before a procedure was actually completed. For example, suppose the client was 
reconciling a credit card account, and clicked Done when there was still an amount 
displayed for Difference (the Difference should be zero before clicking Done). 
QuickBooks transfers that remaining amount to Opening Bal Equity. If you display the 
register for the Opening Bal Equity account, the Memo field should say something like 
“balance adjustment.”

If the problem is a bank reconciliation adjustment, and the client has no idea where 
the problem is, first verify that the year-end bank balance is correct. If so, the best 
solution is to print the entire cheque register from the beginning of the year. Sit down 
with the bank statements, highlight every transaction on both, see which ones are 
different, and fix them. Then you can delete the balance adjustments in the Opening 
Bal Equity account.
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How can a client track customer advances as 
a liability?

When your client has customers who pay in advance for a service not yet received, 
that is a liability to your client’s company. QuickBooks documentation recommends 
that you receive the payment but do not apply it to an invoice (creating a negative 
receivable). Here is an alternative method if you want to track the advance as a 
liability.

Create a current liability account called Customer Deposits. Then create a service item 
called Cust Deposit; assign it to the Customer Deposits liability account. When your 
client receives an advance from a customer, create a cash sale that shows one item—
the Cust Deposit item. 

For example, suppose you receive a £5,000 advance on a project. You have no invoice 
to apply it to yet. Create a cash sale, and use the item Cust Deposit (assigned to the 
Customer Deposits liability account). When you record the cash sale, QuickBooks 
debits the cash or Undeposited Funds account and credits the liability account.

Suppose the final invoice is for £25,000 for consulting income. They’ve already given 
you £5,000, so use the Cust Deposit item and enter –5000 (minus 5000) as the amount 
for the item. This makes the accounts receivable balance £20,000.

How to keep track of who paid deposits: 
1 Create a transaction detail by account report (this report shows every account and 

every transaction).

From the Reports menu, choose Accountant & Taxes and then Transaction Detail 
by Account.

2 Click Modify Report.

3 From the Total By drop-down list, choose Customer.

4 Click the Filters tab.

5 From the Filter list, choose Account.

6 From the Account drop-down list, choose Selected accounts, and then choose the 
Customer Deposits liability account.

7 Click OK.

Now the report shows the inflows and outflows by customer, so you can tell who 
has used up a deposit and who hasn’t. The report shows a balance of zero for a 
customer after you’ve used up the deposit.
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Client’s opening balance sheet has changed 
from when the company was originally set up

Here’s a common mistake made by clients when they’re ready to set up their own 
QuickBooks companies. They get the figures from their accountant (on a balance 
sheet, for example) but, instead of entering opening balances as of the last day of the 
prior period, they enter opening balances as of the first day of the period. For example, 
they’ll enter 01/01/2007 as the opening balance date, rather than 31/12/2006.

They then start entering transactions dated that same day (01/01/2007), and that 
makes it even more difficult to isolate the opening balances. 

To fix this, go into the registers and change the dates of the opening balance entries.

If you enter opening balances dated the last day of the previous period (31/12/2006), 
those are the only transactions with that date in the register. If you have any problems 
with opening balances, they’re easy to find and fix.
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What to do about “Fatal Error” messages

From time to time, an unexpected “Fatal Error” message may appear when using 
QuickBooks. This can usually be cured by using the QuickBooks Verify and Rebuild 
procedures on your company data file.

To verify and rebuild a QuickBooks data file:
1 From the Window menu, choose Close All.

This closes all QuickBooks windows. You must do this for Verify and Rebuild to 
work.

2 From the File menu, choose Utilities and then Verify Data.

QuickBooks verifies your data file and indicates whether any problems were 
found. Even if not, you should carry out a rebuild.

3 From the File menu, choose Utilities and then Rebuild Data.

QuickBooks warns you that a backup must be made before the rebuild (it does this 
automatically) and reminds you not to overwrite any existing backups.

4 Click OK in the information box.

QuickBooks displays the Back Up Company File dialog box.

5 Specify a backup filename and location (not the ones you normally use), then click 
Save.

QuickBooks rebuilds your data file. This may take a minute or two, depending on 
file size.

6 When QuickBooks confirms that the rebuild is complete, click OK in the infor-
mation box.

You should now be able to use your data file and back it up normally. If so, delete the 
backup made by the rebuild. If not, and the problem persists, contact QuickBooks 
Technical Support.
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Sample QuickBooks reports 218
Profit & Loss Standard 218
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Sample QuickBooks reports

The following illustrations represent only some of the many preset reports available 
in QuickBooks. To preview other QuickBooks reports, from the Reports menu, choose 
Report Finder.

Profit & Loss Standard
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Balance Sheet Summary

Cash Flow Forecast
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Pay VAT (via Suppliers menu)

A/P Ageing Summary
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Trial Balance
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Adjusted Trial Balance
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General Ledger
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Journal
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Statutory Payments Report
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general journal 179
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generating 43, 44
jobs 67
list reports 47, 81
numbers format 60
payables 71
payroll 74, 175
printing 93
printing problems 137
printing to a file 26
profit and loss 61, 171
project 67
purchases 72
QuickReports 47
sales 66
sales by customer 183
saving in PDF format 26
sorting 58
statement of cash flows 169
statutory payments 225
stock 73
summary 45
suppliers 71
time 67
transaction 46
trial balance 178
types of 48
unpaid bills 174
value added tax 83

restoring data 201
retained earnings

changed from previous year 212
opening balances 159

returns
from customers 130
on unpaid invoices 133
recording 133

S
sales receipts. See cash sales receipts
sales reports

by customer 183
customizing 66

saving
report data 92

saving data 190
saving disk space 96, 113
security of data 203
setting up QuickBooks. See EasyStep Interview
shipping methods 8
sorting, report data 58
spreadsheets

exporting reports to Microsoft Excel 26
report printing to 26
trial balance, printing to 153

statement of cash flows report 169
statutory payments report 225

stock
doesn’t match balance sheet 211
reports 73

summary reports
changing defaults 52
described 45

suppliers
ageing 187
contact information 82
credit 126
discounts from 126
geographical information 187
maximum number 8
paying by BACS 108
phone list 82
purchase reports 186
reports 71
setting up 149
to be paid by BACS 106
types 149

suppliers, determining dominant 186

T
tab-delimited files

exporting lists 23
report printing to 26

tax tables, updating 159
taxes

income 38
payroll 118
year-end tax forms 205

technical limitations 8
templates

employee defaults 149
maximum number 8
memorised reports 91
transferring between files 22

terms report 67
time reports

described 67
for projects 69

to do notes
maximum number 8
report 83

transaction reports
cash basis 113
described 46
history 85

transactions
importing 29
passwords for 203
transferring 21

transferring data. See exporting and importing
trial balance

Quicken conversion 153
report 77, 178
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troubleshooting
client errors 208
fatal error messages 216
printing problems 137

U
uncategorised income and expenses 158
Undeposited Funds account 133
updating files 197
users, adding 159

V
value added tax

amount owed at start date 158
entering a VAT-only bill 126
opening balance 121
paying 123
reports 83
upgrading from earlier versions 122

vendors
discounts from 127
lists 187
reports 72

vendors. See suppliers
verify data 216
versions, installing multiple 162
voiding invoices 133

W
withholding report 82
working trial balance 178

Y
year-end

automatic adjustments 202
payroll 205
procedures 202
profit and loss report 171

yearly tax forms 205
P11 205
P35 205
P60 205
Self-Assessment Tax Return 205

year-to-date
payroll information 116
value added tax 121
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